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Getting Started with STEP
This section is intended to provide users with an introduction to the STEP system and concepts. Additionally, it
provides detailed information needed to perform basic datamaintenance tasks in STEP, including detailed
descriptions of the workbench interface and search functionality. While geared towards end users, the guide
provides information that is necessary for all users to understand as a foundation for more advanced topics.

This guide is centered around the STEPWorkbench, but the concepts and functionality presented are often
applicable to both the workbench andWebUI interfaces. Because of this, it is helpful for users of either interface to
be familiar with thematerial in this guide. For documentation specific to theWebUI, see theWeb User Interfaces
guide.

TheGetting Started guide contains the following sections.

l Introduction: This section includes a terminology table and an overview of some basic STEP concepts.
Thismaterial should be understood prior to proceeding through the guide as it lays the foundation for the
subsequent topics.

l STEP Workbench UI: This section introduces the user to the workbench interface, as well as providing
detailed reference information for the various functions, including toolbar actions andmenu options.

l Object Maintenance in Tree: This section provides an overview of creating, editing, and deleting objects in
the workbench, aswell as providing detailed information for working with particular types of objects.

l Navigation and Searches: This section introduces the user to basic search and navigation functionality in
the STEPWorkbench, aswell as providing detailed descriptions of the search criteria available on the
Search tab.

l Keyboard Shortcuts: This topic provides a list of keyboard shortcuts that can be used in the workbench.
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Introduction
This section introduces the reader to basic STEP terminology and concepts. This information provides a
foundation that is key to understanding the subsequent materials.

l STEP Terminology: A table defining basic STEP terms, including links to topics with additional information.

l Basic STEP Concepts:Introduces some core concepts in STEP to facilitate understanding of the Getting
Started and SystemSetup guides.

l Object Super Types: Provides an introduction to the STEP object super types, including links to detailed
information for each type.
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STEP Terminology
This topic provides definitions for basic STEP terminology that is helpful to be aware of when reading the online
help. Links to additional material on related topics are also provided, when appropriate. This should not be
considered a complete list of all STEP terms as it is intended to cover only themore commonly used terms that
users are likely to encounter throughout the online help.

A

Term Definition Further Reading

Action Type of business rule that can be executed tomanipulate data or perform
an action. Actions can be executed by various processes and events
within the system. For example, at approval of an object, within a
workflow (on entry to a state, exit from a state, on the transition between
tasks, or when a deadline has beenmet), as part of an import process, or
from a bulk update process.

See the Business
Actions topic in the
BusinessRules
documentation.

API seePublic API See the STEP API
Documentation link
on theWebStart
page.

Approval The process of pushing data from theMaintenance workspace to the
Approved workspace in STEP. Approval can be associated with business
logic that may prevent approval or may perform automated data updates
during approval. Approvals are often the triggers for sending data to
downstream systems.

See the Approval of
Objects topic in the
STEP User Guide /
Getting Started
documentation.

Asset Any type of digital media, such as an image,Word document, PDF, Excel
file, PowerPoint, JPG, GIF, etc.

See the Assets
topic in the STEP
User Guide /
Getting Started
documentation.

Asset Push A process that exports assets fromSTEP to a file system. Conversion
templates can be applied to transform images, for example from high res
to low res, resizing, applying color scales, etc, though assets can also be
sent as-is simply tomake them available on the file system.

See the Asset Push
topic in the Digital
Asset Exchange
guide.
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Term Definition Further Reading

Assignee The user or group to which a task is assigned for work to be performed
within a workflow. User states can be assigned directly to a named user
or to a user group.When a state is assigned to a user group the task is
"offered" to all members of that group. To perform the task associated
with the state, amember of the group has to claim the task. Once a task is
claimed it is no longer visible in the group task list; only the person who
claimed the task is able to see it. A user may subsequently release a task
back to the group.

See the Assignees
inWorkflows topic
in theWorkflows
documentation.

Attribute A characteristic or detailed piece of information related to a particular
object. Attributes can be one of two types, description or specification.
Description attributes are available onmost object types in STEP, while
specification attributes are only available on objects in the Primary
Product Hierarchy.

See the Attributes
topic in the Super
User Guide /
SystemSetup
documentation.

Attribute
Group

Groups attributes, reference types, and/or link types. Attribute groups can
have sub-groups.

See the Attributes
Groups topic in the
Super User Guide /
SystemSetup
documentation.

Attribute
Value

The value stored in a particular attribute on a particular object. See the Attributes
topic in the Super
User Guide /
SystemSetup
documentation.

B

Term Definition Further Reading

Bookmark A placeholder created by the user that serves as a shortcut to a
previously viewed location.

See the Bookmarks
topic in the STEP
User Guide /
Getting Started
documentation.

BusinessRule Automated piece of programming logic that may implement
customer-defined rules, such as validations, automatic updates,
notifications, data-driven workflow routing, etc. Also see Condition
and Action.

See the Business
Rules topic in the
BusinessRules
documentation.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 12



C

Term Definition Further Reading

Calculated
Attribute

An attribute where the value is calculated according to a specific
formula defined for this attribute. The formulamay include static
text, other attribute values, information from references on the
object, and a number of other options.

See the Calculated
Attributes topic in
the SystemSetup /
Super User Guide
documentation.

Category Profile View in STEP that helps product managers and data analysts to get
an overview of an entire section of the Product Hierarchy through
variousmetrics that are displayed in dashboard format.

See the Data
Profiles topic in the
Data Profiling
documentation.

Character Tag An entry that begins with “<” and endswith “/>” such as <check/>.
These tags represent characters that may not be found in the
special character map in Unicode, or may be used instead of the
Unicode character.

See the Tags topic
in the System
Setup / Super User
Guide
documentation.

Claim The action that a user performs to take a task in a workflow out of a
group queue and assign to himself / herself.

See the Claiming
and Releasing
Tasks inWorkflows
topic in the
Workflows
documentation.

Classification A particular type of hierarchy that organizes groups of objects or
assets. Objects are linked to classifications via references, andmay
have references tomultiple classifications. Also referred to as
"yellow folders".

See the
Classifications
topic in the Getting
Started / User
Guide
documentation.

Collection An object that holds a static set of objects, or a dynamic search
criteria that can be refreshed as needed to find the latest matching
objects. Using collections, the resulting data can be displayed, bulk
actions can be performed, or the objects can be exported.

See the Collections
topic in the Getting
Started / User
Guide
documentation.

Completeness
Score

A measurement within STEP, expressed as a percentage, to
indicate the proportion of key data that has been completed for a

See theObject
Completeness
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Term Definition Further Reading

particular object. This key data is configurable, as well as the
weighting of importance.

topic in the Data
Profiling User
Guide
documentation.

Condition A condition is a type of business rule that evaluates to either true or
false. In relation with approval, a condition can act as validation for
whether an approval action can be carried out. In relation to
workflows, conditions can be used to prevent a transition from being
taken if certain conditions are not met. A conditionmay not change
data.

See the Business
Conditions topic in
the BusinessRules
documentation.

Context A specific filter placed on the system data. Each context is a
combination of different dimensions such as language, country, and
so forth, for example, English US, French CA, or GermanDE. Data
may vary based on context.

See the Contexts
topic in the System
Setup / Super User
Guide
documentation.

D

Term Definition Further Reading

DataModel Basic system configuration defining the allowable structures
andmake up of data within STEP. Consists of system setup
data, including: dimensions, contexts, object types,
reference types, keys, component models, attribute groups,
attributes, lists of values, units, and tags.

See the System
Setup / Super User
Guide.

Deadline Optional setting within a workflow for time allowed for a task
to be completed. If a deadline expires on a task, it is possible
to perform an escalation.

See the Deadlines
and Escalations in
Workflows topic in
theWorkflows
documentation.

Derived Data Data that is not directly imported or migrated, but is instead
derived by the STEP system as part of or following import or
migration. Consists of translation status, asset push status,
asset push content, approval status, and any data
constructed or transformed by business rules or calculated
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Term Definition Further Reading

attributes.

Dimension A definition of the context-sensitive domain in STEP, such as
language or country, which allows for different layers of
information in which content can vary. Each systemmust
have at least one dimension and attributes and references
may be dimension-dependent. For example, the color name
can differ per language (e.g. red and rouge) when the
language represents the dimension.

See the
Dimensions and
Dimension Points
topic in the System
Setup / Super User
Guide
documentation.

Dimension-Dependent
Attribute

An attribute that can have different values for different
dimension points, where the actual value is determined by
the context in which the attribute is presented.

See the Dimension
Dependent
Attributes topic in
the Super User /
SystemSetup
documentation.

E

Term Definition Further Reading

Entity A group of master data that has a specific businessmeaning. Entities
typically store product-neutral data in STEP according to client-
specific groupings of information, such as customers, employees,
suppliers, and addresses. Entities are also often used to store
reference data that is utilized within the system. Entities can be
grouped into a hierarchy using reference types that are only valid
from an entity object to an entity object. A source object can be
displayed as a child of the target object or the target as a child of the
source.

See the Entities
topic in the Getting
Started /
STEP User Guide
documentation.

Escalation The action(s) to be taken when a deadline expires within a workflow.
Escalations require at least one business rule to be configured, which
is triggered by the escalation.

See the Deadlines
and Escalations in
Workflows topic in
theWorkflows
documentation.

Event Events are recorded actionswithin the system, such as an approval,
transition in a workflow, or a change in globally revised data. Within

See the Events
topic in the Super
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Term Definition Further Reading

workflows, events are also the names assigned to particular
transitions.

User / System
Setup
documentation.

Event Queue Queue to store events that have occurred on the system, to later be
processed by an asset push, outbound integration endpoint, or event
processor.

Externally
Maintained
Attribute

A characteristic of an attribute or reference that can be set to ’Yes’ or
’No’. A ’Yes’ selection indicates that the data point ismaintained
externally, and a change in it does not trigger a change in approval
status and/or a new revision on the STEP object on which the data
was changed. A ’No’ selection indicates that the data point is
maintained internally and a change in it has the potential to trigger a
change in the approval status and/or a new revision on the STEP
object on which the data was changed.

See the Externally
Maintained
Attributes topic in
the Super User /
SystemSetup
documentation.

F

G

Term Definition Further
Reading

Golden Record Collection of data from a variety of sources, based onmatching,
linking, and survivorship rules. TheGolden Record is considered
the trusted data record, compiled from the various source objects.

See theGolden
RecordsMatch
Action topic in
theMatching,
Linking, and
Merging
documentation.
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H

Term Definition Further
Reading

Hierarchy A data structure composed of parents and children. See theObject
Type Hierarchy
topic in the
Object Types
and Structures /
Super User
Guide
documentation.

Hotfolder File system of folders where data can be dropped for automatic loading
into STEP, based on the particular configurations and/or code applied
to the hotfolder.

See the IIEP
Receiver
Methods in the
Data Exchange
documentation
or Asset
Importer in the
Digital Asset
Exchange
documentation.

I

Term Definition Further
Reading

ID The unique identifier for all objects within STEP. It cannot be
translated or edited once created, and cannot contain special
characters.

Image Conversion A series of parameters defining the way in which an image is
transformed from the standard high resolution asset that exists in
STEP to the required downstream format. Several conversion
options are available by default, and additional conversions can
be added via configuration and/or extensions. Note that
conversions change assets as they are pushed fromSTEP,
leaving the originating file unchanged in STEP.

See the Image
Conversion
Configurations
topic in the
Digital Asset
Exchange
documentation.
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Term Definition Further
Reading

Inbound Integration
Endpoint (IIEP)

Communication channel defining how data is received by STEP.
Each endpoint defines how data is received from an external
system, specifying location, transport protocol, data to be
exchanged and other configuration parameters.

See the Inbound
Integration
Endpoints topic
in the Data
Exchange
documentation.

Integration Endpoint
(IEP)

Communication channel between STEP and external systems.
See Inbound Integration Endpoint andOutbound Integration
Endpoint.

See the Data
Exchange
documentation.

Inheritance The ability to make data available in the product or classification
hierarchy to lower nodes by linking it to a higher node in the
hierarchical structure.

See the
Inherited
Attributes topic
in the Super
User / System
Setup
documentation.

J

K

L

Term Definition Further
Reading

Library Set of functions that can be reused inmultiple business rules or other
libraries. Libraries cannot be called independently andmust be
referenced from other actions, or conditions.

See the
Business
Libraries topic in
the Business
Rules
documentation.

List of Values
(LOV)

A validation base type for an attribute that only allows a value to be
considered valid if it belongs to a respective list of pre-configured values
assigned to the attribute. Also used to refer to the value list itself. LOVs
are also referred to as 'Domains' at times.

See the List of
Values (LOVs)
topic in the
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Term Definition Further
Reading

SystemSetup /
Super User
Guide
documentation.

Localized Value An attribute value that is set directly on an object and is not inherited
from any level above in the hierarchy.

See the
Inherited
Attributes topic
in the System
Setup / Super
User guide
documentation.

M

Term Definition Further
Reading

Mandatory
Attribute

Indicates that the product and all its sub-productsmust have a value for
the specified attribute in order for the object to be approved.

See the
Mandatory
Attributes topic
in the Super
User / System
Setup
documentation.

Multi-Valued
Attribute

An attribute that can contain more than one value for a specific object. See the Editing
Multi-Valued
Attributes topic
in the Super
User / System
Setup
documentation.
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O

Term Definition Further
Reading

Object An element within the system, for example, a product,
image, classification, attribute, workflow, business rule,
etc.

See the Basic
STEP Concepts
topic in the
Getting Started /
User guide.

Object Type A specific label for levels within a taxonomy, given to
different elements within the system. Nearly every object
in STEP is labeled with an object type to help identify
what it is (i.e. a product or entity rather than an image, a
TIF rather than a PDF, etc.). This includes entities,
products, product categories, alternate hierarchies,
images and other assets, attributes, and LOVs. Through
the use of object types, system administrators can
control how rigid or loosely defined the database will be
in terms of object creation and where objects are
allowed to ‘live’ and/or be used. This labeling also
becomes very important when working with exported
data so that each type of object in STEP can be
identified for special handling in web applications or
other uses outside of STEP.

See the Basic
STEP Concepts
topic in the
Getting Started /
User guide.

Orphan Attribute A specification attribute that has a value, which has been
deleted from / not linked to a product node or
classification and is denoted by italics.

See theOrphan
Attributes topic
in the System
Setup / Super
User Guide
documentation.

Outbound Integration Endpoint
(OIEP)

Communication channel defining how data is sent by
STEP. Each endpoint defines how data is sent to an
external system, specifying location, transport protocol,
data to be exchanged and other configuration
parameters.

See the
Outbound
Integration
Endpoints topic
in the Data
Exchange
documentation.
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Term Definition Further
Reading

Postprocessor A plugin component within the IEP framework that
allows STEP to act on the result of the import / export
such as starting workflows, sending notifications, etc.

See the IIEP
Configuration
Flipper and the
OIEP Output
Templates
Flipper topics in
the Data
Exchange
documentation.

Preprocessor A plugin component within the integration endpoint
framework that allows STEP tomodify themessage
prior to import / export. It can be used for various
functionality such as prevalidation, format conversion,
filtering, etc.

See the IIEP
Configuration
Flipper and the
OIEP Output
Templates
Flipper topics in
the Data
Exchange
documentation.

Primary Product Classification
(PPC)

Hierarchy that allows for different types of objects to be
stored once in the database; each object within this
hierarchy has a unique ID / identifier andmay have only
one location within the hierarchy. Also referred to as the
'blue hierarchy'.

See theObject
Type Hierarchy
topic in the
SystemSetup /
Superuser
documentation.

Product One of the object super types, referring to any object
within the Primary Product Classification (blue
hierarchy).

See the
Products topic in
the Getting
Started / User
Guide
documentation.

Product Template InDesign templates that determine what type of data
will appear on a printed page, including the positioning
and styling.

See the Product
Templates topic
in the Publisher /
STEP'n'design
documentation.
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Term Definition Further
Reading

Product Variant Data type used tomodel multiple variants of a similar
object. For example, T-shirts in various sizes and colors
could all be variants of a single product.

See the Product
Variants topic in
the Super User
Guide / System
Setup
documentation.

Proof View A tab in the STEP workbench which displays a product
template view of the current STEP data without the
user needing to use InDesign.

See the
Generating
Proof Views
topic in the
STEP'n'design
documentation.

Publication One of the super types, referring to objects in the
publication (green) hierarchy.

See the
Publications
topic in the User
Guide / Getting
Started
documentation.

Public API The set of server-side functions that have been
exposed to be used in the business logic. This includes
many functions to create, get, and set data, such as
values and references. It also includes variousmethods
for logging aswell as sending emails.

See the STEP
API
Documentation
link on the
WebStart page.

Purge Removal of an object from the database. Following
purge, an object cannot be revived.

See the
Managing
Revisions in
STEP topic in
the Super User /
SystemSetup
documentation.
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Term Definition Further
Reading

Queue Themechanismwithin the IIEP framework that allows
messages to be processed in an asynchronousway. The
queuing concept allows separating processes from
different integration endpoints aswell as controlling the
degree of parallel imports (a queue size of one
guarantees sequential import, while a queue size larger
than one allows parallel processing of multiple messages
for increased throughput where sequential execution is
not required).

See the
Background
ProcessQueues
topic in the
SystemSetup /
Super User
Guide
documentation.

R

Term Definition Further
Reading

Reference Relationship between objects within the STEP system. See the
Reference and
Link Types topic
in the Super
User / System
Setup
documentation.

S

Term Definition Further
Reading

Special Character A character that cannot be found on a standard
keyboard but can usually be found in theWindows
character map. Ex: Trademark Symbol - ™

See the Tags
topic in the
Super User /
SystemSetup
documentation.
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Term Definition Further
Reading

State A step within a workflow to which a specific user, user
group, or system can be assigned to complete the task
(s) associated with the state.

See the
Creating a
Workflow topic
in theWorkflows
documentation.

STEP = Stibo Enterprise
Platform

Master data software application that provides
businessmanagers a single source database to store,
manage, and re-purpose product information for
publication or syndication.

STEP’n’design STEP’s plug-ins for InDesign that allow data from the
STEP database to be pulled onto pages.

See the STEP
Publisher /
STEP’n’design
documentation.

STEPXML The native XML language for STEP, which can be
used for importing / exporting data in STEP, aswell as
transferring configurations between STEP systems.

See the
STEPXML
Format topic in
the Data
Exchange
documentation.

Super type A major category of data within STEP. STEP super
types are: Asset, Classification, Entity, Product, and
Publication. See the specific definition for each super
type for additional information.

See theObject
super types topic
within the
Getting Started /
User guide.

Super User A user that is given administrative privilegeswithin the
STEP system.

See the Actions
Sets topic in the
Super User /
SystemSetup
documentation.
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T

Term Definition Further
Reading

Task The work and/or action that must be completed within a
specific workflow state (whether by a user or via
automation).

See theWorking
with Tasks in
Workflows topic
in theWorkflows
documentation.

Transition The change of tasks from one state to another within a
workflow.

See Creating a
Workflow in the
Workflows
documentation.

U

Term Definition Further
Reading

Unique Key A unique key is a system entity that represents a specific object in the
STEP system. The entity is composed of one or more data points,
whether utilized as-is or in a combined and/or transformed format using
a specified formula. There can be exactly one record for each object for
each defined key. No two objects with the same unique key for an active
key can exist.

See the Unique
Keys topic in the
SystemSetup /
Super User
documentation.

User
Permissions

Rules that allow or restrict users from performing certain functionswithin
the system.

See the
Privilege Rules
topic in the
Super User /
SystemSetup
documentation.
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V

Term Definition Further
Reading

Validation Base
Type

A characteristic of attributes that identifies the format of the accepted
data for the attribute value, such aswhether the value is a date, integer,
fraction, text, LOV, etc.

See the
Validation Rules
topic in the
SystemSetup /
Super User
documentation.

W

Term Definition Further
Reading

WebUI A web-based interface to access the STEP database in
order to read, edit, or download data and assets.
MultipleWebUIs can be configured for each STEP
installation.

See theWeb
User Interfaces
topic in theWeb
UI
documentation.

Workbench An interface for managing data in STEP, aswell as
carrying out administrative functions.

See the STEP
Workbench UI
topic in the
Getting Started /
STEP User
Guide
documentation.

Workflow Business process(es) modeled as a series of states and
tasks that can be executed by users and/or automatic
processeswithin the STEP system.Workflows prompt
the next step of a process to be started, by either
creating a task for a user, or sending an alert.
Workflowsmay contain a number of process steps or
tasks, as well as business logic.

See the
Workflows
documentation.

Workspace A set of independent ‘copies’ of the database objects
that provides a revision-specific view of objects.

See the
Workspaces
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Term Definition Further
Reading

Workspaces are organized intoMain and Approved
areas. TheMain workspace is where datamaintenance
takes place. The approved workspace is a non-editable
snapshot of data that has been determined to have
been acceptable for publishing to downstream systems.

topic in the
Super User /
SystemSetup
documentation.

X

Y

Z
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Basic STEP Concepts
This topic introduces the reader to some fundamental STEP concepts that provide a foundation for the rest of the
material in the Getting Started / User guide, as well as the SystemSetup / Super User guide. The focus of this
topic is on data structures and datamanagement, and is not intended to be an introduction to the full capabilities of
a STEP system.

Object Types Overview
Technically, nearly everything in STEP is an object, and object typesmust be defined for which instances of
objects can exist. Object types provide a specific label for levels within a taxonomy, given to different elements
within the system. Nearly every object in STEP is labeled with an object type to help identify what it is (i.e., a
product or entity rather than an image, a TIF rather than a PDF, etc.). This includes entities, products, product
categories, alternate hierarchies, images and other assets, attributes, and LOVs. Through the use of object types,
system administrators can control how rigid or loosely defined the database will be in terms of object creation and
where objects are allowed to "live" and/or be used. This labeling also becomes very important when working with
exported data so that each type of object in STEP can be identified for special handling in web applications or
other uses outside of STEP. Object types in STEP can largely be divided into two categories:

l TreeObject Types: Object types that make up the standard STEP hierarchies accessible on the Tree tab in
workbench. Many of these object types can be further grouped into five categories of object types, referred
to as the super types. Tree object types are defined in SystemSetup, but instances of the object types are
accessed within the Tree.

l SystemSetupObject Types: Also referred to as BasicObject Types. This category encompasses all of the
remaining object types that make up a STEP system. Amongmany other things, this includes attributes,
users, integration endpoints, workflows, and business rules. SystemSetup object types are defined in
SystemSetup, and instances of the object types are also accessed within SystemSetup.

More information on object types in general, including how to create andmaintain object types, can be found in the
Object Types and Structures section of theSystem Setup / Super User documentation.

Object Super Types
Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the Product super type so objects that share data based on
common characteristics are typicallymodeled using this super type. Alternatively, digital media files are housed
using the Asset super type, which allows for automatic reading and storing of asset properties such as size and
format. Any number of individual object typeswithin each super type can be created. For example, a systemmay
use both an 'Icon' object type and an 'Illustration' object type (along with any number of others) within the Asset
super type.

The object super types are:
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1. Assets

2. Classifications

3. Entities

4. Products

5. Publications

More information on the characteristics of the various super types can be found in theObject Super Types topic
within this guide.

Object Types Versus Object Instances
Two core capabilities for managing data in STEP are the Tree tab and the SystemSetup tab. In order to
successfully use STEP, it is critical to understand the differences between the functions available in these two
areas, specifically in relation to types of objects versus instances of objects.

Technically, everything in STEP is an object, including workflows, attributes, business rules, export and import
configurations, products, classifications, images, etc. However, the term "objects" ismore generally used tomean
assets, classifications, entities, products, and publications. In other words, the super types are also all things that
you can find on the Tree tab in STEP. This section focuses on the differences between object types and object
instances for Tree objects, specifically those that fall into the super types.

For example:
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The objects and structures available in the Tree will vary based on your particular datamodel, but the concepts
described can be applied across any datamodel. Regardless of the specific names or structures, each node on
the Tree tab is an individual object that has a defined "place to live" within a hierarchy. A user can right-click on
many of these objects and have a 'New...' option, such as 'New Product' or 'New Classification', allowing them to
create a new node in the hierarchy. For example, when right-clicking on the 'Apparel' object and selecting 'New
Product', a dialog appears with an option to create a 'Level 2' object.
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Typing a Name and clicking Create would create a new object as a child to the Apparel node. But what defines
that a 'Level 2' object can be created on this node? And that it is a Product (blue) object rather than an Entity (gray)
or Classification (yellow)?

The allowable structure of objects and hierarchies that are accessed in the Tree are defined in SystemSetup. To
continue with the above example, we can see that the defined object types and structures include a Primary
Product Classification that has a number of levels. A Level 1 can only have a Level 2 child, which can in turn, can
only have a Level 3 child. However, a Level 3 object type can have a number of child object types, including an
Item Folder, Level 4, and a Sales Item Folder. A Sales Item Folder is a child of a Level 3 object type, asmentioned,
but can also be a child to a Level 4. Similarly, a Sales Item can be child to multiple things, including a Sales Item
Folder and a Sales Item Family.
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The object types defined in SystemSetup provide the "skeleton" for the allowable instances of objects that can be
created in the Tree. It is important to understand that it is only the structure and types of objects that are defined in
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SystemSetup, but any number of instances of the defined types can be created in Tree. This is best illustrated by
viewing SystemSetup and Tree side by side, as shown below. Object instances are displayed in Tree, with red
text indicating the corresponding object type designations fromSystemSetup.

Notice in the above screenshots that a Level 2 object exists in SystemSetup only once, but we seemultiple
instances of it in Tree.
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The same principles described for the Primary Product Hierarchy apply to all other hierarchies in STEP. For
example, an entity hierarchy could have a Customer object type with allowable children of Address and Contact
object types. The object types and structures are defined in SystemSetup, and instances of these objects can then
be created in Tree.

Note that object super types can only exist within their designated hierarchy types. To clarify, a product hierarchy
(blue hierarchy) can only contain object types of the product super type, while an entity hierarchy (gray hierarchy)
can only contain objects of the entity super type. It is possible to have the visual appearance of mixed hierarchies,
but this is accomplished via references rather than actual data structures. For example, productsmay appear in
the Tree to be within a classification hierarchy, but this is due to references on the object, as shown below.
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Notice that the corresponding SystemSetup structure for the above does not include the product object types.

The true residence of the product objects is within the Primary Product Classification, with a visual display of the
product references into various classification hierarchies being just that: a visual display of references. However,
assets are an exception to this concept. Assets are not part of the Classification structure in SystemSetup, but do
in fact exist within this structure in Tree. Each asset must be linked in to one or more classifications, and this is the
only location in which they "live" in STEP. Each asset automatically has a reference applied to each classification
in which it is linked. More information on references can be found in theReference and Link Types topic in the
System Setup / Super User guide. More information on the various object super types and their characteristics
can be found in theObject Super Types topic within this guide.

Using the above information, the questions posed earlier in this topic can now be answered:

Why can we only create a Level 2 object under the Apparel node?Because in this particular datamodel
configuration the Apparel node is a Level 1 object type, and only Level 2 object types are allowed to be created
under a Level 1 object type.

Why can't we create an Entity or Classification under the Apparel node?Because only object typeswithin the
same super type can exist within the same hierarchy. And even if this wasn't the case, the structure defined in
SystemSetup in this particular hierarchy only allows a Level 2 object type (of the product super type) under a Level
1 object type.
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Object Super Types
This topic provides an introduction to the STEP object super types. It will be helpful to have read and understood
theBasic STEP Concepts topic in this guide prior to reading thismaterial.

Object types that make up the standard STEP hierarchies accessible on the Tree tab in workbench are referred to
as TreeObject Types. Many of these object types can be further grouped into five categories of object types,
referred to as the super types. This topic introduces the five primary object super types in STEP. Understanding
the differences between the various object super types is important whenmaking decisions about how tomodel
data in STEP.

Each super type has specific characteristics that make it suitable for modeling particular types of data. For
example, inheritance of data is available within the Product super type so objects that share data based on
common characteristics are typicallymodeled using this super type. Alternatively, digital media files are housed
using the Asset super type, which allows for automatic reading and storing of asset properties such as size and
format. Any number of individual object typeswithin each super type can be created. For example, a systemmay
use both an 'Icon' object type and an 'Illustration' object type (along with any number of others) within the Asset
super type.

The object super types are:

1. Assets

2. Classifications

3. Entities

4. Products

5. Publications

Each is described below, along with links tomore detailed information for working with the various super types.

Assets
The Asset super type is used to hold any type of digital media, including images, videos, documents, and text files.
Assets are organized within classifications, and can be linked to other objects in STEP using references.
Specifically, assets can be linked to objects of the Classification, Entity, or Product object super types. Upon
import, STEP populates some basic information about each asset, which can be viewed under the System
Properties flipper on each asset, but cannot be edited. Default asset icons vary by file type, and can be updated by
admin users.
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For more information on working with assets, see theAssets topic within this guide.

Classifications
TheClassification super type is used to build hierarchies and objects that bundle other objects into organized
groupings. These are represented by default with yellow folders in STEP, though these iconsmay be updated by
an admin user. For example, images, manuals, and icons could be uploaded to STEP as assets and stored in
appropriate subfolders under the 'Assets' classification folder. Product objects could also be linked into
classifications to provide alternative categorizations of objects that vary from the product hierarchy structure.
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For more information on working with classifications, see theClassifications topic in this guide.

Entities
The Entity super type is used to create hierarchies and objects that do not require inheritance of data through
categorized groupings. Entities are commonly used to store customer, location, or person data, as well as to store
reference data. In addition, entities are used to store source data for golden records. Entities are represented by
gray folders and white and gray cubes by default, but these can be updated by an admin user, as is evident in the
screenshot below.
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For more information on working with entities, see theEntities section of this guide.

Products
The Product super type is used to create hierarchies and objects that use inheritance of data for objects
categorized by similar characteristics. In STEP, products are represented by default with blue icons either as
folders or nodes, though these icons can be updated by an admin user. Upper nodes in a product hierarchy are
often categories and subcategories, with leaf nodes being actual objects. Whether an organizational folder,
sellable object, or something else, each node in the hierarchy is of the product super type, and all child objects are
able to inherit attributes and values from parental objects.
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For more information on working with products, see the Products section of this guide.

Publications
The Publication super type is used to create hierarchies and objects used for print publishing solutions, including
STEP'n'design, Flatplanner, and AutoPage. Publication objects are used to create templates used in print
solutions, as well as publications such as catalogs or pamphlets. Product objects can be linked into publication
hierarchies, meaning data from the product(s) will be reflected in the publication. Publication objects use green
icons by default, though these can be updated by an admin user.
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For more information on working with publications, see thePublications section of this guide.
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Accessing STEP System Information
The simplest way to access system information about your STEP installation is by clicking theAbout STEP icon
on theWebStart page.

STEP system information is useful for system troubleshooting and new project planning, as well as helping users
ensure compliance with their contracted license terms.

Though system information is also obtainable through the Admin Portal install.log or by running a Stibo Patch
Operations Tool (SPOT) command on the application server, clicking About STEP is themost straightforward way
to obtain this information. For more information on the install.log, see the Logs topic in theAdministration Portal
documentation. For information on the SPOT command, system administratorsmay contact Stibo Systems.

'About STEP' Page
When the About STEP icon is clicked, a new page is opened (e.g., http://[yoursystem]/about/step) that is
password protected to ensure that only STEP users have access to the information.

This 'about' page displays the following information:

l System name

l STEP version, in a string that identifies the system by its baseline version that includes themajor release
version number (e.g., 8); minor release number (e.g., .2); themaintenance patch version, if applicable (e.g.,
mp1); and the baseline creation date.

l Number of user accounts and the number of allowed user accounts. Standard STEP users that do not count
against the number of licensed users—such asDBA, STEPSYS, SERVICE, and SWADMIN—are not
included in the user count.

l The approximate number of products, classifications, assets, and entities. Object counts are approximate
because changes could be going on in the background while the page is being viewed. Also, for time
purposes, the quick approximation number is preferable to an exact count, which could potentially tie up
system resources for a prolonged time.

l The number of contexts, dimensions, and languages

© Stibo Systems - Confidential - STEP Trailblazer 8.3 42



Detailed Version Information
A 'Detailed Version Information' hyperlink is also included that opens a new page (e.g. http://
[yoursystem]/about/version) where you can access information about the add-on components, customizations,
and hotfixes applied to your system. If your system contains none of these, only the current baseline version of the
system is displayed.
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System Snapshot and Diagnostics Package Links
Below the bullet list, additional information is provided to assist users who need to accessmore complete system
information for support purposes.

Provided is a snapshot.spr link where you can download a snapshot file that contains full system information,
including installed bundles, metrics, and differences to previous snapshots. This file is intended to be submitted to
Stibo Systems along with support requests. For more information on snapshots and their contents, see the Tools
topic in theAdministration Portal documentation.

Also included is a link to the Administration Portal page, in case you need to produce a diagnostics package. This
package is generated and uploaded to Stibo from the 'Send Diagnostics' tab. For more information, see theSend
Diagnostics topic in theAdministration Portal documentation
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STEP Workbench UI
The screenshot below shows a basic view of the STEPWorkbench. Though system customizations and variable
access permissionsmay result in a slightly different view, the basic elements appearing in this view of the
workbench'sMainWindow will be present for most users. Nine of those basic elements are numbered in the
screenshot below and labeled in the list appearing below the screenshot. Each item is covered in detail in separate
topics, with links to those topics below.

Note: The STEPWorkbench is a Java client. STEP backend usesOracle.

Main Window - Basic Elements
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1. Menu Items

2. Toolbar

3. Tree Tab

4. Search Tab

5. Background Processes Tab

6. SystemSetup Tab

7. Bookmarks Tab

8. STEPWorkflow Tab

9. Object Editor

Main Window - Other Elements
Other elements appearing in this view of the STEP workbench that are useful to understand, but do not require
their own topic, are numbered in the screenshot below. An additional list appears below the screenshot that
names these elements and provides further information.

1. System Information. At the very top of the STEP window, important information about the user's STEP
system is listed. The first element displayed is the name of the STEP system, then the user ID, followed by the
URL of the STEP system being accessed.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 46



2. Pin - This option allows users to pin at the right-hand side of the window. By default, this will be unpinned

. One such use case can be seen with adding objects to the Flatplanner basket. To see this example, see
theAdding Objects Manually to the Basket topic in the Flatplanner documentation.

Once pinned, a user may navigate to other items in the Tree while the information in the right side of the screen
remain unchanged.

3. STEP connection status. Displays the status of STEP's connection to the internet. When the connection is
strong and STEP is ready to run normally, the status will read 'Ready.' Other statuses that may appear are:

l Reading. STEP is requesting information from the database.

l Lost Connection to. STEP has lost connection to the server.

l Reconnected to. STEP has reconnected to the server after a lost connection. May alternate with the
Lost Connection to status if the connection to the internet is lost for a significant period of time.

4. Connection strength. A small graph illustrating the connection strength between the user and the server,
also know as the 'Network Latency.' If a user hovers their cursor over the graph, a hover-over display will
appear showing how fast data is traveling between the server and the user asmeasured inmilliseconds.
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Background Processes Tab
The Background Processes tab shows all active and non-active processes in STEP. Each time there is any activity
such as imports, exports, bulk-update, creating collections, etc, there is a background processes, BGP, which
generates the logs and lets the users know if the processwas successful. In the event of an unsuccessful
background process, an error message is displayed showing the reason for failure.
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Background process contains:

l Properties describeswho has started the Background Process, unique identifier (BGP ID – Auto generated),
describeswhat kind of BGP was performed, such as export or import or bulk update etc., statuses of the BGP
such as 'Succeeded' or 'Failed,' BGP creation date and time, BGP start dated and time, BGP end dated and
time, the amount of time taken to process the request, number of warnings, and number of error messages.
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l Execution Report is a detailed user-friendly BGP information report. If the process failed, then it displays a
short message about why this is failed.

l Save - It is possible to download the execution report. Click on the 'Save' button, 'Save File' window appears.
Browse to where you want to download the file and give it a file name.

l Truncate - This button will be available only on 'Ended Processes' section of the BGP.

This action is used when there are lot of logs or lines under the execution report, and if a user wants to view any
particular information, such as an error or warning. The user can truncate the logs accordingly by setting the
parameters in the 'Truncate execution report' dialog.

For example, if the execution report has 50 lines, and a user wants to see only 19 lines among the report that are
error related.

Number of lines to retain: 19
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Execution report entry types to delete:Enable check box for 'Info' & 'Warning'

Click on 'OK' button

Result: This will truncate the execution report and retain only the first 19 error lines.

Note: Once the lines are removed, they cannot be recovered again.

Based on the type of activity being generated, there aremany different kinds of background processes. A few are
mentioned below:

1. Approve recursively

2. Bulk Update

3. Create Collection

4. Download Report

5. Export Manager Pipeline

6. Import Manager Pipeline

7. Purge Revisions

8. Revive Recursively

9. Translation

10. Translation Import

Background Process View Options
In the Background process tab, there are two option for viewing BGPs. A user logged in can choose to see only
the BGPs that they have initiated, or the user could choose to see all the BGPs run by everyone. These two
options can be selected by clicking on either the 'OneMan andGear' button or the 'TwoMen andGear' button.

One Man and Gear: This icon, , will display the background process run by the user who has logged into the
STEP system.
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Two Men and Gear: This icon, , will display the background process run by all users of the STEP system. To
have this privilege available, the 'View Background Processes of Other Users' setup actionmust be added for the
users who need access to this feature. For information on privileges, see the Setup Actions topic in the System
Setup documentation.

Background Process States
Fore each background process started, there are four states that it could enter. Below each state is described in
detail:

Active Process
This shows the list of processeswhich are currently being executed. If there are any processeswhich failed, then
those processeswill still be in the active process node, but highlighted in Red color.
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Queued Process
This shows the list of processeswhich are in queue. Once the active processes are complete, the queued process
moves to the active process.

Completed with Errors
This shows a list of processeswhich are completed, but with a few errors. Theminor errors are displayed with the
details, but the one’s which can be processed will eventually complete.

Note: 'Completed with Errors' option is only available for Import manager pipeline, Smartsheet Import, Stateflow
dead line, andMatch code process.
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Ended Process
This displays a full list of all the processeswhich have been processed without any errors.

For information on Background ProcessQueues, please see theBackground Process Queues topic in the
System Setup documentation.
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Bookmarks Tab
The Bookmarks tab allows users to set bookmarks for any objects in the Tree and allows users to easily access
these objects without having to search or navigate the Tree.

A bookmark is a UniformResource Identifier (URI) that is stored to provide the user with a quickmethod of
retrieving the data at any time. Bookmarksmay be accessed either by themenu selection Navigation >
Bookmarks or by the Bookmark tab.
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Note:

l Bookmarks are stored on the local STEP system and are not accessible when logging into STEP from a
different computer.

l Bookmarks allow the setting of bookmarks specific to individual users – just as in a web browser. Thismeans
that one user will not be able to view the bookmarks created by another user.

To know more about the Bookmarks andmaintaining Bookmarks, see theBookmarks topic in theNavigation
and Searches documentation.
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Adding a Bookmark
Standard navigation Bookmarks are used to quickly access specific nodes in the Tree and SystemSetup
hierarchies. These bookmarks save the URL of the currently selected object. Any objects from Tree or System
Setup hierarchies can be added with the usage of Bookmarks functionality.

To save an object as a Standard Navigation Bookmark:

1. In Tree, select the item to be bookmarked.

2. On the Navigatemenu, select Bookmark > Add Bookmark.
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Note: Notice that the existing bookmarks are displayed on themenu.

3. The new bookmark is displayed on the Bookmarks tab.

Note: The Standard Navigation Bookmark is saved under the Bookmark Tab. The bookmark is represented with
the product icon and automatically labeled with the product name and ID in parenthesis.

4. Click the new bookmark.
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5. Navigate to the Bookmarksmain tab, andgo to the Product subtask on an object to view the bookmark data.

Bookmarks can also be created using ashortcut. Select the object and pressCtrl+D. The bookmark is created
automatically.
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Removing a Bookmark
After saving a Bookmark, it may no longer be needed eventually. There is a right-clickmenu option that can
remove a selected bookmark.

1. On the Bookmarks tab, right-click the bookmark to be removed and click Remove Bookmark.

2. The selected bookmark is removed.

Note:

l No confirmation window before removing will be displayed.

l Bookmarks can only be removed and not deleted. If user deletes a bookmark (Maintain menu > Delete), then
the object will be deleted. However, the deleted object could be found in Recycle bin.
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Editing a Bookmark
BothStandard Navigation (the link to specific objects) andSearch Bookmarksmay be edited in the
Bookmarks tab. To edit a bookmark:

1. On theBookmarks tab, right-click the bookmark to bemodified and click 'Edit Bookmark.'

2. If desired, change the name of the Bookmark then select 'OK.'

3. The namewill be updated in the Bookmarks tab.

4. The object URL can be edited only if the Edit URL checkbox is activated. In the below screenshot, the Product
URL has beenmodified which points to a new Product URL –
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Similarly, 'Search Bookmark' can be edited by editing the 'Search URL,' if the 'Edit URL' checkbox is edited.

5. Click the 'OK' button to save any changes to this bookmark.
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Copying a Bookmark to the Clipboard
Bookmarks are direct addresses to a specific object, such as a product, entity, or publication, in STEP. These
bookmarks can be shared to other users by copying the bookmark to the clipboard, and then pasting this
bookmark to a shareablemedium.

1. On the Bookmarks tab, right-click the bookmark to be removed and click 'Copy to Clipboard.'

2. Paste the copied URL of the bookmark (using Ctrl + V onWindows).

The copied URL can be pasted in the URL Field of STEPWorkbench, and the user can search the respective
objects.

Note: Youmay send the copied URL to other STEP users so that they can navigate to the object or to the search
criteria.
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Menu Items
Listed below are all of the functions accessible via STEP'smenu bar.

Thoughmany tasks central to using STEP can be accomplished with a right-click on an object and then selecting
the desired option from a dropdown, some of the less frequently used functions are only accessible via themenu
bar.

File Menu
File menu has the below listed options as shown in the screenshot and each option is explained in the following
section:

Translate
Allows the ability to translate Products, classifications, and names of images and documents, Product values,
Indexwords, LOVs (List of Values), Units, Attribute names, Free text cells in tables in theWorkbench and to
import translations.

For more information on the translate functionality, see the Translation documentation.
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Import / Export
Allows the ability to load data / images and documents / eCl@ssClassifications, GPC, ETIM, or to export data /
images and documents. The user can also schedule imports and exports from their menu selections.

Note: To import eCl@ssClassifications a license is required. For more information about eCl@ss, see the
eCl@ss Format topic in theData Exchange documentation.

See the Import Manager topic and theExport Manager topic in theData Exchange documentation for more
information on these topics.

Reports
Launches the Standard Reports and any custom data reports. For more information on this tool, see theReporter
documentation.

Bulk Update
Allows the user to launch or schedule a Bulk Update. For more information on bulk updates, see theBulk
Updates documentation.

Schedule Category Profiling
Launches the Schedule Category Profiling dialog. For more information on category profiles, see theGenerating,
Updating, and Scheduling a Data Profile topic in theData Profiling documentation.

Save
This allows the user to save any changes that aremadewithin theWorkbench.

Note: This option does not get activated at all in STEP.
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Change Password
During any session, any user may change their own password. Clicking onmenu option, the user needs to enter
Old Password, New Password, and Retype the new Password. The new password will take effect on next time
login.

For other ways to change your password, see theChanging User Password topic in theUser and Groups
documentation.

Empty Recycle Bin
Contents of the Recycle Bin are permanently deleted when this function is selected. Can also be accessed by
right-clicking on the Recycle Bin icon in the [Tree] tab.

Steps to Empty Recycle Bin:

l Select the option 'Empty Recycle Bin.'

l A 'Confirm Purge' dialog with analysis of all the available content in Recycle Bin will be displayed.

l Click the 'Purge' button.

All the content will be permanently deleted.

Empty Recycle Bin Before
Contents before a specified date are deleted.

Steps to Empty Recycle Bin Before:
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l Select the option 'Empty Recycle Bin Before.'

l 'Empty Recycle Bin Options' dialog is displayed to select a date to delete the objects before a specified date.

l Click on the ellipsis […] button.

l 'Date Picker' dialog will be displayed.

l Click onOK button in 'Date Picker' dialog.

l Click onOK button to 'Empty Recycle Bin' dialog.

Recycle bin contents which are deleted before a specified date will be deleted.

Note:When you right click on the Recycle Bin icon in the Tree tab, Empty Recycle Bin and Empty Recycle Bin
Before are available along with other options.

Purge Old Revisions
This is a global purge of revisions contained within a specified workspace. The PurgeOld Revisionsmenu item
require further information:

1. Type - Type of object - Product, Classification, Asset, DTP Documents, SystemConfiguration which has to be
included in purge, then for each type further granule can be done by selecting the below options.

2. Object Types - By selecting this option, the user can pick the required objects from the dropdown, they can
pick individual or multiple object types.

3. File specifying IDs - If this option is selected, then the user should point the file which contains the IDs of type
(Product, Classification, Asset, DTP Documents, and SystemConfiguration). Click on the browse button to
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import a TEXT file with the required IDs to be purged. IDs can be inserted one below other. Background
processwill trigger once the file is selected.

4. All Object Types - By choosing this option all the object types from the systemwill purge revisionswith a
background process.

5. Date - The date range with time can be set by specifying the date with a date picker pop up to select the date.

6. Purge All Workspace - This option will purge the above selected objects fromApproved aswell fromMain
Workspace.

Click onOK button, there will be a background processwith an execution report.

A further description of this functionality is available in theManaging Revisions in STEP section of theSystem
Setup / Super User Guide documentation.

Check integrity of external assets...
This option is enabled on systems set up to store images in file system and not in the STEP database. If a
Classification is selected the user can click thismenu item to see if all images in the selected classification have
been successfullymigrated from the database to the file system.

The integrity of the file system for storing digital assets can be double checked by selecting one or more
classifications and then select 'Check integrity of external assets' in the File menu.

This will start a background process reporting if any assets aremissing or has been changed against expectations.

Should errors be found the assets with wrong or missing content are gathered in a collection and the URL of this
collection is referenced directly from the execution report of the background process.

A normal check of approximately 10,000 asset files completes after oneminute. Thus, expect that the integrity
checkmight take some time on systemswith many assets.

Note: To enable check integrity andMigrate assets, you need to be aware of following steps and should get
approval from an authorized person.
1. Go toSystem Setup > Users & Groups.
2. Set 'Store assets and DTP documents in' to 'File System.'
3. Set the system property 'FileSystemStorage.Root' to point to a folder to be used as asset file system.

Assets can be stored in a file system on the STEP application server rather than in the STEP database itself. This
can reduce the size of the database significantly, and for DTP tools depending on having the referenced high-
resolution images directly available on the file system, replication fromDB to file system of these images can be
avoided.

Migrate assets to file system...
This option is enabled on systems set up to store images in file system and not in the STEP database. If a
Classification is selected, the user can click thismenu item tomigrate images stored in the database to the file
system location.

Themigrate assets of the file system for storing digital assets can be done by selecting one or more classifications
and then select 'Migrate assets to file system' in the File menu. This will start a background process.
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Pre-generate Thumbnail Cache...
This option will generate thumbnail Cache of image/documentsmanually.

For example, on in the Image and Documents tab of a classification folder, the image thumbnails are delayed in
generating, then Pre-generate Thumbnail Cache from File menu can be run. Once ran, it will generate a
background process. The image thumbnails will speed up with every click.

The user must have a setup action calledMaintain system to enable the option. There is also a way to automate
this option under SystemSetup tab:

l Navigate toUsers & Groups
l SelectSystem Settings tab
l Go to Image & Document Settings flipper
l Set Pre-generate thumbnail cache on upload = Yes then on upload of image or document the thumbnail will be
generated automatically.

However, there will be delays on the upload process.

By default, the following three optionswill be deactivated. After the previous settings are set, the options gets
activated accordingly.

Close Window
This option closes the active window. If there aremultiple STEPWorkbenches running / open, and if one of the
workbench is required to close, then you would use the CloseWindow option on that STEPWorkbench.
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Exit STEPworkbench
This will exit the STEP Content Manager completely by exiting all active windows. If there aremultiple STEP
workbench running / open, all the STEP workbench will be closed.

Edit Menu
Edit Menu has the standard Edit options along with STEP’s edit options as shown in the below screenshot and
each option is explained in the sections below:

Undo
Undoes the last action of the user. Note: it doesNOT undo character by character changes in text editors.

Keyboard Shortcut:Ctrl+Z

Redo
Once an action is undone by selecting 'Undo', a user can then select 'Redo' to repeat the action.

Keyboard Shortcut:Ctrl+Shift+Z

Cut
Standard 'cut' operation. This will allow user to cut the selected content.

Keyboard Shortcut:Ctrl+X
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Copy
Standard 'copy' operation. Only the selected portion of content will be copied.

Note that if a folder is copied, the subfolders will NOT be copied.

Keyboard Shortcut:Ctrl+C

Paste
Standard 'paste' operation. This will only paste the copied or cut operation.

Keyboard Shortcut:Ctrl+V

Paste and Match Style
Once something is copied or cut, this will paste with STEP styles associated with the copied / cut text. This will help
to paste the content along with current styles.

Keyboard Shortcut:Ctrl+Shift+V

Paste Link
Allows the copied object to be linked into another object (e.g. linking an attribute into a second attribute group).
Creates another instance (not a copy) of the same object, just in a different location.Allows the copied object to be
linked into another object (e.g. linking an attribute into a second attribute group). Creates another instance (not a
copy) of the same object, just in a different location.

The paste link function doesn't create a copy of a new object, but instead creates a new reference to an existing
object that was copied.

For example, if you have a new SKU in your blue hierarchy that you want to add to a series of yellow folders and
don’t want to use the References or Referenced By tabs to create all new links, you could copy the SKU and paste
into the yellow folders (classification hierarchies explained above) of your choice.

Keyboard Shortcut:Ctrl+L

Select All
Standard 'select all' operation.

1. Select any object type or background process or in SystemSetup object in the Tree. PressCtrl+A, and
everything in left view side will be selected. 'Select All' fromEdit menu won’t be active.
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2. The attribute values can also be selected using Ctrl+A command. Simply select into the attribute, and the
'Select All' will highlight all the values.

3. If you choose ‘Select All’ from ‘Edit’ menu or the keyboard shortcut while selecting an attribute in a category,
then all the flipper information is selected.
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Spelling
Enables the spelling option on the keyed in data. Spelling has two options: Automatic Spell Check and Spell
Check.

Suggestionswill be displayed when user selects Automatic Spell check.

Asset
The Asset menu includes:

1. Edit Asset: SeeAssets topic in theGetting Started documentation.
2. External Viewer: By selecting this option the images or documents is “checked out” fromSTEP and opened in

a third party application.

3. Replace Asset Content: The asset content is replaced with only the local asset. If the asset object type is
dimension dependent, and there is no local asset, Replace Asset Content will not work.

4. Create local content of Asset: The asset will become local to that context in which workbench is executed.

Note: To enable this option, in SystemSetup > Users andGroup, in Image & Document Settings flipper of the
SystemSettings tab, the Dimension Dependencies should set to either or both 'Language / Country.'

5. Update SystemProperties: In case there is delay by the system in updating asset property, this option will
update the property of asset.

6. Delete Local Content of Asset: The asset from executing context in running workbench will be deleted.
However, the asset from global context gets inherited in the executing context.

Edit Unique Key Values
Edit the key values of the currently selected object.

The 'Edit Unique Key Values' option will be highlighted if the user has selected any tree objects.

The 'Edit Unique Key Values' option, when clicked on any product object and hasUnique Key attributes linked to
it, displays a dialog with list of Unique Key Attributes for editing / adding the values.
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If the user selects an object that has no Unique Key Values defined and tries to use the 'Edit Unique Key Values'
option, amessage dialog will show.

For more on unique keys, see theUnique Keys topic in theSystem Setup / Super User Guide documentation.

Remove Row(s)
Removes a selected row, e.g. an attribute linked to a product.

Note: Remove Row(s) option will be grayed out all the time in Edit Menu.

Remove Row option will be automatically changed to relevant Remove option based on the editor selected by the
user.

Example 1 - If user selects the References tab, Remove Row option will be changed to ‘Remove Link to
Attribute’ (Ctrl + minus sign (-)) option.

Example 2 - Remove Table Type - Removes a selected row in a table, however, the 'Remove Row(s)' will
change to 'Remove Table Type' fromEdit menu when a row in a table under Table tab is selected. Youmay
remove the row by right-clicking on the row.
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For more information, see theCreating Tables topic in the Tables documentation.

Keyboard Shortcut:Ctrl + Underscore / Minus (-)

Insert Row
Adds an additional row, e.g. an attribute linked to a product.

Note: Insert Row option will be greyed out all the time in Edit menu.

Insert Row option will be automatically changed to relevant Insert/Add option based on the editor selected by the
user.

Example 1 - When user stands on the Sub Products tab, Add Product (Ctrl + Plus) will be available to add
sub products.

Example 2 - When user stands on the References tab, Link to Attribute (Ctrl + Plus) will be available to link
attributes.

Example 3 - Add Table Type – Allow the user to Add a table type for a table under Table tab.
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However, from the Edit menu, the Insert Row option is disabled. Insert Row works by selecting legal table, and
then, right click to add a row before and add a row at the end, aswell as adds new table type. For more
information, see theModifying Tables topic in the Tables documentation.

Keyboard Shortcut:Ctrl + Plus Sign / Equal Sign (+)

View Menu
View Menu as listed in below screenshot explains about the different ViewingModes, Contexts, Workspaces,
Filters, Views andmanymore and are explained in the sections accordingly:
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Mode
There are sixmodes available in STEP workbench. All of these view modes, except for Update, are available on

the toolbar .

l Normal View Mode - the view where themajority of object maintenance occurs. From the toolbar, it is

represented with the icon.
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l Translation View Mode - the split-screen view between a selected source language and the currently

selected language. The source language is also selected in thismenu. From the toolbar, it is the icon.
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Online Translation can be done from this Translation Tab. Fields highlighted in green color can be translated
within STEP from this TranslationMode.

For more information on translating data into other languages, see the Translation documentation.

l Workspace View Mode - this view shows a comparison of values betweenMain and Approved workspaces.

From the toolbar, it is the icon. For more information on workspaces, see theWorkspaces topic in the
System Setup / Super User Guide documentation.
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l Context View Mode - this view shows a comparison of values between different contexts. From the toolbar, it

is the icon. For example, this will allow a user to view values for all languages or for all price versions. For
more information, seeContexts. All context defined in SystemSetup tab can be selected as target contexts
but in the below screenshot as an example, 3 contexts are selected.
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For more information on contexts, see theContext topic in theSystem Setup / Super User Guide
documentation.

l Revision View Mode - this view shows a comparison of values between different revisions. From the toolbar,

it is the icon. If you have selected any object in STEP, then switched to the revision view, it will show like a
comparison screen of the two latest revisions. It will display from the latest revision in the first column and then
older revision.
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These revisions are also listed under Status tab in a product. For more information onmanaging revisions, see the
Managing Revisions in STEP topic of theSystem Setup / Super User Guide documentation.

Update View Mode - this view shows a comparison between object differences acrossworkspaces (Approved
andMain). Additionally, it allows the user to update the object in the current workspace from a source workspace.
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Context
TheContext shows all available contexts defined in SystemSetup tab.

The recently accessed contexts will be listed at the top of the Context sub-menu. All the other contexts in your
STEP systemwill be available under 'Other.' Selecting that option prompts the following dialog.
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For more information on contexts, see theContext topic in theSystem Setup / Super User Guide
documentation.

Workspace
Workspace shows all available workspaces. It is possible to the change workspace and view objects as they
appear in different workspaces.

For more information on workspaces, see theWorkspaces topic in theSystem Setup / Super User Guide
documentation.

Note: In theWorkbench toolbar next to the context selector, a toggle icon ( ) is available. It makes it possible to
switch betweenMain and Approved workspaces.

Note: In theWorkbench toolbar next to the context selector, a toggle icon ( ) is available. It makes it possible to
switch betweenMain and Approved workspaces.

Target
Depending on the view chosen, this function label changes from target to source.

l In the Translation view, this allows the user to select the source language.
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l In theWorkspace view mode, this allows the user to select the target workspace.

l In the context view mode, this allows the user to select single target as context or multiple contexts to compare
the content. This is the place where we can define number of contexts which should be shownwhen to click on
view translation or from the toolbar, you select context as well as deselect.

l In the Revision view mode, this allows the user to select target revision(s), provided theremust be a revision in
STEP. If the revisions aremore, on clicking others (as shown in the second picture below) it gives a window to
select necessary revision for comparison.When selected Revision view it shows only two revisions, however
by using target we can addmore revisions for comparison.

l In the Update view mode, this allows the user to select the source workspace.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 85



Filter
A view that filters out empty attribute values, non-mandatory attributes, un-editable attributes, and/or illegal
attributes.

Note: Once any of the above showed / stated option is selected, it will remain active unless the option is un-ticket
during that session of the system is working. (In case user is selected Hide Empty Values, and click on different
product it is still in the activemode.)

Primary Hierarchy

A product is located / linked in several different hierarchies. When doing quick search fromGoto for a product, a
user maywish to locate the product in a particular hierarchy.

For example, a product manager may alwayswant to view the product in its position in themain classification (All
Products). However, a web administrator maywish to view the product in its location in the alternate web
classification.

This option sets the default as to which hierarchy the product will be displayed in when it is selected from the
search’s 'hit list'.
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Select Version

Allows the user to set the default publication / version used for proofing. If the user clicks on 'Other,' it allows to
Browse / Search the Publication Version.

For more information about publication versions, see thePublication Versions topic in theGetting Started
documentation.

Note: If a publication does not contain any versions, then an error will prompt.

New View
Allows the user to create / customize a new view to hide / show attributes.

If a user has selected a product or asset the select the 'New View' option a prompt will display for a name.
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After the user may edit the filter as to what is shown on the new view. Theymay add, remove, add all, or remove all
for this new view.

Once the new view is saved, it will show in view dropdown.

Remove View
Removes an unwanted / unneeded view that was created by a user.

Product Views
Allows to choose the view and shows the products that are selected.
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Note: The 'New View,' 'Remove View,' and 'Product Views' normally gets active if the user is in Translation,
Workspace, Context, Revision, Update view mode and also whenmultiple objects are selected.

If any 'user group' in system setup tab in the system has theGUI set-up defined asUse View is enabled, then for
Normal View Modewill change.

For example, System setup > Users & Group > Stibo User > GUI set-up tab > Product Editor Contents flipper,
the option 'Use view' selected instead of 'Use normal product editor,' then objects in workbench displays the
information differently and all View related options in View menu default gets active.

Show Source Context
Attribute namesmay be translated. This option allows a user to view attribute values in a foreign language but can
still view attribute names in the source language.

This option displays to the user the Dimension Point in which the Attribute Value is stored in.

In the following example, attribute name “Attribute_English” is language / country dimension dependent. The
value is entered in the English US context. The 'Source' column is showing the language as English with the USA
as the country because values are from context English US.

The following another example but with German information.
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Rotate Table
This will flip the selected table so that the columns become rows and rows become columns. This ismost often
used in amulti-product editor.

A user has to select a column or row for a shortcut to function. In case the user has a selected view mode like
Workspace, Context, Revision or Update, then this Rotate Table option will be inactive.

It is also possible to rotate the table by the right-clickmenu in the 'Table' tab under the 'Definition' section.

If the user has press the F11 shortcut without being selected any row or column, then the Name and Defined At
will rotate but not the table.

However, if a row or column in the table is selected, there is a chance of getting an error for the row type or column
type.

The following is an example of theWorkflow table rotation.
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The following is an example rotation a table of multiple products.

Keyboard Shortcut: F11

Reload
Retrieves updated information from the database including other users’ changes.
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Keyboard Shortcut: F5

Collapse Tree
Collapses the folders in the Tree navigator. If the user has expanded any hierarchies in Tree tab, this action will
collapse all the folders at once.

Disable calculated values
Disables the calculation of calculated attributes. This will make the STEP interface load faster. For more
information on calculated attributes see, theCalculated Attributes topic in theSystem Setup / Super User
Guide documentation.

Note: IfDisable calculated attributes is checked, calculated attributes can be rendered one by one by clicking
theCalculate button on the Product editor

Default Font Size
Allows the user to changeGUI font. The user must log out and log in again to see changes in font size.

Choose User Display Sequence Attribute
Allows the user to select a user specific 'Display Sequence Attribute' that is different from the one which is set in
theSystem Setup Tab under theUsers & Groups options.

When selecting the 'Choose User Display Sequence Attribute,' the follow dialog will display:

The global Display Sequence Attribute is set inSystem Setup > Users & Groups, under 'Product Information
Manager Default Settings' flipper.
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Toggle Show Hidden Background Process Template
The user can toggle the show hidden background process template to true or false.

If 'Toggle Show Hidden Background Process Template' is set to be True, then the entire hidden background
process template will be displayed to the user. If it is set to False, then hidden background processwon’t be
displayed to the user.

Note: To display, its affect the toggle function systemmight take some time.

In the below example, if the show hidden background process is set to be True, you will notice the Integration
Endpoints display, but when set to False, they are removed from the list.
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Default Context
Sets the default context used when logging in.

Logs
DisplaysWorkspace logs and SystemSetup logs.

Note: To get the log, a user must have setup action 'View SystemSetup Logs.'

For Approved andMain workspaces, this option is grayed out.

For user created workspace, a log is obtained from view menu aswell as by right clicking on user created
workspace.
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A system setup log contains all changes related to system setup objects. This includesmodifying system setup
objects values and options, deleting system setup objects, adding dimension dependency, etc., along with date
and time stampwith user information.
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Navigate Menu

Search
Displays the Search tab, which allows the user to search for types of objects within the system including the ability
to search within a selected hierarchy, via attribute values, and via custom queries.

For more information on searching, see theSearch Overview topic in theGetting Started documentation.

Keyboard Shortcut:Ctrl+F

Search Below
After selecting an object in workbench, this option allows the user to 'Search Below' the selected hierarchy.

Goto
A quick way to jump to a particular object in the database based on the name, ID, or Unique Key value. A
dropdown displaysmultiple hits and allows the user to select the desired object.

Keyboard Shortcut:Ctrl+G

Note: In case of multiple hits while searching in 'Goto' for an object, it will look through the Primary Hierarchy set
from the View Menu and based on the selection of the super object type, the 'Goto' option will jump to the first one.

Goto Next
When there aremultiple 'Goto' results (or typeahead results) from the 'Goto' function, the user can opt to select
'Goto Next' to continue on to the next hit / result.

Keyboard Shortcut:Ctrl+E

Back / Forward
Jumps the user backwards or forwards to previously selected objects. Works the same as the Back / Forward
button in a web browser.
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Note: 'Forward' will only work if the user performed the 'Back' option first.

Bookmarks

Allows the setting of bookmarks specific to individual users – just as in a web browser. For example, a user can
'bookmark' a specific search query.

There are 2 types of Bookmarks – Standard Navigation Bookmark and Search Bookmark

Bookmarks that are added can be accessed in 'Bookmarks' tab.

For more information on bookmarks, see theBookmarks topic in theGetting Started documentation.

Find Similar Product
Populates a search based on the attributes and its values of the selected product.

When this option is selected, a window will appear prompting the user to check off common attributes to search
for.

Note: The 'Please Select Attributes' dialog shows only the attributeswhich have values (inherited – context
inherited and hierarchical inherited values, local values, and calculated values).
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When the attributes are checked off and then the 'Select' button is clicked, the user will be redirected to Search
Tab, which is populated with the Object type and selected attributes and its values.

After selecting 'Search,' the selected product and products whichmatch the search criteria will be displayed.

Note: This search is recommended for attribute validation base type of 'Text,' 'LOV,' 'ExternallyMaintained,'
'Numeric.' It is not recommended for attribute validation base types like 'Number,' 'URL,' 'Date,' 'Condition,'
'Multivalued Text,' 'Multivalued LOV,' etc. When attribute values such as calculated attribute values or inherited
attribute values are selected, the search result will not be displayed even though the attributes are of validation
base type 'LOV,' 'Text,' or 'Numeric.'

Format Menu
The Format Menu contains the different options that can be applied on a product’s attribute value selected strings:
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Style
Users can apply style formatting defined in SystemSetup to selected strings of text such as bold, italic, or custom
style tags.

By default, Bold (Ctrl+B) and Italic (Ctrl+I) will be displayed with standard keyboard shortcuts displayed on top of
option Style.

For more information on style tags, see the Tags topic in theSystem Setup / Super User Guide documentation.

Clear All Styles
Removes all styling that is applied to a selected string of text such as bold and italic.

Character Tag
Inserts custom tags e.g. <BigStar/> into a text string.

When a user clicks on the 'Other' option, the 'Insert Character Tag' dialog displayswhich lists all the Character
Tags defined in SystemSetup.

Keyboard Shortcut:Ctrl+R

For more information on style tags, see the Tags topic in theSystem Setup / Super User Guide documentation.
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Insert Special Character
This is an embedded character map. It shows themost recently used characters and offers a complete Unicode
character range after the user selects the 'Other' option.

Note: All the above Format menu option will be unavailable unless adding or modifying an attribute value.

Keyboard Shortcut:Ctrl+Shift+E

For more information, see the Special Character section of the Tags topic in theSystem Setup / Super User
Guide documentation.

Maintain Menu
Maintain menu provides the user to maintain the STEP workbench data like Insert, Link, Merge, Deletions,
Approvals and others. Each option in turn hasmany sub options and are explained in the below sections:
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Insert
Insert an object based on either the currently selected tree or elsewhere.
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The following options are available in the Insert sub-menu:
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l Product (Ctrl+Shift+P) – If the user is within the primary product hierarchy, this option will create a new
product beneath the selected hierarchy.

l Classification (Ctrl+Shift+C) – If the user selected a classification hierarchy, this option allows to create a
new classification folder beneath the selected classification with the predefined classification object types.

l Classification Root (Ctrl+Shift+R) – If the user would like to have a classification root to store images or
configurations or to link products in the classifications folder, this option creates a Classification Root with a set
of predefined classification root object types that are listed.

l New Entity Node – If the user selected an Entity root, this option will create a new entity object based on one
of the predefined entity types.

l Entity Root – A new 'Entity Root' can be created in the tree hierarchy from predefined set of entity root object
types.

l New Publication... – Allows the user to create a new Publication. If the user has already selected a
Publication Hierarchy, then when this option is chosen, 'Create Publication' dialog will displayed with default
object type selected. The user must provide a name of the Publication and 'Page Template,' 'Product
Template,' and 'Publication Template' to create a new publication.

Note: The 'Create' button in the ‘Create Publication’ dialog will be enabled only if the user has selected a
Publication Template.

l New Publication Group – Allows the user to create a New Publication Group within the selected Publication
Group. If a Publication Group is selected, once this option is chosen, ‘Create Publication Group’ dialog will
display with the predefined set of object type.

l New Publication Section... – The user will get a wizard to create 'New Publication Section.' When selecting
this option, the 'New Section' dialog will display. Now, youmust fill in the Section Name and select the Page
Template from the dropdown list.

l New Page Template... – Allows the user to create a new Page Template. After selecting a 'Publication
Group,' this option will display a wizard Create New Page Template in STEP.

l Orphan Attribute (Ctrl+Shift+O) – This allows user to add an attribute as anOrphan Attribute to a product
by searching or browsing fromSystemSetup tab. For information on them, see theOrphan Attributes topic
in theAttributes documentation.

l Asset (Ctrl+Shift+A) – Allows the user to create placeholder with ID and Name for a new Asset on the
selected classification folder. The user may choose an asset object type from the Create Asset dialog. After,
asset content can be added.

l Attribute (Ctrl+Shift+T) – Allows the user to create a new Attribute in the selected Attribute Group in System
Setup Tab.

l Attribute Group (Ctrl+Shift+I) – Allows the user to create a new Attribute Group in the SystemSetup tab.

l List of Values (Ctrl+Shift+L) – Allows a user to create new List of Value under Lists of ValuesGroup / LOVs
in system setup. User will be allowed to key in ID and Name in the Create LOV pop up window.
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l Dimension (Ctrl+Shift+D) – This option will create a new dimension. A user must select the 'Contexts' node
in the SystemSetup tab for this option to be available. For more information on dimensions, see the
Dimensions and Dimension Points topic in theSystem Setup / Super User Guide documentation.

l Dimension Point (Ctrl+Shift+M) – Allows the user to create new Dimension Point. A user has to select a
Dimension under SystemSetup > Contexts > Dimension (for example 'Language'). The label of this option
changes dynamically based on the selection of dimension.Wewill not see the option ‘Dimension Point’ at any
point of time. For example, if the user has chosen 'Language' as Dimension, this option will be labeled as “New
Language”.

l Workspace (Ctrl+Shift+W) – The user can create ownworkspace from this option in system setup. User
should stand on an existing workspace to create a new workspace using this option. For more information on
workspaces, see theWorkspace topic of theSystem Setup / Super User Guide documentation.

l Action Set (Ctrl+Shift+S) – This option creates a new Setup or User Action. A 'Create Action Set' dialog
displayswith ID and Name to be filled when user selects the option Action Set. Whether you can create a
Setup or User Action is based on which node is selected in System setup. For more information on action sets,
see theMaintaining Actions topic in theSystem Setup / Super User Guide documentation.

l New Image Conversion Configuration… - A wizard will display to create new image conversion
configuration and saved for reuse in the selected classification folder. For more information on image
conversions, see the Image Conversion Configurations topic in theDigital Asset Exchange
documentation.

l Create Transformation Lookup Table – Allows the user to create a Transformation Lookup Table under the
selected classification. For more information, see the Transformation Lookup Tables topic in theSystem
Setup / Super User Guide.

l New Event Queue – The user can create a new event queue in system setup tab.

l New Asset Push Event Queue - The user can create New Asset Push Event Queue in system setup and it
will create New Event Queue and the event queue can have any number of asset push configurations running
from it.

For more on assets push events, see theCreating and Maintaining Asset Push Event Queues topic in the
Digital Asset Exchange documentation.

l New Asset Push Configurations – New Asset Push configuration will be created under the selected Asset
Push Event Queue.

For more on assets push events, see theCreating and Maintaining Asset Push Configurations topic in
theDigital Asset Exchange documentation.

l STEP Workflow (Ctrl+Shift+R) – This will create a new workflow under SystemSetup > Workflows

When the user selects 'Workflows' in 'SystemSetup' tab, then selects this option, the STEPWorkflow designer
window will display. It is also possible to create workflow by right clicking on that 'Workflows' folder.

For more information on workflows, see theWorkflows documentation.
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l Background Process to Monitor Deadlines (Ctrl+Shift+D) –When selecting the SystemSetup >
Workflowsnode, this option, either by theMaintain > Insert Menu, the keyboard shortcut, or by right click,
starts a background process for checking STEPWorkflow items that have exceeded their deadlines.

l User - Users are created under by selecting SystemSetup > Users & Groups > Groupwhere the user will
belong under. When a user selects a Group and select this option, the 'Enter New User' dialog displays.

For more information on users in STEP, see theWorking withUsers topic in theSystem Setup / Super User
Guide documentation.

l Group - Groups are created under by selecting SystemSetup > Users & Groups. Add the new group either
with the keyboard shortcut, inserting from theMaintain menu, or by right clicking.

Keyboard Shortcut:Ctrl+Shift+G

For more information on groups in STEP, see theWorking with User Groups topic in theSystem Setup /
Super User Guide documentation.

l New Supplier – Supplier users are created in SystemSetup > Supplier Group.

New Supplier can be created by selecting the Supplier Group.

l Create Package - Creates a Package in SystemSetup > Change Package.

After the user has selected the Change Package option, a 'Create Change Package' dialog displays. Enter an
ID and Name of the Package.

For more information on packages, see theChange Packages topic in theConfigurations Management
documentation.

l New Business Condition – Creates new a BusinessCondition under Global BusinessRules in System
Setup. BusinessConditions can be created under Workflows in SystemSetup.

For more information on business conditions, see theBusiness Conditions topic in theBusiness Rules
documentation

l New Business Action - Creates new Business Action in SystemSetup under Global BusinessRules.
Business Action can be created under Workflows in SystemSetup.

For more information on business conditions, see theBusiness Actions topic in theBusiness Rules
documentation

l New Business Library - Creates new Business Library in SystemSetup under Global BusinessRules.
Business Library can be created under Workflows in SystemSetup.

For more information on business conditions, see theBusiness Libraries topic in theBusiness Rules
documentation
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l Setup Group Root... – Creates a new setup group root under SystemSetup.

When the user selects this option, the 'Create SetupGroup Root' dialog displayswith set of object types. The
user may create a new setup group root based on the object the object type selected.

It is also possible to create objects products, classifications, entities, publications, and assets when right-clicking in
STEP. For more information on object creation, seeCreating Objects in Tree topic of theGetting Started
documentation.

Link
Allows users to link attributes to products, assets, products to classifications, etc.

Based on the source object there are different link options available with keyboard shortcuts shown in above
screenshot.

1. When a user selects a product hierarchy and clicks on Link > Product, product is linked to the selected product
via a list of product reference type dropdown.

2. When a user selects a product hierarchy and clicks on Link > Asset, asset is linked to the selected product via a
list asset reference type dropdown.

3. When a user selects an attribute, it can be linked to classifications.

4. When a user selects a classification, products can be linked to it.

5. When a user selects an attribute, it can be linked to products.

For more information on linking your attributes to products, see theCreating a Product Attribute Link topic in
theSystem Setup / Super User Guide documentation.

Merge
Depending on the selected object, the user canmerge attributes, LOVs, and LOV values. See theMerging
Attribute Values topic in the SystemSetup / Super User Guide documentation.

Delete
Standard 'delete' function. Warns the user if the selected folder contains subfolders. All deleted objects aremoved
to the Recycle Bin (where they can be revived or totally removed from the system).

Note: Keyboard 'Delete' button won’t delete in STEP workbench.
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Force Delete and Purge
If an object is selected in the workbench, and Force Delete and Purge is clicked, the object will be deleted and
purged from recycle bin. After selection, the user will be warned andmust confirmwith 'Force Delete and Purge.'

Unlink Object Type
A SystemSetup option in Object Types and Structures. Allows a superuser to unlink a selected object type from its
parent.

Duplicate
Standard 'duplicate' operation. Essentially a copy and paste in one click. Usersmay also right click for few selected
item and duplicate these selects. A prompt will request a new ID when an auto ID is not set, then automatically
provides a different Name. The user is also allowed to tick for duplicate references.

Duplicate Recursively
If a hierarchy needs to be duplicated, the user can select the top node in the hierarchy and click 'Duplicate
Recursively,' and then, a background processwill start. The hierarchywill be duplicated.

In the below example, the ID is auto generated so the duplicate recursively background processwill gives an error,
the ID should be editable for duplicate recursively.
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Make Revision
Allows a user to force a revision on a product and provides a comment for explanation.

Approval

Approve Object
Approves an object from theMain workspace to the Approved workspace and changes the red X ( ) to either a
green checkmark ( ) or a yellow one ( ).

See theApproval of Objects section of theSTEP User Guide / Getting Started documentation for more
information.

Partial Approval
Approve selected parts of the unapproved changes on selected object.

Check Approve
Generates report that showswhat would happen if the object is approved.

Approve Deletion
Once an object is approved, to be removed from the Recycle Bin, an object must be Approve Deleted. If a
previously approved object is deleted, in the Recycle Bin it will have an '(In Use)' header:

Once a user perform an Approve Deletion, it is titled 'Not in Use' andmay be deleted.

Approve Recursively
Launches a background process that will approve the currently selected object and all of its children.
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Transfer Object To
Takes selected object andmoves it into the chosen workspace.

Update Object From
Updates the object across all workspaces, including references and values for classifications, products and
images & documents.

Update Workspace From
Updates the current workspace from another workspace. It is possible to update the entire workspace or only a
part of the workspace. Objects that do not exist in the current workspace will be transferred to the current
workspace.

Update Object
Updating objects acrossworkspaces. Thismeans that if an object exists in different workspaces, values and
references can be updated across these workspaces.

Revive
Once the user selects an object from recycle bin, this option will place the object back to original position from
where it was deleted.

Revive Recursively
This option gives a window for the user to confirm.When the user has deleted an object hierarchy, this option will
place the deleted object hierarchy back to the original position.

Window Menu
Window menu in STEP has options to apply on STEP workbench window and are explained below:

New PIM Window
Allows the user to launch another session.

Keyboard Shortcut:CTRL + N

Goto Dashboard
Brings the user to the dashboard.
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Zoom Window
Maximizes the selected window.

Help Menu

Help
Brings the user to the online help documentation, and it opens up in a browser.

Keyboard Shortcut: F1.

About STEP
Displays the workbench introductory window.
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Object Editor
When an object is selected from the left panel in STEP (e.g.Tree tab, SystemSetup tab, etc), the right panel
displays details for the selected object in the first tab. The kind and number of tabswill vary depending on the
selected object. However, all objects will have an ID, Name, Object Type, Revision, Approved, Translation, Path,
etc. These fields are called Aspects.

See theObject Maintenance in Tree topic within this guide and child topics for additional information on the
various object editors available in Tree.

Information on editing non-Tree objects can be found within the relevant sections throughout the STEP
documentation (e.g. information on workflow editors is available within the workflows guide).

For the product objects in STEP, users can create attributes (description attributes) along with Aspects in the first
flipper called 'Description.' For more information about Description Attributes, see the Description Attributes topic
in the SystemSetup documentation.
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Search Tab
The Search tab allows users to perform simple searches by typing directly into the default search field.

Users can also performmore complex searches by selecting and/or combining additional search criteria.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 112



Below SearchOperations can be performed on the entire search result.

For more information about SearchOperation, seeSearch Operations topic in theNavigation and Searches
documentation.

For more on Searching, see theSearch Overview section of theGetting Started documentation.
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STEP Workflow Tab
STEPWorkflow is STEP's native functionality for structuring and to some extent automating processes around
objects in STEP. Typical examples are Product onboarding processes and change / governance processes.

The concept of STEPWorkflows differs from the general concept of a workflow, in that STEPWorkflows are data-
centric, meaning that each instance of a givenWorkflow alwayswill be tied to an object in STEP. As illustrated
below, technically, aWorkflow Instance is simply a relation between a STEP object and aWorkflow definition that
also exists as an object in STEP.

The STEPWorkflow tab has 2 sub tabs (Tasks and Profile).

Tasks
The Tasks sub tab is the primary interface for working with workflows in STEPWorkbench.

1. Each workflow has a flipper that can be opened to display details about the workflow.
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2. Administrators can configure which states are displayed for each workflow. The number of tasks for the state
are displayed.

3. The Refresh button updates the data displayed for number of tasks in the workflow.

4. Clicking theShow All Items button displays all tasks in all displayed states, regardless of the assignee. Only
users with the STEPWorkflow Administrator privilege have access to this button.

5. Clicking theShow All Items assigned to me or any group I am a member of button displays tasks directly
assigned to the user or any group that the user is amember of.
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6. Clicking theShow All Items assigned to me button displays only tasks that are directly assigned to the user.

7. Clicking the ... (ellipsis) button allows users to filter the list of displayed tasks based on a Collection. For
example, if a user wanted only to see objects in the workflow where the Color Attribute = Blue, they can first
perform an Attribute search on the Search tab, then save the result as a collection, and use that collection to
filter the objects to display only those where Color is Blue.
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Profile

1. Click a Profile link to see details of the configuration.

2. TheEdit Configuration button allows you tomodify the data being profiled.
3. TheUpdate on-demand data button runs the profile and updates the data displayed.
4. TheCopy to Clipboard button saves the data displayed to your computer's clipboard
5. Once saved to the Clipboard, this data can be pasted into Excel for further analysis.

For information on how to configure workflows, see the Creating aWorkflow topic in theWorkflows
documentation.
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System Setup Tab
Schema objects aremaintained from the SystemSetup tab. Examples of such objects are Attributes, Action Sets,
Contexts, LOVs, Object Types, Tags, Units, Users & Groups,Workspaces, Reference Types, andmanymore.
Most actions performed require Super User access. This is where the core components like integration endpoint,
STEPWorkflow,WebUI, business rules, etc. are created and configured.

Additional information on the SystemSetup objects and functions can be found throughout the online help. For
example, information on workflows is available in theWorkflows guide, while information on integration endpoints
is available within theData Exchange guide. Information for general functions that are not covered in
independent guides (e.g. attributes, references, users and groups) can be found in theSystem Setup / Super
User Guide.
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Toolbar
The features accessible on the STEP toolbar, (located beneath themenu bar), are geared towards navigating
between objects and viewing object data in different ways.

The various features available on the STEP toolbar are described below.

Stibo Systems Logo

Clicking the Stibo Systems logo allows the user to toggle between the STEP dashboard and the STEP
Workbench. For more information regarding the dashboard see theGlobal Dashboard section of theData
Profiling documentation.

Context List

'Context' acts as a filter that allows a user to view object data defined by, for example, country or language.

To select the context, the user clicks the dropdown and then selects the desired context from those listed.When
working in STEP it is useful to check that the context is properly set because viewing data in the wrong context is
likely to cause significant confusion. For more information regarding contexts, see theContexts topic in the
System Setup / Super User Guide documentation.

Workspace Toggle Button

Located to the right of 'Context', theWorkspace Toggle button, , switches the user's view of a given object
between the 'Main' and 'Approved' workspaces. In the 'Main' workspace, object information is editable. In the
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'Approved' workspace, the user will see only those values that have been approved, andmay not edit them. For
more information on workspaces, see theWorkspaces topic in theSystem Setup / Super User Guide
documentation.

Navigation Buttons

To navigate backward or forward to a previously viewed screen or to refresh the current screen's data, the user
can click the 'Back', 'Forward', or 'Reload' buttons, respectively. These buttons are located between the
'Workspace Toggle' button and the URL field. When clicked, these buttons behave in a way similar to most web
browsers' 'Back', 'Forward', and 'Reload' functions.

Address Field

Tomaximize navigability of the STEP tool, all objectsmay be accessed via an in-tool URL. Aswith the URL bar in
a standard web browser, a product may be reached within STEP by pasting its unique URL into the URL bar. It is
important to note that the STEP URL always beginswith "step://", unlike web URLswhich begin with "http://" or
"https://".

Viewing Mode Buttons

STEP enables the user to view STEP data in a variety of ways, dependent on the need.When clicked, each of the
five 'View' icons that appear to the right of the URL field in the toolbar present STEP data in different ways. Below
are the five view modes described:

Normal mode

This is the default view of the STEPWorkbench.With this view selected, users will see a listing of all relevant
attribute andmetadata associated with that object.

Translation mode

With thismode selected, users can view all object-related data in up to two languages. The data is presented in a
comparison display format. STEP automatically highlights in green those attributes that require translation. More
information of translations is available in the Translation documentation.
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Workspace mode

With the 'Workspace' view active, users can see object data as it appears in both the 'Main' and 'Approved
workspaces. This comparison view can be useful by allowing a user to view, at a glance, which values have
changed since the object was last approved. However, if the object is in 'Never been approved' status, only the
'Main' workspace will show when this view is active. For more information on workspaces, see theWorkspaces
topic in theSystem Setup / Super User Guide documentation.

Context mode

With this view enabled users can view all of an object's data for two or more available contexts in a comparison
display format. The number of contexts viewable at one time is configurable. For more information regarding
contexts see theContexts topic in theSystem Setup / Super User Guide documentation.

Revision mode

With thismode selected, users can view the current state of an object's data aswell as all previous revisions in a
comparison display format. The number of revisions viewable at one time is configurable, but the current and
previous versions are shown as the default. For more information on revisions, see theManaging Revisions in
STEP topic in theSystem Setup / Super User Guide documentation.

Goto Field

This field enables searching for specific objects. To quickly locate objects in the hierarchy by their ID, name, or key,
that data can be added into the 'Goto field' and searched on.When the desired item appears in this field, the user
can click on it, taking them directly to the object. For more information regarding theGoto field, see theUsing
Goto documentation in theGetting Started /User Guide. For more information on Keys, see theUnique Keys
documentation in theSystem Setup / Super User Guide.
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Tree Tab
This section contains information about how to create and remove local overrides and information about table
dimension points.

The above hierarchies and their child objects can be navigated, edited, created, and deleted from the Tree.

The following table is an overview of the different elements of the Tree tab.

Object Description

Products It is used to store actual product information. Alternative name is 'Blue folder'

Classifications It is used to store assets (Images and documents), configurations, and link products.
Alternative name is 'Yellow folders' or 'Secondary classification.'

IndexWords An Index structure needs to be created in STEP, in the sameway as a ‘Classification
Hierarchy,’ and products are linked into this structure.

Entities It is used to store the party, supplier data, or contact information. Alternative name is 'White
folders.'

Publications It is used to store print (Example: InDesign) documents and print related configuration like
templates, versions, commercial data, and dtp documents. Alternative name is 'Green
folders.'
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Object Description

Collections Collections are containers for storing different sets of objects to perform bulk update or export
data.

eCatalogs It is used to create electronic product catalogs. An electronic product catalog is a data file
containing product and price information for a specific product selection. Alternative name is
STEP sync.

Recycle Bin Deleted objects (products, assets, classifications, configurations and entities) aremoved to
recycle bin from the Tree tab.

It is used to create electronic product catalogs. An electronic product catalog is a data file containing product and
price information for a specific product selection. Alternative name is STEP sync.

For further information about objects in the Tree and how to work with them, see theBasic STEP Concepts and
Object Maintenance in Tree topics within this guide.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 123



Object Maintenance in Tree
Regardless of the particular object type or hierarchy that you are working with, the general principles of
maintaining objects in the workbench are the same, and are described in theAll Objects section of this guide.
This includes general information on creating, editing, approving, and deleting objects.

Note: TheAll Objects information should be read and understood prior to focusing on any of the object type
specific information (links below), as the basic information that is common to all object types is not repeated in the
type-specific sections.

Beyond the general object maintenance topics, additional information on working with specific object types in
Tree, including details about the various editors and functionalities available on them can be found in the
subsequent topics in this guide:

l Assets

l Classifications

l Collections

l Entities

l Products

l Publications

l Recycle Bin for Tree

Note: All actions in STEP are controlled via privileges. Some usersmay not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The information in
this guide focuses strictly on themeans for carrying out the various actions, and assumes that all required
privileges are available to do so. More information on privileges is available in thePrivilege Rules topic in the
System Setup / Super User documentation.

A variety of components are also available for maintaining objects inWebUI. For more information, see theWeb
User Interfaces documentation. Additionally, objects are often created or maintained within workflows, or via
imports, integration endpoints, bulk updates, etc. These types of object maintenance are outside the scope of this
material, but additional information is available in the relevant guides throughout the STEP online help.
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All Objects
This section covers the basic functionality of creating, editing, and deleting objects in the Tree, aswell as providing
an overview of the commonalities between the various object editors. Regardless of the particular object type or
hierarchy that you are working with, the general principles of creating andmaintaining objects are the same.

It is helpful if theBasic STEP Concepts topic in this guide has been read and understood prior to reading this
material.

A variety of components are available for creating andmaintaining objects inWebUI. For more information, see
theWeb User Interfaces documentation. Additionally, objects are often created or maintained within workflows,
or via imports, integration endpoints, bulk updates, etc. These types of object maintenance are outside the scope
of thismaterial, but additional information is available in the relevant guides throughout the STEP online help.

Note: All actions in STEP are controlled via privileges. Some usersmay not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values.

The information below focuses strictly on themeans for carrying out the various actions, and assumes that all
required privileges are available to do so. More information on privileges is available in thePrivilege Rules topic
in theSystem Setup / Super User documentation.

See the relevant section(s) below for detailed information on working with objects in the workbench:

l Approval of Objects

l Creating Objects in Tree

l Deleting Objects in Tree

l Editing Objects in Tree
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Approval of Objects
This section introduces the user to the concept of approvals in STEP, and provides detailed information on how to
carry out approvals in the STEPWorkbench. Approval of objects in theWebUI is handled via addition of an
Approve action button to a screen.

Approval Overview
The data in STEP is logically divided into two workspaces namedMain and Approved.

TheMainWorkspace is the editable "draft"Workspace where data is initially born and enriched. The Approved
workspace, on the other hand, holds approved data deemed ready for production.

In a typical STEP setup, data from the Approved workspace ismade available to downstream systems. Data
cannot be edited directly in the Approved workspace. Instead, data is reflected in the workspace via an operation
called approval.

Approvals can be carried out manually by a user, or programmatically by a business rule, import process, or other
operation.

The approval operation only applies to objects that are workspace revisable. These are:

l Product objects

l Classification objects

l Asset objects

l Entity objects configured to be workspace revisable

All other objects in STEP (like attributes, references, etc.) will be identical in theMain and ApprovedWorkspaces
and changesmade to these will be reflected automatically in both workspaces. These objects are known as being
'Globally revisable'.
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Detailed information on how to carry out approvals in the STEPWorkbench can be found in theApproving an
Object topic in this guide. This guide also contains a detailed description of the approval symbols that are visible in
the different object editors in theApproval Symbols topic.

Note: All actions in STEP are controlled via privileges. Some usersmay not have access to approve objects, or
may only have options to approve specific object types, hierarchies, or attribute values. The information in the
subsequent topics assumes that all required privileges are available to carry out the described actions. More
information on privileges is available in thePrivilege Rules topic in theSystem Setup / Super User
documentation.
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Approving an Object
This topic describes how to approve an object in the workbench.When an object is approved, it moves to the
Approvedworkspace.

An Explanation of Data Ownership
The concept of data ownership is very important in relation to approvals. Thus, for an object to be fully approved,
all data that the object ownsmust be approved. Also, when data changes, it is the object that owns it that is
modified and potentially becomes 'unapproved.'

The figure below shows data owned by a Product object (the largest box).

Note:

l A Product owns its parent link (also true for Classifications, Entities and Assets)

l The Product owns local values, but not inherited Specification Attribute values. Thus, when these aremodified
at an ancestor level, this will not affect the Product’s approval status. Also, the valueswill be approved with the
object for which they are local.

l The Product owns all local References and Links for which it is the Source.When a Link or Reference is
modified, it is the Source that is changed while the Target is unaffected. Attribute values on the Reference /
Link are likewise owned by the Source object.
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How to approve an object:
Approving objects is done by right-clicking on the object and selecting one of the available approval options, or
from theMaintain menu.

Note: If 'approval' is a Taskwithin aWorkflow, thenObjects can alternately be approved from the Task view. See
Working with Tasks in Workflows in theWorkflows documentation.

ApproveObjects is available when theMainworkspace is selected.

Approving objects is available for:

l Classifications

l Products

l Images & Documents

l Entities (setup to beWorkspace revisable)
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The status of an object in the variousworkspaces can be viewed in the Status tab in theWorkspaces field of the
relevant editor.

Once object editing is complete, and the object is ready for publishing, approving the object copies the current
object values into the Approved workspace.

Conditions to approve an object:
l Objectsmust be approved from theMainworkspace.
l An object cannot be approved if parent objects are not yet approved (approvingmust be done from the top
and downwards in the hierarchy).

l A Reference or Link cannot be approved if the Target does not exist in the ApprovedWorkspace. i.e., If a
Product / Classification is referenced with another Product / Asset / Classification, then the referenced
Product / Asset / Classification needs to be approved first before the actual Product / Classification is
approved.

l If Attributes or References / Links areMandatory, objects cannot be approved if there are no values / targets.

l ExternallyMaintained Attributes or References / Links are not under revision control. Values / referenceswill
automatically be reflected in the ApprovedWorkspace andmodifying the data will not affect object’s
approval status.

l The user must have sufficient Approve privileges.

l To easily check differences in theMain and ApprovedWorkspaces, selectPartial Approve, as discussed
below.

l When approving, the objects revision number changes automatically.

l An entire hierarchy can be approved using theApprove Recursively option. For more information, see
Approving Recursively below.

l The user must have sufficient approve privileges.
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Partial Approve
It is possible to approve an object that has a Reference / Link to another object that does not exist in the Approved
Workspace.What will happen is that the object will become “partially approved” meaning that the object and all
data that can be approved will be approved. The Reference /Link will however not be approved, and if the Target
for the Reference / Link is later approved, the Source needs to be approved again for the Reference Link to be
reflected in the ApprovedWorkspace.

Partial approvals can also be performed deliberately - bothmanually and programmatically. Specific Attributes,
References, Links, and the object Name can be selected for approval. The Attributes, References, Links and
Names are sometimes referred to as “part objects”. These part objects can of course not exist in the Approved
Workspace without the object to which they belong. Thus, when the first part object is approved, the object will be
present in the ApprovedWorkspace.

Usage:
Partial approval of selected elements of the object is particularly helpful in situationswhere certain elements of the
object need to be available for usage (in the Approved workspace) before the rest of the object or its elements can
be approved.

Example:
Consider that there are totally 2 users who perform changes for a product and then approve the product. Now if
the product is completely approved, then it becomes tough to identify which user performedwhat changes. In this
case, using the Partial Approve will allow the user to approve the changes performed only by him/her and leave
the rest of the changes to be approved the other user who did the changes.
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How to approve partially:
1. In Tree, select the object you wish to partially approve.

2. In theMaintain menu, click Approval > Partial Approve. Optionally, right-click the selected object and click
Partial Approve.

3. This will bring up the Partial Approve dialog box:

4. The user has to select the required element / elements , example: attributes and click on ‘Approve Selected’
button.

Details of the Partial Approve Dialog
The dialog showswhich elements of the selected object have been changed since the last approval of the object.

BesidesName, Parent Object, and Default DTP Template, the type of elements listed are attributes, references,
and tables. For each element the values inMain andApprovedWorkspaces are listed.

For detailed information about the value for an element, click theDetails…link. This displays a detailed view of the
element showing the values for theMain andApprovedworkspace:
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In the above example, the value for the attribute Brand Name has changed. Values only present in Main
workspace aremarked with a green background color. Values only present in Approve workspace aremarked
with a red background color.

Note: The detailed view differs slightly depending on the element type selected.

All elements are selected as default. To deselect all elements, click the checkbox next to the All Elements node.

You can select the element(s) you wish to approve by clicking the check boxes next to each element. You can also
select a whole element group, i.e.,Attributes by clicking the checkbox next to the element group.

To expand an element group click the + sign next to the element group. To collapse the element group, click the -
sign next to the element group. To expand all elements in the dialog, click theExpand All button. To collapse all
elements in the dialog, click theCollapse All button. To check if the selected elements can be successfully
approved, click the Check button. An Approve report will subsequently summarize the result of the check.

Clicking theApprove Selected button will approve the selected elements of the object and theApprove status of
the object will change accordingly. NormalPrivilege rules apply toPartial Approve. For more information, see
Action Sets.

Suppress Re-translation
Normally, an approval of a translated Product in a source language will cause the Translation status of the
Product to be set toRe-translation needed. In the Partial Approval dialog this behavior can be suppressed by
clicking theSuppress Re-translation checkbox. All existing translation relationswith status 'Up to Date' will
remain in status 'Up to Date'. This is especially used in caseswhere onlyminor changes are approved and no re-
translation is needed. For more information, see the Translations documentation.

Note: To get a list of language variations of the object that potentially will be affected by the approval, place the
cursor on theSuppress Re-translation label.

Check Approve
If you are not sure whether or not you are allowed to completely approve anObject, you can run aCheck
Approve.

1. In [Tree], click the Object to be approved.

The Editor shows theObject contents inMain andApprovedWorkspaces.

2. In theMaintain menu, clickApproval > Check Approve, or right-click on the object, and then selectCheck
Approve option.

l If you only have changed attribute values for which you have the Approve privileges, aComplete
Approval Possible dialog box appears.
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l If the product cannot be approved due tomultiple reasons such asMandatory values / References
being empty, then the report will provide details about themissing information as shown below:

Note: If you have changed attribute values for which you do not have the Approve privileges the Approval options
are unavailable.

For example, consider a Product that hasmultiple attributes linked and hasmandatory values and references
which needs to be approved after the changes have been done. In this case, scrolling down or switching between
tabs to check if the values are entered is time consuming. In this case, Check Approve will help the user to know if
the product can be approved completely with detailed report.

Approving Recursively
Approving Recursively is done from theMainmenu by clickingApprove Recursively. Similarly, the Approve
Recursively can be done by right clicking on the Product aswell.

Approving Recursively is available when aMainWorkspace is selected.

Approving Recursively is available for:

l Classifications

l Products

l Images & Documents

l Entities (setup to be workspace revisable)

The status of anObject in the variousWorkspaces can be viewed in theHistory tab in theWorkspaces field of the
relevant Editor.

Approving Objects recursivelymeans searching for unapprovedObjects linked to (or below) a selected hierarchy
node, and approving theseObjects (copying them to theApprovedWorkspace).
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This is useful and time saving e.g., when a lot of images have been imported and checked and should all be
approved.

To recursively approve in the 'Main' Workspace:

1. In [Tree], select the hierarchy containing theObjects to be approved.

2. In theMaintainmenu, clickApproval > Approve Recursively.

A dialog box appears, listing the Name of the selected hierarchy node, containedObjects and status of
analysis.

Note: Approve Recursively automatically performs a search for unapprovedObjects. You can click theSkip
Analysis button if this is not needed.

3. Optionally, type a name for the process.

4. ClickOK button to start the approve process.

A dialog box appears displaying information on the process.

5. ClickGo to process button.

The Process view will open showing details of the process and a report of approvedObjects.

The hierarchywill now have Approved status indicating that it is copied in theApprovedWorkspace.

Approval Feedback
Depending on yourApprove Privileges, youmight get different types of warnings, when clickingApprove
Objector Partial Approve.
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Approve Object Feedback
If you havemodified attribute values for which you haveApprove Privileges, and at the same time you have
modified attribute values for which you do not haveApprove Privileges, anUnable to approve entire object
dialog appears.

If you havemodified attributes values, and you do not haveApprove Privileges, then the option 'Approve' is
grayed out in the right-clickmenu. If you havemodified attributes values, for which you do not haveApprove
Privileges, aMissing privileges dialog appears.

For more information about user privileges, see theUser Actions topic in theSystem Setup documentation.

Partial Approve Feedback
If you havemodified attribute values for which you haveApprove Privileges, and at the same time you have
modified attribute values for which you do not haveApprove Privileges, aPartial Approve dialog box appears.
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In the example above, the user will be able to approve all attribute values in Attribute GroupManual Sequence
and Category Specific Attributes. All attributes users do not have permissions for will not be displayed.

Approve Recursively Feedback

1. In [Background Processes], clickApprove Recursively, unfoldActive or Ended Processes, click the
relevant process.

2. In theBackground Process tab, unfoldExecution Report.

If there are any errors, the report will provide details about the error. If the process or approval was successful,
then the report will show 0 error and 0 warning.

The following example shows amissingmandatory attribute value, which caused the object to not approve.
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Approve Recursively Dialog

There aremultiple optionswhich are explained below:

l Finding UnapprovedObjects: This will analyze the hierarchy and then provide the count of the number of
Products / Classifications / Assets / Entities which are currently in unapproved status.

l EmptyMandatory Links / values inMainWorkspace: This provides the details about the number of
mandatory links / references that aremissing for the Products/Classifications / Assets / Entities.

l Start Processwith Description: This option is used to enter the name for the Process before starting the
background process. However, this option is optional but is advised to enter a name so that it can be later
identified for review purposes.

l Skip Analysis: This option can be used in caseswhere the number of child products is huge. The analysis of
the number of unapproved or missingmandatory values / References can be time consuming but will
provide the detailed report. By clicking this option, the analysis will stop and the user can proceed with the
approving recursively.
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Example:Consider there are approximately around 100’s of products in a particular parent hierarchy.
Selecting each product at a time and then approving would be time consuming. In these cases, approving
recursively will help a user to approve all the products at a time and saves a lot of time.

Context Dependent Approvals
When an object is approved, this always happens in a specific Context, and the approval will only be for data
visible in this Context.

To illustrate this, see the figure below where an object 'P' has values for two different Attributes,Color and
Width in theMainWorkspace.WhileWidth is not dimension dependent,Color is and has different values in
two contexts - 'Blue' in the English context and 'Bleu' in the French context. If the object is approved in the
English context, only the data visible will be reflected in the Approved workspace. Because of this separated
approval, the object must also be approved in the French context to have it become completely approved
(green checkmark in the approval status field). Until this approval across contexts is done, the object will in the
English context have the status 'Approved in Current Context on [date + time]' (yellow checkmark), and in the
French context have the status of 'Last Approved on [date + time]' (red X).
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Approval Symbols
The Approved symbols are used to indicate the status of a Product, Classification, Image or Document. The
Approved symbol is viewed by clicking either a Product, Classification, Image or Document.

If you need to approve data, this is typically done in:

l Normal viewingmode - either approve a single object, or you can approve recursively.

l Approvedmode - approve all Objects, or you can partial approveObjects (choose specific Values and
References to be approved).

AnObject can contain revised data or not revised data.

Not revisedObjects are:

l Externallymaintained Attributes

l Commercial Data

l Entities, which are not set up to beWorkspace revisable

Revised data are:

l Internallymaintained Attributes (e.g. Description Attributes and Specification Attributes)

l References betweenObjects:

l Product to Image / Document Reference

l Product to Product Reference

l Product to Classification

l Product to Entity

l Classification to Classification

l Classification to Entity

l Image / Document to Entity

l Image / Document to Classification

l Entity to Entity

l Entity to Product

l Entity to Image / Document

l Entity to Classification

l Object names (e.g. Product names, Images & Documents names and Classification names)

l STEP PIM Tables

l Linked Attributes to Product
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Note: Only the status of revised data are reflected in the Approved field (see the table below for more
information).

The Approved field contains one of three different symbols indicating the Approved status of the current Object.

Approved
Symbols

Status Description

Unapproved Revised data on Product, Classification or Images & Documents in current
context are not approved.

Examples can be:

l An Object has never been approved.

l Revised data (e.g. Attribute Values, References, Object names or tables) have been
changed in current context without being approved.

Examples of changes to revised data could be:

l A change in Object name.

l A changed value on an internally maintained Attribute.

l If an Attribute has been linked to a Product.

l If Reference links to Objects have been made.

Note:When linking a Product to Classification and in case the Classification
Object Type owns the Product links, then the Product does not get the
Unapproved symbol. For more information, seeOnline Help - Object Types &
Structures.

Privileges can have an influence on the Approved symbols. See 'Users with
Different Privileges' below.

Approved Revised data on Product, Classification or Images & Documents are approved
in all contexts.

Note: No data in current context or any contexts are to be approved.

Partial
Approved

The yellow Partial Approved symbol can appear if:

Revised data have been approved in current context but a Reference, Object
name, or Value need also to be approved for the Object to get approved in all
contexts.

If you change view to another context, then you typically see that:

l A dimension dependent Reference is not approved.
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Approved
Symbols

Status Description

l A dimension dependent Value is not approved.

l A dimension dependent Object name is not approved.

Note: When all the dimension dependent References, Attribute values and
Object names have been approved, then the symbol will change from yellow
Partial Approved symbol to a green Approved symbol.

Privileges can have an influence on the Approved symbols. See 'Users with
Different Privileges' below.

Different Approval Status Messages in the STEP Application
1. Unapproved

In these examples, objects are shown as an unapproved status in 2 different situations.

When an object is newly created and never been approved as shown below:

When an object attribute / reference ismodified, the status will show as “Last Approved on” along with the date
and time as shown below:

2. Approved
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3. Partially approved

Users with Different Privileges
If two users have differentView privileges, then theymight get two different Approved symbols when looking at an
ApprovedObject.

Example with Attribute can be:

l User 1 has the privileges to see all Attributes

l User 2 has limited privileges and can only see some of the Attributes

If changes aremade to the Attributes that only User 1 can see, then User 1 gets the Unapproved symbol, while
User 2 only gets the yellow Partial Approved symbol as no changes has beenmade to the Objects he can see.

If changes aremade to Attributes that both User 1 and User 2 have the privileges to see, then both users get
the Unapproved symbol.
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Creating Objects in Tree
Regardless of the particular object type or hierarchy that you are working with, the general principles of creating
objects in the workbench are the same, and are described below.

Note: All actions in STEP are controlled via privileges. Some usersmay not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The information
below focuses strictly on themeans for carrying out the various actions, and assumes that all required privileges
are available to do so. More information on privileges is available in thePrivilege Rules topic in theSystem
Setup / Super User documentation.

Objects can bemanually created in the Tree via right-clicking or using theMaintain menu.

To create a new object via right-click:
1. Select a parent under which the new object should be created. Note that if the new object should be created as

a root node on the Tree tab, theMaintain menumust be used (see below).

2. Right-click on the parent and select the appropriate 'New...' option. The optionswill vary based on the selected
parent. For example, note the differences between the available options on a classification and an entity, as
shown below.

3. Selecting the right-click option will open a Create dialog, appropriate for the selected object super type (e.g.
Create Assets for assets and Create Entity for entities). The options available in the dialog are based on the
datamodel defined in SystemSetup. For example, the Object Type selection will vary based on the allowable
object types under the selected parent, and ID will only be available for population if the object type being
created does not have autogenerated IDs applied.
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4. When an object type has been selected and an ID applied, the Create button will be enabled. Clicking Create
completes the creation of the new object, which is then accessible in the Tree. If a Name is not supplied, the
object will display in the Tree by the ID in parentheses. If a Name is supplied upon creation, the object will
display in the Tree using the Name entry. For example, two new objects have been added under Customer C
in the screenshot below. The first did not have a Name supplied, while the second did.

To create a new object via the Maintain menu:
From themenu in the upper left corner of the workbench, select Maintain > Insert and choose the appropriate
option. Note that it is required to use thismethod when adding a new root node to Tree. Additionally, note that the
available options differ based on the active selection when themenu is accessed. For example, the below shows
the available insert optionswhen a classification has been selected, whereas the publication-related optionswould
be enabled if a publication object had been selected instead.
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Many of the available optionswill only be enabled when an appropriate selection has beenmade on the System
Setup tab. For example, an attribute groupmust be selected for the Attribute or Attribute Group options to be
enabled.
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Deleting Objects in Tree
Regardless of the particular object type or hierarchy that you are working with, the general principles of deleting
objects in the workbench are the same, and are described below.

Note: All actions in STEP are controlled via privileges. Some usersmay not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The information
below focuses strictly on themeans for carrying out the various actions, and assumes that all required privileges
are available to do so. More information on privileges is available in thePrivilege Rules topic in theSystem
Setup / Super User documentation.

Objects can be deleted from the Tree by right-clicking on the object to be deleted, or via theMaintain menu when
the object to be deleted has been selected. In both cases, the Delete option is selected from themenu, and
deletion of multiple objects is supported using Ctrl or Command tomultiselect.

Selecting Delete will open a deletion confirmation window, which will vary slightly based on the object selected for
deletion. For example, a classification provides an option to unlink child products rather than delete them, while
deletion of a product will automatically delete all child objects.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 148



Clicking Delete will attempt to delete the selected object (and delete or unlink child objects as appropriate). A
confirmation window will appear detailing success or failure. Note that in order to delete an object, a number of
conditionsmust bemet. For example, the object must not be referenced by any other object andmust not be active
in anyworkflow. If the deletion conditions are not met, the confirmation window will display the errors, whichmust
be corrected prior to deletion of the object.
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In some cases, a Force Delete option is available, though it is recommended to correct the data whenever possible
rather than forcing deletion. Also note that updatesmay need to be approved in order to take effect. For example,
if an object has been referenced by another and that reference has been approved, removing the referencemust
also be approved (by approving the change on the referencing object) to resolve the deletion objection.

Once an object has been deleted, it is visible in the Recycle Bin for Tree, fromwhere it can be revived if needed. In
order to fully delete the object, the deletionmust be approved and the object purged. Following a purge, the object
cannot be revived.

For more information on the Recycle Bin for Tree and the available actions, see theRecycle Bin for Tree topic
within this guide.

Alternatively, an object can be deleted and purged in one go using the 'Force Delete & Purge' option in the
Maintain menu. Choosing this option will bypass the Recycle Bin and is equivalent to completing a deletion and
purge all in one action. However, this option doesNOT cause an approve deletion event in the system, so if
deletion events need to be recorded for output to downstream systems, this option should not be used.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 150



Editing Objects in Tree
Objects can be easily edited within Tree, and general principles for editing are the same, regardless of the type of
object. The available tabswill vary based on the object type selected, as well as other considerations such as data
model and licenses. Some tabs are common across the various object super types, while others appear only on
specific object types or subsets of object types. Additionally, some editors appear onmore than one super type,
but have differing functionality based on the type of object that has been selected.

This topic covers the editing functionality available across the various editors, and provides links to additional
information for working with specific object types.

Note: All actions in STEP are controlled via privileges. Some usersmay not have access to create or delete
objects, or may only have options to edit specific object types, hierarchies, or attribute values. The information
below focuses strictly on themeans for carrying out the various actions, and assumes that all required privileges
are available to do so. More information on privileges is available in thePrivilege Rules topic in theSystem
Setup / Super User documentation.

When an object is selected, themain portion of the screen displays a corresponding editor. Themain editor for the
object is the first tab, which is Classification in the below example.

All objects will have an ID,Name,Object Type,Revision, andPath field. Objects that are subject to approval
(known as 'workspace revisable') will also have anApproved field. ID cannot be changed once an object has
been created, so the field appears yellow, meaning it is not editable.Revision andApproved data is auto-
populated by the system, so these fields are also not editable. Conversely, objectName andObject Type can be
edited (assuming the user has privileges to do so), so those fields appear white.
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Note: Any number of attributesmay be added to objects under the Description flipper. However, not all data
shown in the Description section is an editable attribute. Fields such as ID, Revision, Approved, Translation, and
Path are aspects of the object (not attributes), and are not editable. Name andObject Type are also aspects of the
object, though thesemay be edited.

Some object types only support Description attributes, meaning all object data is accessed under theDescription
flipper. For object types that support Specification attributes, data is organized by attribute group, and clicking the
magnification icon (indicated by a 1 in the screenshot below) will collapse or expand each group, allowing users to
focus on the relevant data. All attributes have a validation base type applied that determines the allowable data
that can be entered, and is indicated by the icon to the right of the attribute name below (2). Detailed information
on attribute validations is available in theValidation Rules topic in theSystem Setup / Super User guide.

To edit data, simply click in any editable field. Text attributes can be edited by typing directly into the field, while
LOV attributeswill provide a dropdown fromwhich users can select a value, as shown below (3).

Pressing the tab key shifts the focus to the next cell and Shift+Tab shifts the focus to the previous cell. Alt + F2
opens the Rich Text Editor, allowing the user to access styling options. For a complete list of shortcuts, see the
STEP Workbench Keyboard Shortcuts topic within this guide. The data fields available for editing will depend
entirely on the datamodel and will vary for each implementation.

Note: Data edited in the workbench is auto-saved, with the change / save being applied as soon as the user exits
any field. Therefore, no explicit save action is ever required by the user.
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If an object is being edited that is workspace revisable (e.g., subject to approval), editing the object will change the
approval status (if the object had been previously approved). See theApproval of Objects topic within this guide
for more information on approvals.

Multi-Editors
Objects can bemulti-selected for editing using Ctrl + click, or by Shift + Down / Up arrow keys. Additionally, objects
of the products and classification super types have a Sub Products tab that can be used for multi-editing.
Functionality for editing objects is comparable, regardless of how themulti-editor interface is accessed.

Right-clicking in any row headerwill expose theRotate Table option which can be used to access the preferred
orientation of the data (Pressing F11 will also rotate the table if any cell in the table is the active selection.). Editing
in thismanner allows for easy copy / paste of values between objects using Ctrl + C and Ctrl + V.

Right clicking in any data cellwill expose theHide Equal andMark Different options, which are especially useful
when working acrossmultiple objects as theywill hide all equal values, or highlight all different values,
respectively.
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Additional options for viewing data are available using theViewmenu located in the upper left corner of themulti-
editors.

The default view option is toShow allwhich displays all data on the object, similar to what would be available in a
single-object editor. Additional options can be configured using theNew View option. Clicking this opens a dialog
for users to enter a name of the view. Clicking OK in that dialog opens an Edit Filter dialog where the user can
select the attributes to be included in the view.
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The dialog defaults to having only "legal" attributes shown, meaning those attributes that are valid for the object, as
well as standard aspects of the object such as ID and Name. Note that object aspects are italicized, while
attributes are shown in standard text. By default, all available attributes and aspects are shown in both the left and
right panels. The dropdown in the upper left corner also has options to expose standard attribute search / browse
functionality, though typically the Legal Attributes selection is used as this prevents a user from defining an invalid
view. The 'Show only' and 'Do not show' radio buttons are applicable to the right panel, where the data for the view
is defined. TheAdd button is used when an attribute or aspect has been selected in the left panel and should be
added to the view (the right panel). TheRemove button is used when an attribute or aspect has been selected in
the right panel that should be removed the view. TheAdd All andRemove All buttons are used to add or remove
all attributes and aspects from the view. ClickingSave stores the new view.

Once one or more views have been created, they are available for selection from theViewmenu under Product
views.
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An existing view can be edited using theEdit view option, and a view that is no longer needed can be removed
with theRemove view option.

Note: Views are user-specific andmachine-specific, so a view created by one user will always be available for
that user when using themachine on which they created the view, but will not be available for any other user or for
the same user working from a different machine.Workbench views are stored in an XML file on the user's local
machine at C:\Users\[user]\STEPUserViews[UserID].xml. If the file is deleted, the configured viewswill no longer
be available.

Right-Click Editing Options
Additional editing options are available by right-clicking within the various editors. These include standard cut /
copy / paste options, as well asmore exotic optionswhich are briefly described below.

Note: Not all options are available and/or enabled at all times. Some options are available only for particular
attribute validation types, and others are available only on specific editors and/or object types. Menus also change
based on whether the right-click takes place on the column or row header, or within the active editable value field,
as well as when a single object / column / row has been selected vs. whenmultiples are selected.

l Character Tag:Used as a quick option to add tags to attribute valueswithout having to enter the Rich Text
Editor. Character tags that have been defined for the systemwill be available as sub-options to the Character
Tag selection. For more information, see the Tags topic in the SystemSetup / Super User guide.

l Edit:Used to open the Rich Text Editor for attribute values, allowing users to apply styles, formatting, spell
check, special characters, etc.

l Filter:Used to filter the displayed data under any flipper, by values, and is exposed by clicking the column
header. This can be especially useful when working with attribute groupswith a large number of attributes in
them as it allows users to filter based on empty / populated, greater than / less than, etc.

l Footnote (Insert / Edit):Used to add an additional piece of information (e.g., a footnote) to an attribute value.
Footnotes are added / edited within the Rich Text Editor so using these optionswill open that dialog. Note that
footnotes are only supported for use in conjunction with STEP tables. Using footnoteswithin attribute values
that will output in something other than a table will not yield the expected results. For more information on
footnotes, see the Tags topic in the SystemSetup / Super User guide.

l Hide:Used to hide a particular row or column from view, and a hidden row or column is exposed by clicking on
the row indicator or column header.

l Hyperlink (Insert / Edit, Follow, End):Used for adding hyperlinks to attribute values. Highlight text within the
attribute value and select the insert option to provide a hyperlink to be assigned to the selected text. After
inserting, and with the cursor at the end of the hyperlinked text, use the end option. This ends the hyperlink so
that subsequent text does not become part of it. Use the edit option to edit a previously inserted hyperlink.
Select the follow option while the cursor is within the hyperlinked text to follow the hyperlink. For more
information, see the Tags topic in the SystemSetup / Super User guide.

l Inline Reference (Insert / Edit, Copy as):Used to add inline references to attribute values. Inline references
are used to re-use values present within another attribute, object Name, or ID. This avoids duplication of data
bymaintaining the data only once, and re-using it from that source as needed. For example, a description
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attributemay need to dynamically include the object Name, e.g., '[Name] is a great product!'. Detailed
information on working with inline references is available in the Inline References in Attribute Values topic within
this guide.

l Insert Special Character:Used as a quick option to add special characters to attribute valueswithout having
to enter the Rich Text Editor. Opens an editor allowing for selection of themost recently used special
characters, with an option to access a full Unicode character menu. For more information, see the Tags topic in
the SystemSetup / Super User guide.

l Override:Used tomanually populate a local value to override a calculated (derived) value. This option is only
enabled on calculated attributes. For more information, see the Calculated Attributes topic in the SystemSetup
/ Super User guide.

l Recalculate:Used for on-demand display of calculated attribute values in the editor if they have previously
been disabled via the 'Disable calculated values' option in the View menu. For more information, see the
Calculated Attributes topic in the SystemSetup / Super User guide.

l Rotate Table:Used to rotate the data display. As a right-click option, it is only enabled from row / column
headers whenmultiple objects are selected. For a single object, it can be used to rotate the data under a flipper
only via keyboard shortcut (Alt + F11).

l Show All (Rows / Columns): Enabled after the Hide action has been taken, and exposes all hidden rows /
columns.

l Sort:Used to sort data based on attribute value rather than attribute name or display sequence. This option is
exposed when a column header is selected, and requires a sort selection (Ascending, Descending, or None).

l Style:Used as a quick option to add styling to attribute values (e.g., bold or italics) without having to enter the
Rich Text Editor. Styles that have been defined for the systemwill be available as sub-options to the Style
selection. For more information, see the Tags topic in the SystemSetup / Super User guide.

Additional Information
In addition to themain editors for objects, several other tabs / editors are available for editing objects, such as
References, Referenced By, etc. However, the available editors and functionswithin them vary based on the
selected object. Therefore, they are described in the context of the type of object being edited, in the subsequent
sections of this guide:

l Assets

l Classifications

l Collections

l Entities

l Products

l Publications

l Recycle Bin for Tree

© Stibo Systems - Confidential - STEP Trailblazer 8.3 157



Inline References in Attribute Values
Inline references can be embedded in attribute values for attributes that have text and numeric text validation
base types. An inline reference use case follows:

You are working with product objects whosemodel number is the same as their STEP ID (for example,
'12345'). On these objects there is an attribute called 'Product Description' that needs to dynamically reference
the object'smodel number within the text of the attribute. For a Product Description such as 'Acme lawn
mower, model number 12345,' the inline reference to the STEP ID would populate '12345.' Using an inline
reference in this instance helps to avoid duplication of effort—since the product'smodel number already exists
in STEP as its ID, there is no need for users tomanually enter it a second time into the system.

Also, in many cases inline references are easier to use than calculated attributes and easier on system resources.
For example, it may be easier for users to use an inline reference to pull in a STEP ID than to create a calculated
attribute using the formula 'StepID()'.

One attribute value can include several inline references. An inline reference can reference either a single attribute
or an attribute group.

Inserting an Inline Reference using Workbench
1. Select the relevant node. The corresponding editor appears.

2. Click on the leftmost tab within the editor, which is different depending on the object type (for example,
'Product', 'Classification', 'Images & Documents', 'Publication,' and so forth).

3. Activate theValue field of the relevant attribute where you want to create or edit the inline reference. Or,
highlight the field, right-click, and selectEdit to launch the larger value editor.

Note: PressingAlt + F2will also open the value editor.

4. Place the cursor at the position in theValue field where you want to insert the inline reference, or place the
cursor on an existing inline reference to be edited.

5. Right-click, and then click Insert Inline Reference to add a new inline reference or Edit Inline Reference to
edit an existing inline reference.
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6. The Inline Reference dialog displays.
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7. If you do not wish to return the name or ID of the current object and instead want to return a value or values
from another object in STEP, click the ellipsis button (…) to the right of theObject field. Ignore this field if you
plan to return value(s) from the current object instead.

l In the 'Select Object' dialog that displays after clicking the ellipsis, search for or browse to the object that
holds the value(s) that you would like to return, then clickSelect to choose the object.

8. SelectResolve To Object ID to return the value of the STEP ID of the chosen or current object.

9. SelectResolve To Object Name to return the value of the STEP Name of the chosen or current object.

10. SelectResolve to Attribute Value and/or Unit to activate the options in the 'Attribute Selection' portion of
the Inline Reference dialog.

11. Click the ellipsis button (…) to the right of theAttribute field to open the 'Select Attribute or Attribute Group'
dialog.

12. Search for or browse to the relevant attribute or attribute group for the inline reference, and then clickSelect.

13. ForAttribute Name(s), check the Include box if the name of the attribute(s) should be included in the inline
reference.

14. In theSeparator field, type a separator to be used between the name and value of the attribute. The default is
the equals sign (=). Note that the Separator field is not activated unless the Include box has been checked.

For example, if a single attribute is chosen, and the Include box is checked, the results will look as follows:

© Stibo Systems - Confidential - STEP Trailblazer 8.3 160



15. UnderAttribute Value(s), select the relevantAspect from the dropdown list. Available options are 'Value(s)
and Unit(s),' 'Unit(s),' and 'Value(s).'

16. In theAttribute Separator field—which is only valid when an attribute group has been chosen for the
Attribute selection—type in one or more characters to specify how the attribute values should be separated.
The default is the semicolon character without a following space (;).

The following screenshot shows:

l (1) An attribute group called 'Manufacturer Information' selected forAttribute
l (2) A separator of = placed between the attribute name and attribute value
l (3) An attribute separator of ; placed between each attribute within the group
l (4) How the attributes and attribute values resolve in the inline reference.

17. ClickOK to complete the configuration of the inline reference.

Inline References and Multi-Valued Attributes
TheAttribute Separator field in the Inline Reference dialog does not apply to the values of multi-valued
attributes. Instead, the separator for values of multi-valued attributes is handled by the <multisep/> tag

© Stibo Systems - Confidential - STEP Trailblazer 8.3 161



(multisep). Themultisep tag is aCharacter Tag in SystemSetup and comes standard with STEP systems.
STEP stores the values of multi-valued attributeswith themultisep tag between them, and this tag typically
renders as a forward slash (/).

If a multivalued attribute is used in an inline reference, the rendering setup for themultisep tag will be shown
between each of the values. In the below example, the 'Country of Origin' attribute has four values.When
rendered in the inline reference, these four values are separated by the forward slash (/) character.

For more information on STEP character tags, see the Tags topic in theSystem Setup / Super User Guide
documentation.

Copying Attribute Values as Inline References

An alternate—and quicker—method of creating an inline reference is to copy the value of an attribute, then paste it
into the value editor of another attribute as an inline reference. This inline reference can then be edited like any
other inline reference.

1. Navigate to the attribute value that you would like to use as an inline reference and select the value editor field.

2. Right-click and selectCopy as inline reference.
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3. Navigate to the 'destination' attribute value and select the value editor field.

4. Right-click and selectPaste.

5. The value appears in the destination field as an inline reference.

Note: The copied 'source' attribute value is connected to the 'source' object, meaning that any time an attribute
value is coped as an inline reference and pasted elsewhere, the inline reference will never pick up the attribute
value from the current object but only from the 'source' object. Also, STEP IDs and STEP names cannot be
copied as inline references.
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Inserting an Inline Reference using Web UI
Rich text editing allows users to enter and edit text within a web browser. Inline references can be inserted into an
attribute value using a Rich Text Editor (RTE) within a Node Editor.

Adding an inline reference inWebUI is similar to adding one in the workbench. For instructions, see theRich Text
Editor section of theWeb User Interfaces documentation.
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Assets
This topic covers information specific to the asset super type that is important to know whenworking with assets.
For general object maintenance information (applicable to all object types rather than specific to assets), see the
All Objects topic within this guide.

An asset is any product-related electronic file, such as images (tiff, eps, jpeg, etc.), Word docs, Excel files, PDFs,
PowerPoint files, text files, etc. Images are a common asset so theywill be the focus of this section. In most cases,
the terms “asset” and “image” are interchangeable.

Although any image can be loaded into STEP regardless of its quality or origin, it is important that a quality check
be performed by users with graphic arts knowledge. Ideally, this check occurs prior to import into STEP so that
only approved images are available in the system.

Classification of Assets
Asset objects live in a classification hierarchy. The classification hierarchy for assets should be separated from
other classification hierarchies (e.g., those used for alternate structuring of products, import / export configuration
storage, etc).

The recommendation is to have one classification object type and instance for each asset object type. For
example:

Within the individual type-based classifications, additional levels can bemodeled if necessary. A common option is
to work with a 2-level folder structure based on the first characters of the asset file name. For example:
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With a structure like this, it is not intended that users should be browsing the hierarchy to locate assets. Instead,
assets are typically located via references from other objects and/or via searches. Note that STEP does not
require that the image hierarchy havemultiple levels. Assets can be stored in a single folder (e.g., a flat structure).
However, this is not typically recommended as it can be impractical to navigate the hierarchy as the number of
assets increases.

Notice that the same asset object can exist below multiple different classifications. However, this functionality is
typically only used for caseswhere suppliers upload assets. These assets will initially go into supplier-specific
classifications and can subsequently also be linked into the primary asset hierarchy.

Asset File Type Designation
New asset object types are defined in STEP the sameway any other object types are, via the SystemSetup tab.
One key difference between asset object types and other object types, such as products or classifications, is that
there are no parent-child relations between assets, as asset instances live in classification hierarchies.

Asset object types are defined in the STEPWorkbench SystemSetup under 'Object Types & Structures'. Apart
from the built-in generic type 'Assets', it will be a flat list of the different asset object types required for the setup.
For example:
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On older STEP installations you will often see asset object types that are file type specific. For example: JPG
Image,Word Document, etc. For newer installations, this file type approach is generally not used, and instead, it is
recommended to use object types that convey information about the asset's use (as shown above), rather than the
file type. This is done for clarity as it is oftenmore important to understand the purpose of the asset. For example,
an asset is not just a PDF file, instead it is an InstallationManual, a Product Brochure or anOwner'sManual. One
advantage of the purpose-based setup is that it is possible to restrict reference types to point to the specific types
of assets and not just to generic file types.

With themove away from file type specific asset object types, asset object types cannot be applied automatically
when digital media files are imported into STEP as there is no 1:1 relationship between file types and asset object
types. It is possible to have object types automatically applied upon import when a file-based approach is used, but
this functionality generally does not weigh up to the disadvantages of the approach.

Asset Objects and Digital Media Files
A fundamental point when dealing with assets is that there is no 1:1 relationship between asset objects and digital
media files in STEP. Thus, it is possible to work with asset objects that do not have "content", i.e., are not tied to
any digital media files. Furthermore, the content can be dimension-dependent so that an asset is tied to different
files in different contexts. Finally, an asset can have different content in different historical revisions.
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As explained in the next section, there are different options for how and where the actual digital media files are
stored. Independently of which option is selected, asset objects are stored in STEP and it is to these objects (not to
the actual media files) that relations aremodeled (using references).

Image Variants and Handling
Different publishing projects impose various requirements on the use of images. For example, a high resolution
image in STEPmay be a TIFF. However, for the web, a jpeg is needed. Or, if the high resolution image is an EPS,
a GIF may be needed instead of a jpeg.

To handle these scenarios, STEP can use the original high resolution image to generate the needed image
versions based on a set of templates or image conversion pipelines.When using an image conversion, the images
in STEPmust be of sufficient quality to allow these variations to be properly created.

More information on image conversions is available in the Image Conversion Configurations topic in the
Digital Asset Exchange guide.

More Information
For specific details about working with assets in the workbench, see theMaintaining Assets and Linking
Assets to Products topics within this guide.

For information on working with assets inWebUI, see theAsset Handling in Web UI topic in theWeb User
Interfaces guide.

For information on importing or exporting assets, see theDigital Asset Exchange guide.
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Maintaining Assets
This topic covers information specific to the Asset super type that is important to know whenworking with assets.
For general object maintenance information (applicable to all object types rather than specific to assets), see the
All Objects topic within this guide.

Creating Assets
The basicmethods for creating an asset are the same as any other object type, as described in theCreating
Objects in Tree topic within this guide. However, there are a few considerations that are specific to assets that
users should be aware of when creating assets, which are described.

Assets are essentially placeholders in STEP, to which a digital media file must be associated.When assets are
created in STEP via import of a digital media file, this association happens automatically. However, when assets
are created using standard object creationmethods in Tree (e.g. right-clicking on a classification folder and
selecting 'New Asset'), it is only the placeholder that is created. An asset created in thismanner will initially have
no system properties and no content. For example:

A user can right-click on the asset and selectReplace Asset Content to open a dialog where a digital media file
can be selected from the local machine. STEP will automatically read and populate the properties of the asset, and
a thumbnail of the digital media file will display. For example:
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To avoid this two-step process, assets are often introduced in STEP via import (or specific transfer protocols for an
initial implementation). More information on importing assets is available in the Importing Assets section of the
Digital Asset Exchange guide.

Asset Editor
General information about editing objects in STEP is available in theEditing Objects in Tree topic within this
guide and is not repeated in this section. However, assets have some additional editing options specific to working
with digital media files, which are described.
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Images & Documents
The Images & Documents tab is the primary workbench interface for assets. It has three sections, described
below.

1. TheDescription flipper contains the same basic information as other object types. Additional Description
attributes can bemade valid for assets to support data such as keywords or asset descriptions. Specification
attributes cannot bemade valid for assets.

2. TheSystem Properties flipper displays data that is read automatically from the digital media file. This
information cannot be edited.

3. The asset thumbnail has a number of options available for editing assets. Additional right-click options are also
available when the asset itself is right-clicked from the Tree. All of the options that are specific to assets only
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(accessible from right-click on the thumbnail or the asset) are described below.

l Create Local Content of Asset:Creates a local version of the asset specific to the current context. See
the Asset Dimension Dependencies section below for more information.

l Delete Local Content of Asset:Deletes the content of an asset that is not dimension dependent. Deletes
the local (context-specific) content of the asset if the asset is dimension dependent. See the Asset
Dimension Dependencies section below for more information.

l Edit Asset:Opens the digital media file for editing in an external program, in addition to an Edit Asset
dialog in STEP. Upon completion of editing in the external program, click save within the program to store
the edited asset to a temporary directory. Then clickOK in the Edit Asset dialog in STEP to have STEP
retrieve the edited file from the temporary directory and store this in the asset. Note that themedia file will
open in the application associated with the file type. For example, for files ending with .xls, Excel will
automatically be launched. Thismay be different from computer to computer. One user’s computer may
open up EPS images in Photoshop, while another user’s computer may open the same file types in
Illustrator.

l Export Images & Documents:Opens the Export Images and Documents wizard tomake selections to
export the currently selected asset(s). See the Export Images and DocumentsWizard topic in the Digital
Asset Exchange guide for more information.

l External Viewer:Opens an external viewer for viewing the asset. This is comparable to the Edit Asset
function in that the program that is utilized is specific to the file type and the user's computer settings. It
differs in that any changesmade to the asset in the external program are not saved back to STEP.

l Image Viewer:Opens an image viewer within STEP for the user to examine the actual asset (as opposed
to just the thumbnail).

l Push Asset(s): Initiates asset push for the selected asset(s). See the Asset Push section of the Digital
Asset Exchange guide for more information.

l Replace Asset Content:Opens a dialog for the user to select a digital media file for the asset. See the
'Creating Assets' section above for more information.

l Save to disk:Opens a standard save dialog allowing the user to select a location on their local machine to
save the digital media file to.

l Unlink asset:Only enabled if the asset has been linked directly into a publication, in which case it unlinks
the asset from the publication. See the Publications section of this guide for more information.

References
TheReferences tab displays the classifications that the selected asset is linked to, and allows for linking to
additional classifications using the Link to Classification link. Each asset must be linked to at least one
classification, but may be linked tomany. Links can be removed by right-clicking on the row indicator and selecting
'Remove Link to Classification'. The Name of each classification displayed is hyperlinked for easy navigation, and
revision, approval, and translation statuses are also displayed.
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Referenced By
TheReferenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). The
display of the Referenced By tab on an asset will vary slightly from system to system, based on the datamodel.

1. Reference Flippers:References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groupswill display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a source for the reference, and a
reference will be created from the object selected in the dialog to the currently selected object that you are
standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the SystemSetup / Super User guide.
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2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what is
described for the Reference Flippers section above. The only difference is that this area displays references
that have not been placed in attribute groups for display purposes.

3. Used on Page:Displays publications that the selected object is used in. Additional information about working
with publications is available in the Publications section of this guide.

Status
The Status tab provides general information about objects, including revisions, translation status, and approval
status. For more information on these basic settings, see the Status Tab topic in the Products section of this guide.
For assets specifically, this tab also includes an Asset Push Status section that describes the status of assets for
the various asset push configurations on the system. For more information, see theMonitoring Asset Push topic in
the Digital Asset Exchange guide.

State Log
The State Log tab allows users to view the recent history of the object across all workflows in which it has been
entered. See the State Log Tab topic in theWorkflows documentation for more information.

Tasks
The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the
user is able to act on the tasks from this editor, including to edit data andmove tasks through the workflow. More
information on the Tasks tab is available in the 'Moving Tasks through aWorkflow inWorkbench' topic in the
Workflows guide.

Asset Dimension Dependencies
Individual asset object types can bemade dimension dependent using the Dimension Dependencies parameter
on the object type. This configuration will only affect the STEP Name of assets, meaning that it allows for individual
assets to have a different name based on the indicated dimension dependencies (e.g 'Red Hat' in English and
'Chapeau Rouge' in French when the dependency is Language).
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It is also possible tomake the content of assets dimension dependent so that an asset in STEP can be tied to
different digital media files in different Contexts. This is configured using the Image & Document Settings >
Dimension Dependencies parameter in SystemSettings.

This setting is global, meaning it applies to all assets. Unless there is a very special reason for turning on asset
dimension dependencies, this should be avoided. Asmentioned, the setting is global, meaning that special
proceduresmust be implemented for creating assets that are to have the same content in all contexts. Thus, if you
import a digital media file (and via this create an asset instance) in a context that does not use the top level
dimension point for the dimension on which asset content depends, the content will be created only in the
dimension point the current context uses.
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Linking Assets to Products
If the asset’s name can bematched to the product, then this function can be performedwhen the asset is imported.
If not linked at this time, there are two ways that the interface allows the link to bemade: a) from the product or b)
from the asset.

There are three ways to link images to products:

l From the product

l From the asset

l From import

Linking Assets to Products (From Products)
1. Select the product and then select theReferences tab.

2. Navigate to the Image References section of theReferences tab. Click on the + symbol to link the image to the
correct area. For this example 'Primary Product' will be used as it is themost common reference typemade.

3. A search window will appear.
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4. Search for and select the appropriate image. By selecting 'Primary Image,' it denotes that the image is the
exact representation of the product. Once a Primary Image has been linked to a product, a thumbnail of the
image will appear when the product is selected.

Note:When assets are linked to products, youmust designate what type of reference is beingmade. For
example, is it an image that represents the product? Is it an accessory to the product? Or a related document?
This reference type denotes that the image being linked to the product is a direct representation of that
product. When youmake such a reference, a thumbnail of the image is attached to the product. The thumbnail
will only appear for this reference type. It is possible to linkmore than one image to the reference type if the
reference type is set to allow multiple references 'yes.'

Linking Assets to Products (From Assets)
1. Select the image in the Assets folder in the Tree. Then, select theReferences by tab.

2. If it is not already open, click on the 'Image References' flipper to open it. Click on the + sign for 'Primary
Product Image' to link the image to the product.
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3. Navigate to the Product in the pop up window, and select it.

4. Selected image will be linked to the product. Once a Primary Image has been linked to a product, a thumbnail
of the image will appear when the product is selected as illustrated in the below image.
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Linking Assets to Products using the Import Manager
Thismethod is best used for large amounts of products / assets linking. Ideally, you should already have a file in
Excel that has the products and desired Image ID set up according to how you want them to be after import.

Note: If you only need to link a few assets to products, then it ismore efficient to link them via the interface.

1. Go to File and select Import, thenData. An 'Import Manager' window will appear. On 'Select Data Sources',
click the ellipsis button (…) next to 'Filename' and select your file.

2. Proceed to the 'Map Data' step. Select a source column and click theMap button. Map the column holding IDs
to 'ID', map the column holding the asset to be referenced to 'Asset Reference'. After selecting the 'Asset
Reference' radio button, select the 'Primary Image' radio button. For more information onmapping, see
Inbound Map Data - Map in theData Exchange documentation.
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3. ClickOK to close theMap To dialog.

4. If the image IDswere not found or the import file data was not done correctly, then columnswill appear in red.
For information on input files, seeAsset Reference - Map Inbound in theData Exchange documentation.

Note: If the image IDswere not found or the import was not done correctly, then columnswill appear in red.
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STEP XML Import
It is also possible to link the images to product via STEP XML import. The following code snippet, shows an
example XML file shown below:

<?xml version="1.0" encoding="utf-8"?>

<STEP-ProductInformation ContextID="Context7" WorkspaceID="Main"
UseContextLocale="false">

<Products>

<Product ID="18210" UserTypeID="Item" ParentID="18209">

<Name>18210 M B</Name>

<AssetCrossReference AssetID="20584" Type="PrimaryProductImage"/>

</Product>

</Products>

</STEP-ProductInformation>

© Stibo Systems - Confidential - STEP Trailblazer 8.3 181



Classifications
This topic covers information specific to the Classification super type that is important to know whenworking with
classifications. For general object maintenance information (applicable to all object types rather than specific to
classifications), see theAll Objects topic within this guide.

Classifications are used to build hierarchies and objects that bundle other objects into organized groupings. For
example, images, manuals, and icons could be uploaded to STEP as assets and stored in appropriate subfolders
under the 'Assets' classification folder. Product objects could also be linked into classifications to provide
alternative categorizations of objects that vary from the product hierarchy structure.

Classification Editor
The primary editor for classification objects is the Classification tab.

This tab will display all description attributes that are valid for the classification. Note that only description attributes
are available on classifications (as opposed to products, which can also have specification attributes). More
information on description attributes is available in theDescription Attributes topic of theSystem Setup /
Super User Guide.
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Sub Products
When on a classification, the Sub Products tab is used to display objects of the product super type that are linked
into the classification via Product to Classification links. When the selected classification does not have product
children (e.g., classifications used to house assets or configurations), the Sub Products tab does not provide any
meaningful information.

Data can be edited on the products linked into a classification from the Sub Products tab by clicking directly into
any editable field. Standard editing capabilities are available within this interface (as described in theEditing
Objects in Tree topic within this guide), including copy / paste functionality using Crtl + C and Crtl + V. Right-
clicking on any field within the table will expose additional options, including Copy, Paste, Hide Equal, andMark
Different selections - all of which are self-explanatory and can be especially useful when editingmultiple objects.
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Note that two views are available using theRotate Table option. As shown above, the view can be organized to
have attributes on the vertical axis. As shown below, the table can also display products on the vertical axis. Also
note that right-clicking within the header field exposes different options than within the data fields, including options
to add and remove products.
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SelectingRemove Product deletes the product to classification link between the objects, but does not delete the
product itself. SelectingAdd Product opens a dialog allowing the user to browse hierarchies to select a product
to link, as well as specifying the link type to be applied.

Note that the same functionality is available using theAdd Product link at the bottom of the Sub Products editor.

References
TheReferences tab is where all references of which the selected object is the source can be viewed and edited
(assuming proper privileges are in place). In addition, if the object has privileges applied, has objects visible in
other contexts, or has any linked attributes, that information can be viewed (and in some cases edited) on this tab.

The display of the References tab on a classification will vary slightly from system to system, based on the data
model. If the selected object has classification reference types for which the object is a valid source, those will
appear on this tab, in addition to the default flipper options.
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1. Reference Flippers:References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groupswill display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a target for the reference, and a
reference will be created to the object selected in the dialog from the currently selected object that you are
standing on (e.g., current object = source, dialog selection = target). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in theSystem Setup / Super User Guide.

2. Ungrouped Classification References: The functionality is identical to what is described for the Reference
Flippers section above. The only difference is that this area displays references that have not been placed in
attribute groups for display purposes. If all references that are valid for the selected object have been placed in
attribute groups, theUngrouped Classification References flipper will not be present.

3. TheApplied Privileges flipper allows users to apply privileges to the selected classification. Detailed
information on creating and editing privileges is available in thePrivilege Rules section of theSystem Setup /
Super User Guide.

4. TheVisible Objects in Other Contexts flipper displays subproducts that are visible in another context, which
is only applicable if classification hierarchies have been set to be dimension-dependent in SystemSettings.
See theClassification Hierarchy Settings topic in theSystem Setup / Super User Guide for detailed
information.
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5. TheAttributes flipper allows the user to view attributes linked to the classification, as well as to add new links
using the Link to Attribute link. When attributes are linked to a classification, they are available to be
populated on any objects of the product super type that reference the classification (assuming the attributes are
alsomade valid on the applicable product object type). The exact columns available will depend on the data
model and the attributes that have beenmade valid on the attribute links. Whether or not the various attributes
are editable will also depend on the setup of the datamodel. However, an ID and Name field are always
shown, with the attribute name being a hyperlink that can be used to navigate directly to the attribute. An
Attribute Groups column is also present, displaying the attribute group(s) that the attribute is in. A Mandatory
column is present and if checked, product objects that reference the classification cannot be approved until a
value has been provided for the attribute. Note that mandatory settings on the attribute itself apply globally,
while mandatory settings on the attribute link apply only to product objects that reference the classification at
which the attribute is linked (or reference a classification that is inheriting the link). More information on
mandatory settings is available in theMandatory Attributes topic in the SystemSetup / Super User Guide. If the
attribute link is inherited (indicated by a green down arrow, , in the row indicator), the 'Inherited from' column
will display the parental node where the attribute has been linked, which is hyperlinked for easy navigation.
More information on linked attributes is available in the Inheritance in the Product Hierarchy topic within this
guide and in the Attribute Links topic in the SystemSetup / Super User Guide.

Referenced By
TheReferenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In
addition, if the object is used by amatch code or is used by any publication, that information can be viewed on this
tab.

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

1. Reference Flippers:References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groupswill display first on the
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screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a target for the reference, and a
reference will be created from the object selected in the dialog to the currently selected object that you are
standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the SystemSetup / Super User Guide.

2. Ungrouped Referenced by Products, Classifications or Entities: The functionality is identical to what is
described for the Reference Flippers section above. The only difference is that this area displays references
that have not been placed in attribute groups for display purposes.

3. Used by Match Code Objects: If the selected object is the Category indicated in amatch code, thematch
code will display. For example:

More information onmatch codes is available in theMatching, Linking, andMerging guide.

4. Used on Page:Displays publications that the selected object is used in. Additional information about working
with publications is available in the Publications section of this guide.

Images & Documents
The Images & Documents tab displays all assets that are child to the selected classification (e.g., all assets that are
housed within that classification). Note that assets can be tied to classifications in two ways: as child products, or
via image and document references. Assets are typically referenced to classifications only when the classification
contains non-asset children for which the asset is relevant. In any case, assets referenced to classifications are not
visible on the Images & Documents tab. This is in contrast to how the same tab functions for products, where the
tab displays all assets referenced to the selected product. However, for the displayed assets (those that are child
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to the classification), the functionality available for interacting with the assets is the same aswhat is available for
referenced assets on a product, which is described in the Images and Documents Tab topic in theProducts
section of this guide.

Tables
The Tables tab allows users to view and edit the tables defined for the object. Tables are generally used to present
consolidated data acrossmultiple objects, such as object name, part number, and price. For more information, see
the Tables guide.

Status
The Status tab provides information about the status of the object, including revision history, translation status, and
approval status. Products and classifications share a common Status tab, which is described in theStatus Tab
topic in theProducts section of this guide.

State Log
The State Log tab displays the history of the selected object across all workflows. If the object has ever been in a
workflow, a flipper is displayed per workflow and the history of transitions of the object within that workflow can be
viewed. Detailed information on the State Log tab is available in theState Log Tab topic in theWorkflows guide.

Tasks
The Tasks tab displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place, the
user is able to act on the tasks from this editor, including to edit data andmove tasks through the workflow. More
information on the Tasks tab is available in theMoving Tasks through a Workflow in Workbench topic in the
Workflows guide.
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Collections
Collections are containers for storing sets of objects from Tree and SystemSetup independently of their
placement in the hierarchies. Objects in a collection can be updated, making collections a valuable tool for data
maintenance tasks.

Whenmultiple collections need to be grouped together, they can be put into a 'collection group'. Collection groups
can also hold other collection groups. Collections and collection groups are found in the Collections hierarchy on
the Tree tab. SeeCreating Collections orCreating Collection Groups in this documentation for more
information on each topic.

For more on datamaintenance in regards to collections and collection group, see theMaintaining Collections
topic in this documentation.

Note: Collection objects are not under revision control and cannot bemade dimension dependent, meaning that
the collection objects will be the same across all Workspaces and Contexts. However, the content of a collection is
filtered according toWorkspace / Context visibility and according to the privileges of the user inspecting the
collection.
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Creating Collections
Collections can be created in two ways:

1. Using the Search tab, perform a search, and create a collection with the results

2. Using an import file

Regardless of how they are created, if a collection contains less than 10,000 objects, these can be inspected in the
Tree hierarchy by expanding the Collection node. The collection will be displayed in an entirely flat structure
regardless of any parent-child relations that may exist between the objects, and regardless of which parents /
children the objects have when viewed elsewhere in STEP.

Creating a Collection from Search
Themost commonway to create a collection is through creating a search. To do so, follow the steps below.

1. Navigate to the Search tab, enter in the needed search criteria, and click Search to verify the results. For more
on how to search, see theNavigation and Searches topic in theSTEP User Guide / Getting Started
documentation.

2. Click the 'Save asCollection' button.

3. Next select the appropriate parent in the collections hierarchy (either the top collections folder itself, or a
collections group folder), enter a collection name (the ID is autogenerated), and clickOK.
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4. A background processwill run, and the new collection will be created and saved under the specified folder.

5. A user can now right-click the collection, and run any needed bulk update, or export the objects.

Note: The initial search criteria used to locate the included objects, is stored on the collection, which allows for
later updates of the collection. To learnmore about editing searches to update collections see theMaintaining
Collections topic in this documentation.

Creating a Collection from File Import
Collections can be created from a text or CSV import file containing separated STEP IDs of products, assets, or
classifications. Objects in the import file must already exist in STEP as the import will not create or update objects,
only place them in a collection.
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1. To create the import, right-click the Collection top node or a collection group to determine where the new
collection will live under. Then selectCreate Collection From File...

2. In theCreate Collection From File dialog, locate the file to be imported.
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3. For the Collection Name parameter, add a Name for the new collection (IDs are autogenerated).

4. For the File Contains parameter, select if the import file contains IDs of products, assets, or classifications.

5. ClickOK to start a background processwhich will create the new collection.
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Creating Collection Groups
Collection groups are containers that can hold collections or other collection groups. Below are instructions for
configuring collection groups.

Creating a Collection Group
1. Depending on where you want the collection group to live, either right-click the top-level Collections node or an

existing collection group in Tree. Then selectCreate Collection Group....

2. In the 'Create Collection Group' dialog enter aName (ID is autogenerated) for the new group.
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3. ClickOK

Once created, collection groups can be selected to hold new collections, or more collection groups can be created
under them. For more on how to create collections, seeCreating Collections in this documentation.
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Maintaining Collections
Collections can be a valuable tool for datamaintenance tasks, because they allow a user to group objects
independently of their placement in the hierarchies, and they can be updated. As an example, a set of objects with
data anomalies could be grouped in a collection via search criteria. Once the data is corrected, the objects with
updated information no longer meet the search criteria. Thus updating the collection automatically removes any
updated / fixed objects from the collection. In this way, only the objects that still need to be fixed are displayed in the
collection.

This topic addresses the variousways users can interact with andmaintain collections.

l Delete

l Edit Search Criteria

l Export Data Below

l Refresh Data

l Run Bulk Update

l Republish

l Search Below

Delete
Clicking on the Delete option deletes the Collection node, but does not delete the objects within the Collection.
Theywill still reside under their original nodes in Tree and SystemSetup. All collections and collection groups
below a collection groupmust be deleted before the parent collection group can be deleted.

Important: If an object is deleted from the collection, then the same object will be deleted from the original
hierarchy placement in STEP aswell. In this case, it would be best to just updated the collection through proper
maintenance of collections such as through an updated search or a bulk update.

To delete the collection node, right-click on the desired collection and selectDelete.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 197



Additionally collections and collection groups can also be deleted from theMaintain menu,Delete option.

For more on creating searches, see theNavigation and Searches documentation.

For more on how to use bulk updates, see theBulk Updates documentation.
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Edit Search Criteria
Collections created from searches can be edited if needed to reflect the needed objects in the collection.

1. To do so, right-click on the collection and selectEdit Search Criteria.

2. Once selected, the user will be brought to the Search tab where they can see the original search criteria, and
modify the search criteria if necessary.

Alternatively, if a collection was created using a search criteria, the 'Search URL' will appear in the collection's
Description flipper under the Search URL field. The user just needs to copy and paste this information into a
browser, and theywill be brought to the Search tab with the original search criteria on it where they canmake
adjustments if needed.
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For more information on searches, see theNavigation and Search topic in theGetting Started / STEP User
Guide documentation.

Export Data Below
The Export Manager wizard allows a user to export data on demand and to create or modify an export
configuration.

1. If a user wishes to export all objects in the selected collection based on the selected format and themapped
data, they can right-click on the collection and select Export Data Below.

2. Selecting this option will launch the Export Manager where a user can fill out the proceeding steps as needed.
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For more information on exporting, see theExporting Data topic in theExporting Data and Assets
documentation.

Refresh Data
Collections created from search results can be updated for themost up-to-date information and object groupings,
as objects in a collection that no longer meet the search criteria will be removed from the collection.

1. To start a refresh, right-click on the collection and selectRefresh.

Note: The 'Refresh' option isOnly available if the collection is created from a search.

Run Bulk Update
This option allows the user to interact with the objects in the collection in a number of ways. To name a few, the
objects could be submitted into a workflow, assigned to a user group, or have an attribute updated.
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1. Right-click the desired collection and select Run Bulk Updates.

2. Complete the steps in the Bulk Update wizard tomake the same updates to all objects in the collection.

For more on how to use the bulk update wizard, and the various operations that can be applied to collections or a
group of collections, see theBulk Update documentation.

Republish
TheRepublish action generates events on products, classifications, or assets in the collection. Common setup is
to use this option for on-demand creation of a republished event. For example, to generate events for all objects in
a collection that has never been published by an event queue.

For more information on events, see theEvents topic in theSystem Setup documentation.

1. To republish an event, right-click on the desired collection and selectRepublish...
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Note: Usersmust have the privilege tomaintain event queues in order to use this action.

2. Clicking the action launches a wizard where users can choose the appropriate event queue from the dropdown
menu.

3. Users can also enter in a ProcessDescription to give a name to the background process, which can be
monitored in the 'Republish Node'.
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Search Below
If a certain attribute on some of the items in the selected collection needed to be changed, a user could use this to
locate the items.

When a user right-clicks on a collection and selectsSearch Below, it allows the user to search only the items in
that particular collection.

See theSearch Below topic in theGetting Started / STEP User Guide documentation.
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Collection Properties and Statistics
Working with and viewing the collections properties, collection statistics, Data Profile tab, or the Log tab can
provide a quick overview of the collection itself, and useful information in regards to the objects it holds.

Collection Tab
TheDescription and Statistics flippers provide information about the selected collection. Below are the flippers
described inmore detail.

1. Description: This displays the Collection properties
2. Statistics: This displays the Collection Statistics
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Description Flipper
The fields described below provide information about the collection:

l ID: Shows the collection ID, which is auto generated.
l Name: Shows the name of the collection.
l Estimated Amount of Objects:Displays the total number of objects in the collection based on the latest
'Refresh' of the collection. The count is not filtered according to Context / Workspace visibility, privilege checks,
or object types.

l Search URL:Displays only on collections created from a search result. A user can copy the URL, paste it into
the URL field, press ENTER, and see the search in the Search tab. It is possible to edit the search if needed.
For more on searching see the Navigation and Searches topics in the Getting Started / STEP User Guide
documentation.

l Last edited By:Displays the date and time and user who last worked on the collection.

Statistics Flipper
The Statistics flipper gives an overview of which type of objects are included in the selected collection.
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In addition to breaking down the objects by type, it will also display the exact number of objects in the entire
collection based on the latest 'Refresh' of the collection.

Note:While actually viewing the collection in Tree, it may appear that there are fewer objects in the collection
then what is reported by the Estimated Amount of Objects field under the Description flipper or the total objects
reported under the Statistics flipper. Examples of why thismay happen could be because some objects are not
approved for the workspace the user is currently in, and thus do not show, or it could be due to privileges.

Data Profile Tab
TheData Profile tab can display a dashboard to provide a graphical representation of the objects that are in the
collection. This can bemodified based on the user's requirement.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 207



If a profile has never been created, a user can click on theGenerate Profile link to create the collection's
Dashboard.

If it has already been created, it is recommended to update the profile when viewing if it has not been updated
recently.

For more information on how dashboards and data profiling work, see theData Profiling documentation.
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Log Tab
The Log displays details about the creation andmodification of the collection, details about which user performed
what actions, and the number of objects in a collection when a collection is refreshed.
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Entities
This topic covers information specific to the Entity super type that is important to know whenworking with entities.
For general object maintenance information (applicable to all object types rather than specific to entities), see the
All Objects topic within this guide.

A STEP entity can be any object not defined as a product. Entities are commonly used tomodel customer-related
data, such as contacts, addresses, markets, or customers, though they can be used for any number of data
modeling scenarios, includingmodeling of reference data.

Entities differ from products in that they do not contain all of the product-specific functionality like specification
attributes, value inheritance, or tables. As entities can only utilize description attributes, the application of category-
specific attributes is not supported. Therefore, attributes are applied to entities strictly via object type validity and all
entity instances of a particular object type will have the same attributes available for population. Additionally,
entities cannot be published in printed form (e.g. as part of print publishing solutions), nor can you translate entities
using a background process.

Entitiesmay or may not be subject to approval, dependent upon the revisability settings (globally revisable entities
are the same in theMain and Approved workspaces, while workspace revisable entities adhere to standard
approval concepts). This provides a great deal of freedom in determining how entities are handled, specifically in
terms of how events are generated and processed. For more information, see theRevisability on Entity Object
Types section of theGetting Started / User Guide documentation or theEvents section of theSystem Setup
documentation.

Entities cannot be linked into classifications, though configuration of entity references allows for determination of a
hierarchical display (with source displayed as child to target, or vice versa). In effect, thismakes classifications
unnecessary for use with entities as entities can be classified via entities. Additional information on this is available
in theEntity Reference Types section of theSystem Setup documentation.

However, entities do retain the standard datamodeling capabilities and provide evenmore configurability. The
Revisability parameter allows you to define an entity object type that does not have to be approved and also
determines how events are processed.

Entity Hierarchy
Any number of entity hierarchies can be added to any system. For example, youmay set up address hierarchies,
customer hierarchies, market hierarchies, and so on. Entities are represented by icons chosen as part of the
implementation process and will likely differ on each system. The following is an example of an entity hierarchy.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 210



For more information on hierarchy setup, see theObject Types and Structures section of theSystem Setup
documentation.

Entity Editor
Once the entity hierarchy is created and description attributes are applied to the entity object types, the next logical
step is to start entering values.

Note: Only description attributes can be applied to an entity object types and will appear in the entity editor.
Specification attributes are not allowed on entities.

For example, the image above shows an entitymodeled as an address. The entity object has several description
attributes: City, Country, State, Street, and Zip. In addition to the Name attribute, these attribute can bemodified
andmaintained. Since this entity object type has beenmodeled to be globally revisable, approval is not applicable.
Therefore, the Approval Status field is not shown.
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Creating, Deleting, and Editing Entities
Creating New Entities
1. Select the relevant Entity Object (in this example Customer). Right-click and select 'New Entity Node' from the

context menu.

Note: Tree iconsmay appear different and are created by the customer according to preference.

2. Select the appropriate type of object to create (in this example Address). Type in the ID and Name of the new
object. Depending on the parent object, the list below will contain different choices. The ID field must be
unique. In some system setups, the ID is autogenerated (as in the example below) and will simply display the
next number in a system list. In that case, just type in the name.
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3. Select theCreate button. The newly created Entity Object will appear.

Deleting Entities
1. Select the Entity Object to be deleted. Right-click and select 'Delete' from the context menu.

Editing Entity Values
Values can bemaintained at the individual Entity Object or on a selected group of Entities.

Note: If a field is colored yellow, it cannot be edited. This is because the field is either inherited or not valid for the
object type.

1. Multi-Select the relevant Entities by pressing the Control key to select desired Entities.

The valid attributes for the selected Entities will appear on the right. To flip the columns& rows, either right-click &
select 'Rotate Table' or press F11.
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2. Type in the appropriate values in each cell.

Editing is similar to Excel editing. Pressing the tab key takes the focus to the next cell. Shift+Tab shifts the focus
to the previous cell. F2 enters the cell. Alt+F2 will open a large editor with a dialog to assist keying in a valid
value.

The right-clickmenu options are available as follows in the Entity object multi editor.

Double clicking on an attribute value inmulti editor displays the following right-click options.
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Entity References, Referenced By, and Status Tabs
References Tab
You can view associated references of an Entity object by selecting the References Tab. In this tab, you can
maintain references from the selected entity to other objects.

Selecting the References tab on an Entity Object will list valid References. In this tab it is possible tomaintain
references from the selected entity to other objects.

SeeReference Types topic in theSystem Setup / Super User Guide documentation for more information.

An entity can reference a number of different objects. It is possible to create:

l Entity-to-Entity references

l Entity-to-Product references

l Entity-to-Classification references

l Entity-to-Asset references

In the example below, one Entity-to-Entity reference type is valid on the selected entity object. Clicking the plus
sign (+) will open a large editor where you can select objects to be referenced. Alternatively, you can type the
name of an object in one of the white target fields and press ’Enter.’

l Targets can be unlinked by clicking the delete button .

l Metadata attributes can be linked on to the target reference in References Tab.
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l The attributes that are linked on to the target reference will be editable once the target reference is linked to the
entity reference type as shown in the above screenshot.

For themeta attributes to be visible on target reference type, add the required description attributes under
Valid Attributes in SystemSetup > Reference Type.

Referenced By Tab
Selecting the Referenced By tab on an entity will list valid Reference Types. In this tab, you canmaintain
references from other objects to current entities.

SeeReference Types in theSystem Setup / Super User Guide documentation for more information.

An Entity Object can reference a number of difference objects. It is possible to create:
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l Product-to-Entity reference

l Entity-to-Entity reference

l Asset-to-Entity reference

l Classification-to-Entity reference

In the example below, one Entity-to-Entity reference type is valid from an Entity to the current selected Entity
Object. Clicking the plus sign (+) will open a large editor where you can select objects fromwhere a reference to
the current selected Entity Object should bemade. In the example, a reference from an entity named 'Customer A'
ismade to the current selected Entity Object.

l Metadata attributes can be linked on to the target reference in Referenced By Tab.

l The attributes that are linked on to the target reference will be editable once the target reference is linked to the
entity reference type as shown in the above screenshot.

l For themeta attributes to be visible on target reference type, add the required description attributes under
Valid Attributes in SystemSetup > Reference Type.
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Status Tab
A record of all the changes that have beenmade to a currently selected entity will be displayed. This record will
allow you to see the user that made the change and when the change wasmade.
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You can purge past revisions or revert the old revisions. There will be noWorkspace, Translation, or Approval
Status flipper as Entities can be created as globally revisable, meaning they are the same in both theMain and
Approved workspaces.

However, Workspace, Translation, and Approval Status flipper will be displayed if we create entity object type as
'Workspace Revisable' as illustrated in below images.

Example of object type definition

Example status tab for workspace revisable object
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Products
This topic covers information specific to the Product super type that is important to know whenworking with
products. For general object maintenance information (applicable to all object types rather than specific to
products), see theObject Maintenance in Tree topic within this guide.

In STEP terms, a product is a part number, a stock number, an order number, a catalog number, a product
number, etc. In other words, any orderable item that a company sells.

Product Hierarchy
The foundation for a product-centric STEP installation is the Product Hierarchy / Primary Product Hierarchy. The
product hierarchy consists solely of objects of the product super type. The product hierarchy is an organized
hierarchywhere all products in the workbench are stored. This is also where products and product attributes are
linked. Although configurable, the product hierarchy is usually amulti-level hierarchy—each level controlled by its
own unique object type. Superusers can control the naming convention(s) used to categorize the products at their
different levels.

Inheritance of attributes and values is supported within the Product Hierarchy and the hierarchy is usually
designed to take advantage of this capability, with objects classified according to similar characteristics. More
information on inheritance is available in the Inheritance in the Product Hierarchy topic in this guide.

A portion of a sample hierarchy is shown below. Categories are represented by folder icons, while discrete objects
are represented by cubes.
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All objects of the product super typemust exist in the product hierarchy, andmay exist only once (e.g., each object
can have only a single parent). The primary purpose of the product hierarchy is proper attribution of products. That
is, in the product hierarchy, products should be grouped according to their similar properties so that inheritance of
attributes, attribute values, and references can best be used. Based on this, it is evident that the Product Hierarchy
is not intended to be used for modeling website hierarchies or other taxonomies (e.g., merchandising hierarchy,
sales hierarchy, etc.) where an object can be representedmultiple times.When a product needs to "live" in more
than one location, that can be accomplished using classification hierarchies. In this case, the product continues to
exist in the product hierarchy (and this is considered its true place of residence). It is then linked into one or more
classification hierarchies using references.

Product Editor
The Product Editor is displayed when an object of the product super type is selected in Tree.
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1. TheProduct tab (known as the Product Editor) is the primary interface for working with product objects in the
workbench.

2. TheDescription flipper displays basic information about the object. Additional information about the data
displayed is described in the Editing Objects in Tree topic within this guide. Note that some information
displayed is common for all implementations, while other information is specific to the datamodel and
configuration of each system.

3. If the object has a primary image referenced, a thumbnail version of it will display. The reference type to be
used for the thumbnail display is controlled in SystemSettings (on the Users & Groups node), and additional
information on this is available in the Primary Image Type topic in the SystemSetup / Super User guide.
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Additional information on references in general is available in the Reference and Link Types topic in that same
guide.

4. Specification attributes are displayed in flippers, with the flipper namematching the attribute group. Flippers
can be expanded / collapsed by clicking themagnification icon. Note that when attribute groups have sub-
groups, configuration determineswhether the parent group or the child sub-group is displayed as the flipper
name. This is set via the 'Product Editor, Group attributes by top group' parameter in SystemSettings (on the
Users & Groups node), and additional information on this is available in the Product InformationManager
Default Settings topic in the SystemSetup / Super User guide. More information on attributes in general is
available in the Attributes section in that same guide.

5. Attribute values can be edited by clicking into any editable field. Additional information on the various editing
options is available in the Editing Objects in Tree topic within this guide. By default, attributes are displayed in
alphabetical order within each flipper. However, if an attribute display sequence has been configured, this will
override the alphabetical sorting. More information on attribute display sequence is available in the Attribute
Display Sequence topic in the SystemSetup / Super User guide.

Additional Editors
See the additional topics listed below for information on the other editors available on products.

l Category Profile: Allows users to configure and view profiling data and dashboards for the objects under the
selected node. See theData Profiles topic in the Data Profiling documentation for more information.

l Commercial: Allows users to add and edit commercial terms for the object. Commercial data / terms lists are
often used to store pricing information. See theCommercial Data guide for more information.

l Images & Documents: Allows users to view and edit assets referenced by the object (or inherited from
parental objects). See the Images & Documents Tab topic within this guide for more information.

l Product Variants: Allows the user to generate andmanage a family of products, which are basically the
same, only varying on the values of a small sub-set of their attributes. For example, clothing and shoes both
offer good use cases for product variants as shoes or clothing itemsmay come inmultiple sizes and colors, but
are otherwise identical. The product family holds all data for the item, e.g., a particular shoe, while the variants
would hold only the various combinations of the color and size varieties (e.g., size 7 red, size 8 blue, etc). The
Product Variants tab is only present if the system has been configured to support variants. For more
information on this, see theProduct Variants documentation in the SystemSetup / Super User guide.

l Proof View: Allows users to preview a close representation of how a product will lookwhenmounted onto an
InDesign page based on a selected publication version and product template. For more information, see the
Generating Proof Views topic in the STEP'n'design documentation.

l Referenced By: Allows users to view all objects referencing the current object, and add / remove / edit these
references. See theReferenced By Tab topic within this guide.

l References: Allows users to view all objects that the current object references, and add / remove / edit these
references. See theReferences Tab topic within this guide.

l State Log: Allows users to view the recent history of the object across all workflows in which it has been
entered. See theState Log Tab topic in theWorkflows documentation for more information.
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l Status: Allows users to view basic information about the object, including revision history, translation status,
and approval status. See theStatus Tab topic within this guide for more information.

l Sub Products: Allows users to view and edit all child objects of the selected object in a table form. See the
Sub Products Tab topic within this guide for more information.

l Tables: Allows users to view and edit the tables defined for the object. Tables are generally used to present
consolidated data acrossmultiple objects, such as object name, part number, and price. For more information,
see the Tables guide.

l Tasks:Displays all active tasks across all workflows for the selected object, subject to the user's privileges
(only tasks that the user has the rights to address are visible). When relevant tasks and privileges are in place,
the user is able to act on the tasks from this editor, including to edit data andmove tasks through the workflow.
More information on the Tasks tab is available in theMoving Tasks through a Workflow in Workbench
topic in theWorkflows guide.
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Inheritance in the Product Hierarchy
Inheritance in STEP is the concept that when the value of an attribute is defined in a parent product, all the child
products that exist under the parent product can inherit the value - meaning that the value is present on the child,
as well as the parent. If the attribute is also valid on the child (in addition to the parent), then the value can be locally
edited on the child (e.g., a different value supplied so the child no longer inherits the value from the parent). Note
that value inheritance also applies to references, meaning that if a reference is populated on a parent, it is also
available on the child in the sameway as an attribute value. However, referencesmust be explicitly configured for
inheritance to be in place, while attribute valueswill automatically inherit to child products.

In addition to value inheritance, attribute inheritance is also available in the product hierarchy. Thismeans that
attributes can be linked to specific nodes / categories so they only appear for those categories and their children.
For example, consider a company that manages data for both batteries and clothing. Sizemight be applicable to
both categories of objects since both batteries and apparel have sizes assigned. However, sleeve length and
voltage are characteristics applicable for clothing and batteries, respectively, and it could be confusing to see a
'Voltage' attribute on a clothing item. To avoid this, the 'Voltage' attribute could be linked to the 'Batteries' category,
while the 'Sleeve Length' attribute could be linked to an 'Upper Body Apparel' category.

Inheritance perpetuates throughout the hierarchy, nomatter how many levels are present (e.g., inherited
attributes and values appear on children, grandchildren, etc.). When attributes are considered applicable to all
products, regardless of category, they are called 'global attributes'. For example, attributes such as Price,
Description, andManufacturer Name. Thus, these attributes are linked to the top level in the product hierarchy and
are inherited down to all products beneath, nomatter how many levels there are.

Attribute inheritance onlymeans that the attributes are available for all of the products beneath where they are
linked. The process of linking attributes to different levels does not have anything to do with the actual values that
will go into the attributes for any particular product. In the 'Voltage' example, when linking that attribute, you are
only concerned with making that attribute available to all the battery products—not with the actual voltage for any
given product. However, if many batteries under a parent shared the same value, the value could be populated on
the parent to inherit down to the children. Any children varying from the parent value could then be edited
individually, while those having the same value as the parent do not need to be updated further. Note that attribute
inheritance within the product hierarchy is only available with specification attributes, and is not available with
description attributes. Further note that this topic focuses on inheritance solely within the product hierarchy.
However, it is important to be aware that attribute inheritance can also be used within classification hierarchies
that are used to organize product objects. Attributes can be linked to a classification, making them available for all
products linked into that classification (or a child classification). More information on attribute inheritance with
classifications is available in theClassifications topic within this guide, and within theAttribute Links topic in the
System Setup guide.

Important: Value inheritance is a powerful feature, but care should be taken not to maintain values at a level too
high in the hierarchy.With such a setup, a single change couldmean that thousands or millions of products would
have to be updated in downstream systems andmany systems are not geared to handlemassive feeds like that.

When working with products and/or creating new products, users should bemindful of inheritance, considering
both the inheritance of the available attributes, as well as their specific values or references. It may be helpful to
consider the following:
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l Is the hierarchy granular enough to allow products within the category to be grouped so that all products only
have the relevant attributes, or are additional category levels required to obtain this granularity?

l Which attributes are required for the products in the category and/or subcategories?

l If product variants are used, which attributes should bemaintained at the family level and which ones should be
maintained at the variant level?

Note: Data can also inherit from dimensions (e.g., language or country). More information on this is available in
theDimension Dependent Data section of theContexts topic in theSystem Setup / Super User Guide.

Linking Attributes to Products
Tomake attributes valid for products, theymust be linked to the appropriate tree nodes in the product hierarchy.
Some attributeswill be global attributes (applicable to all objects in the product hierarchy) and are linked to the
“Product Hierarchy” root node. These global attributes are then valid for all products. Other attributes apply only to
specific categories of objects, and are then linked directly to those categories, making them available for all objects
within that category (if also set as valid for those object types). Attributes should not be linked to individual leaf
objects, as each one would have to have the link individually applied. Instead, attributes should be linked to some
parental folder in the hierarchy above the objects needing to use the attribute.

Before proceeding, be aware of the following:

l Attributes can be linked to objects of the product or classification super type. In either case, the steps are
comparable and the attributes aremade available for the children "under" the node at which they are linked
(beingmindful that "under" means "actual children" in the product hierarchy, whereas it means "objects with a
reference to" when dealing with classifications).

l Linked attributes apply only to objects of the product super type. For example, linking attributes to a
classification object that holds assets does not make those attributes available on the child assets.

l Only Specification attributes can be linked to products or classifications. Description attributes cannot be linked
attributes.

Linking Attributes
1. Select the product group or classification and click theReferences tab.
2. Expand the appropriate flipper (Linked Attributes from Product Hierarchyon product objects or

Attributes on classification objects), then clickLink to Attribute.
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3. In the standard search / browse window that displays, locate the appropriate attribute(s) and clickSelect.

Localizing an Attribute Link
Local attribute links can be created to override inherited attribute links.

1. Select any existing inherited attribute link and right-click on the row indicator.

2. Select theCreate Local Link option.
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This creates a local version of the link where attributes on the reference can be locally edited. Local links are
removed the sameway as inherited links, though removing a local link simply re-applies the inherited link.

Unlinking a Linked Attribute
Unlinking an attribute does not delete the attribute fromSTEP; it simply removes the link so the attribute is no
longer available for population on the selected node (and child nodes, if applicable). Note that attribute linksmust
be removed from the same node to which theywere added. In other words, trying to remove an inherited attribute
link is not possible and the 'Remove Link to Attribute' option will be disabled. To remove an inherited link, it must be
removed on the parental object that holds the link. However, care should be taken in doing this as it will remove the
link for all child groups, and will need to be re-linked at those lower child levels if it is still needed there.

1. On the References tab of the object, expand the appropriate flipper (Linked Attributes from Product
Hierarchy on product objects orAttributes on classification objects).

2. Right-click on the row indicator and selectRemove Link to Attribute from the context menu (or use Ctrl +
“-”). Multiple attributes can be unlinked simultaneously bymulti-selecting.

Note: If an attribute has been linked locally, removing the link only removes the local link, and the inherited link
will again take effect.

Additional methods for maintaining attributes links
Attribute links can be added and removed in a number of ways, in addition to what has been described above.
These include:

l References tab of the attribute itself
l Maintain > Linkmenuwhen a product or classification is selected
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l Edit > Link to Attribute /Remove Link to Attributemenuwhen a product or classification is selected

All methods for adding and removing attribute links are equivalent, producing the same end result.

Working with Inherited Values
There aremany advantages to setting common values:

l When an update is needed, the value is only entered once in the product group instead of – potentially –
separately, across hundreds of products.

l When new products are added to the group, they automatically inherit the product group’s values.

l The translation of product group values only need to be performed once, as opposed to translating the same
value every time for individual products.

Asmentioned above, it is possible to set attribute values for an individual product, but consider a situation where all
products within a product group share common attribute values. For example, a set of hats that share a common
description and features.

There are two ways to approach this: 1) keep all common valueswith the individual product or 2) set the common
value at a higher level in the product hierarchy. By setting the value higher in the hierarchy, the attribute value is
inherited down to all products beneath.

The image above shows three inherited values, which are designated by a green down arrow ( ).

The value is set at the product group, or in this case, 'Hats and Caps Sales Items'. Therefore, all products beneath
will inherit the same value.
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It is possible to override an inherited value by setting a different value at any subordinate level, e.g., the product
level. This is called a localized value. However, this requires that the attribute be valid for the child object type (as
is the case for the inherited values shown in the screenshot above). Attributes that display as inherited (indicated
by the green arrow) but not editable (e.g., value field is yellow rather than white) are not valid for the object, so they
can only have a common value with all sibling products, which is inherited from a parent higher in the hierarchy.
Detailed information on setting validity of attributes is available in theValidity on Specification Attributes topic
in theSystem Setup / Super User Guide.

If a value is localized, then subsequently deleted, the product will again automatically inherit the parental value.
Therefore, it is impossible to have null (blank) values for inherited attributes (unless the parental object has the null
value).

For information on working with and/or setting up inherited reference values, see the Inheritance Example for a
Reference section of theSystem Setup / Super User Guide.
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Images & Documents Tab
Whenworking with products, the Images & Documents tab displays thumbnails of all assets that are referenced by
the selected product, or inherited from a parental object referencing the asset. When working with classifications,
this tab displays all assets that are child to the selected classification. The functionality for working with the
displayed assets is the same, regardless of whether a product or classification has been selected.

If more than 50 assets are present, theNext / Previous buttons are enabled at the top of the screen, allowing
users to page through sets of assets (50 at a time). Filtering functionality is also available and is especially useful
when working with large sets of assets. The options for filtering are described below.

Along with each thumbnail, basic information about the asset is displayed, including asset name, pixel size, file
size, and reference type used to link the asset to the selected object.

Interacting with Assets
From the Images & Documents tab, several actions can be taken with the displayed assets.

Edit asset
By right-clicking on the asset, users can edit any assets on the page, open an external viewer, save the image to a
disk or local PC, and view the image on a larger scale.
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Edit reference type
The type of reference that links the object and the asset is displayed in a dropdown below the asset thumbnail.
Selection in the dropdownwill be disabled (grayed out) if there is only one valid reference between the object type
and asset type. If multiple valid reference types are available, selection of the reference type is enabled and can be
edited from this location. More information on references is available in theReference and Link Types topic in
theSystem Setup / Super User Guide.

Filter the displayed assets
A user can filter the displayed assets by entering the name of the asset in the Filter filed. This action displays
assets that have the entered value as part of the asset name, as shown below.

Note: The filter automatically applies wildcard functionality so explicit entry of wildcards (*) is not needed.
Entering an asterisk will cause the system to search for assets with an asterisk in their name.
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To remove the applied filter, delete the characters in the filter field and press the Enter key on your keyboard.

Navigate to asset
The asset name is shown directly below the asset thumbnail as a hyperlink. Clicking the hyperlink navigates
directly to the asset in the classification structure.
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Product Overrides
Product overrides are alternate versions of products and product families that may have differing values,
references, links, and structures. Attributes and values applied to the product family are inherited to the product
override and can be replaced with local values and references on the product override. Product overrides allow
product objects to exist in multiple locations in the product hierarchy and are the primary building blocks for many
print product presentations. A product override allows for the creation of 'pseudo' product families that are flexible
to ever-changing print presentations. They can be thought of as a workaround for when an existing product family
does not contain the exact products needed for the publication layout and/or the accompanying STEP table(s).

A product override folder can include products from various "standard" (e.g. non-override) product families.
Similarly, a product override leaf object can live under a different product folder (override or standard) than the
folder in which its corresponding standard object resides.

1. Tree Structure: For clarity, it is recommended to house product overrides in a separate sub-hierarchy from
standard products.

2. Override Interface: The product override object makes it possible to override the children, attributes, and
references of a product / product family. This is useful in order to publish a limited version of a product family
without modifying the object itself.
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Example

In this example a product familySki Jacket Pro has three products. A product override 104061 is created and
based on the product familySki Jacket Pro. Attributes, values, and references are inherited from the product
familySki Jacket Pro to the product override folder and can be replaced with local values and references on the
product override.

Two products from the product familySki Jacket Pro are linked into the product override folder (SKU 00001 and
SKU 00002). The product override only contains a subset of the products included in the original product family
Ski Jacket Pro, as SKU 00003 is not included.

Important: Values and references inherited to a product override will not be inherited to products linked into the
product override. These products will have their values inherited from their original structure instead.

Selecting the Product tab or References tab on the product-override will indicate with a yellow icon ( ), if an
attribute or reference is inherited from an overridden product. Inherited values and references can be replaced
with local versions, assuming the relevant attribute and/or reference is valid on the relevant product override object
type.

Creating a Product Override
1. In Tree, select an object for which an override should be created.
2. Right-Click and selectNew Product-Override
3. In the Create Product-Override dialog,

l Click anObject Type

l Key in ID and Name

l Optional: Click the ellipsis button (…) to select a product family to adapt values, references, and links from.
The product-override will inherit all values, references, and links from the selected product family.

l Optional: Click 'Adopt Children' if the product-override should also include all products from the overridden
product family.
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4. PressCreate to create the product-override.

Linking Products into a Product Override
1. In Tree, select the product override
2. Right-click the product override and selectAdd Children to Override
3. Search orBrowse for the products to be linked into the product override

Removing Products from the Product Override
1. In Tree, select the product override
2. Expand the product override and select the product to be removed

3. Right-click and selectRemove Child from Override

Creating a Subordinate Product Override
1. In Tree, select the product override
2. Select a product linked into the product override

3. Right-click the product and click Convert to Product-Override

The product will be converted into a product override. Values, references, and links will get inherited from the
overridden product. 
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Referenced By Tab
TheReferenced By tab is where all references of which the selected object is the target (e.g., all the objects that
the selected object is referenced by) can be viewed and edited (assuming proper privileges are in place). In
addition, if the object is used by product overrides, has amatch code acting on it, or is used by any publication, that
information can be viewed on this tab. Finally, privileges assigned to the product can be added and edited from this
location, and subproducts that are present only in other contexts can be viewed (if the object is of a dimension-
dependent object type).

The display of the Referenced By tab on a product will vary slightly from system to system, based on the data
model.

1. Reference Flippers:References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid target that have been placed in attribute groupswill display first on the
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screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a source for the reference, and a
reference will be created from the object selected in the dialog to the currently selected object that you are
standing on (e.g., current object = target, dialog selection = source). If any attributes are available on the
reference and editable, they can be edited within this interface. References can be removed by clicking the (X)
on any existing reference. Additional information on configuring and working with references is available in the
Reference and Link Types topic in the SystemSetup / Super User guide.

2. Referenced by Products, Classifications or Entities: The functionality is identical to what is described for
the Reference Flippers section above. The only difference is that this area displays references that have not
been placed in attribute groups for display purposes.

3. Used By Product Overrides:Displays product override objects that are based on the selected object. More
information on product overrides is available in the Product Overrides topic in this guide.

4. Linked into Product Overrides:Displays product override objects that have the selected object as a child.
More information on product overrides is available in the Product Overrides topic in this guide.

5. Used by Match Code Objects: If the selected object is the Category indicated in amatch code, thematch
code will display. For example:

More information onmatch codes is available in theMatching, Linking, andMerging guide.
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6. Used on Page:Displays publications that the selected object is used in. Additional information about working
with publications is available in the Publications section of this guide.

7. Applied Privileges:Displays the privileges that have been applied to the selected node. Privileges can be
added using the Add Privilege link, and can be removed by clicking on the row indicator and selecting 'Remove
Privilege'. Existing privileges cannot be edited from this interface. Detailed information on creating and editing
privileges is available in the Privilege Rules section of the SystemSetup / Super User guide.

8. Visible Sub-Products in Other Contexts:Displays subproducts that are visible in another context, which is
only applicable if the object type is dimension-dependent. Note that it is not recommended tomake product
object types dimension-dependent; instead, it should only be data on objects (e.g., attributes and references)
that are dimension-dependent. As a result, this flipper is rarely used.
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References Tab
TheReferences tab is where all references of which the selected object is the source can be viewed and edited
(assuming proper privileges are in place). In addition, if the object has associated indexwords, is used by any
publication, or has any linked attributes, that information can be viewed and edited on this tab.

The display of the References tab on a product will vary slightly from system to system, based on the datamodel.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 241



1. Reference Flippers:References can be placed in attribute groups for display purposes. All references for
which the selected object is a valid source that have been placed in attribute groupswill display first on the
screen, with the flipper title being equal to the name of the attribute group. References can be added by clicking
the (+) on the reference. This will open a dialog allowing the user to select a target for the reference, and a
reference will be created from the currently selected object to the object selected in the dialog (e.g., current
object = source, dialog selection = target). If any attributes are available on the reference and editable, they can
be edited within this interface. References can be removed by clicking the (X) on any existing reference.
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Additional information on configuring and working with references is available in the Reference and Link Types
topic in the SystemSetup / Super User guide.

2. Ungrouped References: The functionality is identical to what is described for the Reference Flippers section
above. The only difference is that this area displays references that have not been placed in attribute groups for
display purposes. If all references that are valid for the selected object have been placed in attribute groups, the
Ungrouped Classification Links andUngrouped Product References flippers will not be present.

3. Index Words: Allows users to view indexwords linked to the currently selected object, and to link indexwords
using theAdd Index Words link. Indexwords aremaintained in a dedicated hierarchywhere it is possible to
maintain the word itself along with a sort word. More information is available in the Creating an IndexWords
Structure topic in the STEP'n'design documentation.

4. Publications: Publications that the currently selected product is linked to are displayed, and new links can be
created using the Link to Publication or Section link. Additional information about working with publications
is available in the Publications section of this guide.

5. Linked Attributes: Attributes that are linked directly to the selected product or inherited from a parental node
in the hierarchy display under the Linked Attributes from Product Hierarchy flipper. The exact columns
available will depend on the datamodel and the attributes that have beenmade valid on product attribute links.
Whether or not the various attributes are editable will also depend on the setup of the datamodel. However, an
ID and Name field are always shown, with the attribute name being a hyperlink that can be used to navigate
directly to the attribute. An Attribute Groups column is also present, displaying the attribute group(s) that the
attribute is in. A Mandatory column is present and if checked, the object cannot be approved until a value has
been provided for the attribute. Note that mandatory settings on the attribute itself apply globally, while
mandatory settings on the attribute link apply only to objects that are child of the node at which the attribute is
linked. More information onmandatory settings is available in theMandatory Attributes topic in the System
Setup / Super User guide. If the attribute link is inherited (indicated by a green down arrow, , in the row
indicator), the 'Inherited from' columnwill display the parental node where the attribute has been linked, which
is hyperlinked for easy navigation. More information on linked attributes is available in the Inheritance in the
Product Hierarchy topic within this guide and in the Attribute Links topic in the SystemSetup / Super User
guide.

The Linked Attributes from Classification Hierarchy flipper is comparable to the product hierarchy
counterpart described above, though shows attributes linked to a classification that the object is amember of
(e.g. has a reference to), rather than attributes that are linked to a parental product. The same considerations
apply in that the exact columns available will vary based on the datamodel, with ID, Name, Attribute Groups,
andMandatory columns always being present and functioning in the sameway as for product attribute links.
Note that objects shown in the 'Inherited from' column in this case are parental objects not of the selected
object itself, but instead of a classification that is parent to the classification that the selected object references.
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Status Tab
The Status Tab provides general information about objects, including revisions, translation status, and approval
status. For products and classifications, the Status tab displays the same information, regardless of the object
type. Publications, entities, and assets have slightly different information available, thoughmuch of it is common to
what is described below.
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1. Revisions: In STEP, historical versions of objects are stored as revisions. A revision thus represents a
historical "snapshot" of an object. The Revisions flipper provides a record of the revisions that have beenmade
to the currently selected object, including when changes to the object weremade and whomade them. Via
right-click, users are able to purge old revisions or revert to previous revisions. For more information on
revisions, including how they are generated and how they should bemanaged, see theManaging Revisions
in STEP topic in the SystemSetup / Super User guide.

2. Workspaces: All the workspaces that the selected products are in will display, as well as the revision number
that exists in that workspace. Generally speaking, if the object has been edited since it was approved, theMain
and Approved workspaceswill hold different revisions. However, it should be noted that not all changes to an
object generate a revision. More information on this is available in theManaging Revisions in STEP topic in
the SystemSetup / Super User guide. For more information on workspaces in general, see theWorkspaces
topic in the SystemSetup / Super User guide.

3. Translation: Translation relations (sources and targets) and status (e.g. Up to date, Re-translation needed,
etc) of the translations display. For more information, see the Translations documentation.

4. Approval status in all contexts:Displays the approval status of the object in each context on the system.
More information on approvals is available in theApproval of Objects topic in the Getting Started / User
guide. More information on contexts is available in theContexts topic in theSystem Setup / Super User
guide.

5. Hidden values:Displays hidden inherited values on the object. Hidden values are those that are inherited
from another dimension (e.g. language or country) rather than from a parental object. More information on this
is available in theDimension Dependent Data section of the Contexts topic in the SystemSetup / Super
User guide.

6. Diagnostics:Displays any issueswith the object found by system diagnostics. If a problem has been found,
the information can be copied by clicking the file link.
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Sub Products Tab
When the Sub Products tab is accessed on an object of the product super type, all direct children of the selected
node are displayed. If privileges allow, data can be edited on the displayed objects by clicking directly into any
editable field. Standard editing capabilities are available within this interface (as described in theEditing Objects
in Tree topic within this guide) including copy / paste functionality using Ctrl + C and Ctrl + V.
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Right-clicking on any field within the table will expose additional options, including Copy, Paste, Hide Equal, and
MarkDifferent selections - all of which are self-explanatory and can be especially useful when editingmultiple
objects.
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Note that two views are available using theRotate Table option. As shown above, the view can be organized to
have attributes on the vertical axis. As shown below, the table can also display products on the vertical axis. Also
note that right-clicking within the header field exposes different options than within the data fields, including an
option to add a product.

SelectingAdd Product opens a Create Product dialog allowing the user to input data to create a new object,
which will be added as a child to the currently selected node. The options available in the dialog are based on the
datamodel defined in SystemSetup. For example, the object type selection will vary based on the allowable object
types under the selected parent, and ID will only be available for population if the object type being created does
not have autogenerated IDs applied.

Note that the same functionality is available using theAdd Product link at the bottom of the Sub Products editor.
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Publications
This section covers information specific to the publication objects in STEP that is important to know whenworking
with publications. For general object maintenance information (applicable to all object types rather than specific to
publication objects), see theAll Objects topic within this guide.

Before generating InDesign pages fromSTEP through any of theSTEP Publisher components—
STEP'n'design ('drag and drop'), STEP Flatplanner, STEP AutoPage, or STEP PublishingWebUI—it is
necessary to build out a publication hierarchy (green hierarchy) in the STEPWorkbench.

The topics in this section describe how tomanually create the necessary objects in the Tree that compose a
standard publication hierarchy. Instructions are also included for duplicating a publication and linking products,
assets, and classifications to nodes (publications and sections) in the publication hierarchy.

Before creating any of the objects detailed in this section, youmust first ensure that all relevant object types for the
publication hierarchy have been created in SystemSetup. Instructions on how to create and configure these
object types are detailed in theCreating a Standard Publication Object Type Hierarchy section of the
System Setup / Super User Guide documentation.

A publication hierarchy can also be built by importing a STEPXML or Publication Excel file. Details on thesemore
automatedmethods of creating a publication hierarchy are not included in this section of the Online Help. For more
information, see the following sections of theSTEP Publisher / STEP'n'design documentation:Exporting and
Importing Publications in STEPXML and Importing Publications in Excel
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Publication Hierarchy Elements
The following is a list of the publication hierarchy elements in STEP.

Element Icon Description

Publication
group

A publication group is a container for publications and templates (product, publication,
and page).

Publication A publication is a collection of the different versions and sections of your publication.

Commercial
data

The commercial data folder stores commercial data lists and is automatically generated
when a publication is created. For more information, see theCommercial Data section
of the STEP Online Help.

Commercial
list

Commercial data lists. The currency icon (top icon on the left) is typically used for price
lists, while the generic list icon (bottom icon on the left) can be used for any type of
commercial data values. For more information, see theCommercial Data section of the
STEP Online Help.

Version Publication versions hold different variants of the same publication. Each publication can
have one or more versions that specify a specific context, workspace, and one or more
commercial lists, if applicable.

Section and
subsection

A section is a container for subsections and DTP (InDesign) documents. Additionally,
products, assets, and/or classifications are linked into sections from the Tree to organize
content for the publication.

DTP
documents

DTP documents are InDesign pages that have been finalized and saved back to STEP.

DTP page A page within the DTP (InDesign) document
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Creating a Publication Group
Creating a publication group in the STEPWorkbench is the first step in creating a publication after all necessary
publication-related object types have been configured in SystemSetup. Publication groups not only serve as the
parent nodes of publications, but at least one publication groupmust exist before publication templates and
product templates can be saved back to STEP.

Note: Unless created by Excel or STEPXML import, publications cannot be created in STEP until at least one
publication template and one product template has been saved back to the workbench. For instructions on how to
configure and save these templates into STEP, see the Templates in STEP'n'design topic in the
STEP'n'design documentation.

Steps to Create a Publication Group
1. In the Tree, click on the top level of the publication hierarchy (green tree node). The standard ID of this root

node isPublication hierarchy root. If this root node does not exist on your system, contact Stibo Systems for
assistance.

2. Right-click and selectNew Publication Group.

3. In the Create Publication Group dialog box that displays, click the relevantObject Type, if applicable.
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Note: In order to choose an object type for your publication group, these object typesmust first be defined in
SystemSetup. For more information, seeCreating a Publication Group Object Type in theSystem
Setup / Super User Guide documentation.

4. Type an ID in the ID field if the STEP ID for your publication group object type has not been set to autogenerate
with an ID Pattern in SystemSetup. (The preceding screenshot shows an ID that has been created
automatically.)

5. In theName field, type a name for the publication group.
6. ClickCreate. The publication group is created.

A Note on Revisability
Publication Groups objects are globally revisable, meaning that they are the same in both theMain and Approved
workspaces. Each time a change ismade by a different user, a numbered revision is created and logged.
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Creating a Publication
Publications are created in the green publication hierarchy in the Tree by the same basic processwhether the
publication will be used for standard STEP'n'design publishing ('drag and drop'), AutoPage, or Flatplanner.

Unlike themore straightforwardmethod of creating objects in the Product or Classification hierarchies, all
publications require the linkage of two types of STEP'n'design templates: publication templates and product
templates. Flatplanner publications require three template types: publication templates, product templates, and
page templates. These templatesmust already be saved in STEP before a publication can be created.

Though publications can be imported in STEPXML or Publication Excel formats, it is recommended to create your
first publication in STEPmanually. Once created, this publication can be exported to produce a 'template'
spreadsheet that can be used for later publication imports.

Steps to Create a Publication Manually in the Workbench
1. In the Tree, open the top-level node of the publication hierarchy, then navigate to the publication group object

in which you would like to create your publication.

2. Right-click this publication group object and selectNew Publication.

3. A Create Publication dialog box displays.
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4. If the STEP ID for your publication object type has not been set to autogenerate with an ID Pattern in System
Setup, type an ID in the ID field. (The preceding screenshot shows an ID that has been created automatically.)

5. In theName field, type a name for the publication (a name is required for publications).
6. In theObject Type list, select a publication object type (only applicable if more than one publication object type

has been created in SystemSetup).

7. Only one choice of engine is available—InDesign engine.

8. Under theProduct Templates flipper, clickAdd template. A Select Product Template dialog appears.
Either search or browse for the product template(s) that you would like to use in your publication. To select
more than one template, hold the Ctrl or Shift keywhile making selections. ClickSelectwhen finished.
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9. (For Flatplanner publications only)Under thePage Templates flipper, clickAdd template. A Select Page
Template dialog appears. Either search or browse for the page template(s) that you would like to use in your
publication. To select more than one template, hold the Ctrl or Shift keywhile making selections. ClickSelect
when finished. (You can add page templates after creating the publication if the page templates are not already
in STEP.)

l A green checkmarkwill appear next to the first page template to indicate that it is the default page template for
the publication. To change the default template, click in the emptyDefault cell next to the page template that
you would like tomake default.
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10. In the Publication Template field, click the ellipsis button. A Select Publication Template dialog appears.
Either search or browse for the publication template that you would like to use in your publication. ClickSelect
when finished.

Note: Only one publication template is allowed per publication, as it is themaster reference for all page sizes,
paragraph styles, object styles, character styles, colors, and table rule settings in your publication.
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l If you need to change the publication template after you create the publication, you can do so by selecting
your publication in the tree, then clicking the ellipsis button (…) in the Publication template field on the
Publication tab.

11. ClickCreate. The publication will now be created together with aCommercial Data folder. The Commercial
Data folder is created by default with every publication object. Though it cannot be deleted, it will not negatively
impact the publication if it remains empty.
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12. Once the publication is created, the systemwill automatically route to theVersion tab.

13. Before proceeding further with publication creation, youmust create at least one publication version. For
instructions on creating a version, see thePublication Versions topic.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 258



Publication Versions
Once a publication object has been created, the next step in completing a publication is to create at least one
version. Publications need at least one version to define the context(s) and workspace(s) that will be used within
the publication. One reason to createmultiple versions is when there aremultiple languages being used within the
same publication. For example, if the publication will be published in five languages, then five versionswill be
created. Versionsmay also be created for different currency zones, vertical markets, or types of catalog.

Note: Publication sections cannot be created until at least one version has been defined.

Creating a Version
1. In the Tree, open the top-level node of the publication hierarchy, then navigate to the publication in which you

would like to create your version.

2. Select theVersion tab. TheVersion Description flipper displays.

3. ClickAdd version. A Create Version dialog box displays.

4. If the STEP ID for the 'Publication Version' object type has not been set to autogenerate with an ID Pattern,
type an ID in the ID field.

5. In theName field, type a name for the version.
6. From theContext dropdown list, select the context fromwhich the product data should be published.
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7. From theWorkspace dropdown list, select the workspace fromwhich the product data should be published.

8. ClickCreate to create the version.
9. Create the number of versions needed by repeating steps 1 - 9 or by duplicating the version you just created.

Note that the name, context, and workspace can be changed after creating a version.

Removing or Duplicating a Version
1. To remove a version, right-click on the version that you want to remove from the publication, then select

Remove version. The version will be removed.
2. To duplicate your version, right-click on the version that you want to duplicate, then selectDuplicate version.

The version will be duplicated.

Viewing Versions
All versions that have been created for the publication can be viewed in the Version dropdown list in the top right
corner of the workbench. This is used for reviewing the different contexts in the Flatplanner, for example.
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Creating a Section
After creating a publication object with at least one version, the next step in completing your publication is to create
at least one section. Sections are required for storingmounted (actual) InDesign pages in STEP aswell as
creating Flatplanner planned pages (spreads).

Steps to Create a Section
1. In the Tree, open the top-level node of the publication hierarchy, then navigate to the publication object in

which you would like to create your section.

2. Right-click this publication object and selectNew Publication Section.

3. In theNew Section dialog that displays, select the relevant sectionObject Type (only applicable if more than
one section object type has been created in SystemSetup).
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4. In the ID field, type the ID of the section (if not generated automatically).

5. In theSection Name field, type a name for your section. If no name is provided, STEP will automatically name
the section with the STEP ID of the section surrounded by parentheses, e.g., (123005).

6. If your system does not contain the STEP Flatplanner publishing component, no additional configuration steps
are required. ClickCreate to create the section.

TheDTP Documents node is automatically created along with sections. The DTP Documents node is used to
storemounted (actual) InDesign pages in STEP.

Additional Steps for Flatplanner Publications
For systems that contain the STEP Flatplanner publishing component, the fields within thePages section of the
New Section dialogmust be populated before the section can be created.

1. In the First pagenumber field, type the page number at which the planned pages in the section should begin.
(For new sections, the default page number is 1. For subsequent sections in the same publication, the page
number will pick up after the last page number in the previous section.)

2. In theNumber of pages field, type desired number of planned pages that should be created along with the
section.

3. In thePage Template dropdown, choose the page template that should be used for the planned pages in the
section. To create a section without any planned pages, enter '0' forNumber of pages. (Note that planned
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pages cannot be named at the time sections are created. If names are required, theymust be added after the
planned pages have been created.)

Note: It is also possible to add sections to a Flatplanner publication using the Publication Planner. For more
information about the Publication Planner, see Inserting Sections in A Publication in Publication
Planner in the Flatplanner documentation.

Create a New Section From Existing
Creating a new section from an existing section is a useful feature that can help reduce time spent onmanual tasks
such as:

l Reassigning of product templates on Flatplanner pages

l Remounting of attribute values on pages

l Re-saving of InDesign pages into STEP

Steps to Create a New Section From Existing
1. In the Tree, navigate to the publication or section where you would like to create the new section.

2. Right-click and selectCreate new Section from existing….
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3. In theCreate Section dialog that displays, click the ellipsis button (…) by the From Section field. (Or, type the
name or ID of the section into this field.)
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4. In theSelect Section to copy from dialog, browse to or search for the relevant section, then clickSelect.

5. Type an ID in the ID field if the STEP ID for your section object type has not been set to autogenerate with an
ID Pattern in SystemSetup. (The following screenshot shows an ID that has been created automatically.)

6. Type a name for the section in theName field.
7. Select Include linked elements to carry over the product and asset objects that are linked to the source

section.

8. To keep all mounted (actual) pages from the original section, select Include documents and actual pages.
(For Flatplanner publications, a duplicated section will still contain all planned pages even if this checkbox is not
selected.)

9. If Include documents and actual pages is selected, theUpdate all values checkbox is activated and the
Destination Version andSource Version options display.

10. Under Source Version, choose the relevant publication version (from the source section) from the dropdown
list(s). This will essentially 'map' the actual pages from the source section into the relevant destination version
in the destination section.
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11. CheckUpdate all values if you would like the actual (mounted) pages in the new section to be updated with all
changesmade to attribute values in STEP since the time that the original pagesweremounted.

Note: 'Update all values' will update all attributes from the original section. There is no way to choose a subset
of attribute values to update when duplicating a section.

12. The checkbox forObtain values from transformed tables, preserve local table styling and structure is
activated ifUpdate all values is selected. SelectObtain values from transformed tables, preserve local
table styling and structure if the following statements apply:

l Mounted tables exist on the actual pages of the original section

l Attribute valueswithin these tables have changed in STEP since the original section was created

l Youwould like to update the values contained in the table cells but do notwant to completely remount the
tables

Updated table cell valueswill be populated as they exist in the resolved table in STEP, i.e., the way the table
appears in STEP after all transformations have been applied.

Note: Any new transformations applied to tables since the original section was created will not be applied to
the updated tables in the new publication.

IfObtain values from transformed tables, preserve local table styling and structure is not selected, all
tables will be remounted in the new section. Remounting a table will update the tables with any changesmade
in STEP but will also cause the loss of anymanual table formatting that was applied to the tables in the original
section. Manual formatting includes changes such as the adjustment of columnwidths or addition of
background shading to cells.
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If the actual structure of a table itself has changed in STEP since the table wasmounted in the original section,
the table will be remounted in the new section regardless of whetherObtain values from transformed
tables, preserve local table styling and structure is checked or not. A basic example of a structural
change to a table is the addition or removal of a row or column.

Note: A configuration property can be set to allow values to update in tables—without remounting—even if
structural changes are present. For more information, see thePreventing the Remount of Structurally
Different Tables in Duplicated Publications section of theDuplicating a Publication topic.

13. In the Process description field, youmay enter a name for the background process that will run when
starting the duplication, though a name is not required.

14. ClickDuplicate. A 'Create Publication Section as copy of' background process starts and aStarting process
dialog box appears.

15. ClickGo to process to monitor the background process or clickClose to exit the dialog (the background
processwill still run).

16. Once the background process has finished, the new section can be found as a child object inside the
publication or section fromwhich the duplication processwas started.
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Organizing Publication Sections in the Workbench
Sections and subsections in publications can bemanually organized in the Tree through simple drag-and-drop
operations as long as the following object types are set toManually Sorted = Yes:

l Publication Group (typically, the object type with the STEP ID 'Publication group root')

l Publication (typically, the object type with the STEP ID 'Default publication type')

l Section (typically, the object type with the STEP ID 'Section')

Subsectionsmay be dragged and dropped out of their parent sections and promoted to higher-level subsections
or top-level sections. Likewise, sectionsmay be dragged and dropped into other sections, enabling the 'demotion'
of sections to subsections.

This functionality simplifies themaintenance of more complex publicationswheremultiple levels of organization
are needed.

The following screenshots shows a 'before' and 'after' example of sections and subsections rearranged in the Tree
through drag and drop. The 'before' image (left screenshot below) shows two top-level sections ('Safety' and
'Safety Equipment') with three subsections below the 'Safety Equipment' section. The 'after' image (right
screenshot below) shows an updated order, with 'Safety' as the parent section andmultiple levels of subsections
beneath.
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Note: Sectionsmay still be rearranged by drag and drop in the Tree ifManually Sorted is set toNo on
publication group, publication, and section objects, but the sectionswill automatically arrange themselves in
alphabetical order.

Templates (publication, product, and page) may also bemanually sorted in the Tree ifManually Sorted is set to
Yes on the publication group object type. See theSorting Templates in STEP section of the STEP'n'Design
documentation for more information.

For more information about object type sorting in STEP, see theManually Sorted section of theSystem Setup /
Super User Guide documentation.
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Duplicating a Publication
To simplify the creation of new publications that are similar to existing ones, duplicating a publication is a useful
feature that can help reduce time spent onmanual tasks such as:

l Remapping of import configurations for commercial data

l Reconfiguration of layer mappings

l Resaving of mounted (actual) pages into STEP

A common use case for needing to duplicate a publication is when a catalog is very similar from year to year. When
it is time to produce the latest catalog, the publication from the previous year can be duplicated.

Steps to Duplicate a Publication
1. In the Tree, open the top-level node of the publication hierarchy, then navigate to the publication that you would

like to duplicate.

2. Right-click and selectDuplicate. A 'Duplicate' dialog box appears.

3. In the ID field, type the ID of the publication (if not generated automatically).

4. In theName field, type a name for the publication.
5. To keep all mounted (actual) pages from the original publication, select Include documents and actual

pages. (For Flatplanner publications, a duplicated publication will still contain all planned pages even if this
checkbox is not selected.)
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Note: An InDesign server must be connected to your STEP system in order to duplicate actual pages into a
new publication. If you select Include documents and actual pages and your system is not connected to an
InDesign server, the publication duplication processwill fail. For more information on the deployment of an
InDesign server, contact Stibo Systems.

6. The checkbox forUpdate all values is activated if Include documents and actual pages is selected. Select
Update all values if you would like the actual (mounted) pages in the new publication to be updated with all
changesmade to attribute values in STEP since the time that the original pagesweremounted.

Note: 'Update all values' will update all attributes from the original publication. There is no way to choose a
subset of attribute values to update when duplicating a publication.

7. The checkbox forObtain values from transformed tables, preserve local table styling and structure is
activated ifUpdate all values is selected. SelectObtain values from transformed tables, preserve local
table styling and structure if the following statements apply:

l Mounted tables exist on the actual pages of the original publication

l Attribute valueswithin these tables have changed in STEP since the original publication was created

l Youwould like to update the values contained in the table cells but do notwant to completely remount the
tables

Updated table cell valueswill be populated as they exist in the resolved table in STEP, i.e., the way the table
appears in STEP after all transformations have been applied.

Note: Any new transformations applied to tables since the original publication was created will not be applied
to the updated tables in the new publication.

IfObtain values from transformed tables, preserve local table styling and structure is not selected, all
tables will be remounted in the new publication. Remounting a table will update the tables with any changes
made in STEP but will also cause the loss of anymanual table formatting that was applied to the tables in the
original publication. Manual formatting includes changes such as the adjustment of columnwidths or addition
of background shading to cells.

If the actual structure of a table itself has changed in STEP since the table wasmounted in the original
publication, the table will be remounted in the new publication regardless of whetherObtain values from
transformed tables, preserve local table styling and structure is checked or not. A basic example of a
structural change to a table is the addition or removal of a row or column.

Note: A configuration property can be set to allow values to update in tables—without remounting—even if
structural changes are present. See thePreventing the Remount of Structurally Different Tables in
Duplicated Publications section later in this topic for more information.

8. Select Include commercial information to duplicate the commercial lists and commercial data import
configuration(s) into the new publication.

9. Select Include linked elements to carry over the product and asset objects that are linked to the sections in
the original publication.
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10. In the Process description field, youmay enter a name for the background process that will run when
starting the duplication, though a name is not required.

11. ClickDuplicate. A Publication Duplication background process starts and aStarting process dialog box
appears.

12. ClickGo to process to monitor the background process or clickClose to exit the dialog (the background
processwill still run).

13. Once the background process has finished the new publication can be found in the Tree.

Create a New Publication from Existing
Another method of duplicating a publication in STEP is to create a new publication from an existing publication.
Thismethod is ideal if you do not want to locate the existing publication, duplicate it, then cut and paste or drag and
drop the duplicated publication from the 'old' location to the 'new' location.

1. Locate the publication group where you would like to create the new publication.

2. Right-click and selectCreate New Publication from existing one....
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3. Browse to or search for the publication that you would like to duplicate. ClickSelect.
4. The sameDuplicate dialog box as described in step 2 of the 'Steps to Duplicate a Publication' section of this

topic (above) displays.

5. Follow steps 3 - 11 as outlined in that section to create your new publication.

Preventing the Remount of Structurally Different Tables in Duplicated Publications
To prevent tables with structural differences from remounting in a duplicated publication, a config propertymay be
added to the sharedconfig.properties file on the STEP application server. This property is
InDesign.TableMissMatch.

l IfObtain values from transformed tables, preserve local table styling and structure is selected
during the publication duplication process and InDesign.TableMissMatch is set to = 1, then tables with
structural differenceswill not remount in the duplicated publication. Attribute values in the table will update
but the table structure will not change. Manual formatting from the original publication will also remain.
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l IfObtain values from transformed tables, preserve local table styling and structure is selected and
InDesign.TableMissMatch is set to = 2, tables with structural differenceswill remount andmanual
formatting will be lost.

l IfObtain values from transformed tables, preserve local table styling and structure is selected and
InDesign.TableMissMatch is set to = 3 (or any other value), tables with structural differenceswill be
skipped. Valueswill not be updated, nor will tables be remounted.

Considerations and Limitations
If the possibility exists that a large number of attribute values have been changed in STEP since the time that the
original publication was completed, it is not recommended to update all values during publication duplication by
selecting theUpdate all values checkbox. It is recommended instead to duplicate the publication with the original
values intact, then update the values on the duplicated pages afterward fromwithin InDesign.

The reasons for this recommendation are:

l Updating attribute values by clickingUpdate all values is an 'all or nothing' scenario. The data update
options under the STEPmenu in InDesign—includingUpdate Document Data andCheck DB Update—
allow greater flexibility in what should be updated, including the ability to update values from specific attribute
groups only.

l Updating data in InDesign also allows for values to be updated in text but not in tables. Updating values in
tables all at once during publication duplication can provide unpredictable results if there have been
structural changesmade to the tables since the creation of the original publication.
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Linking and Unlinking Publication Products,
Assets, and Classifications
Product, asset, and classification objectsmay be linked to publication sections in the publication hierarchy.
Product and asset objects (but not classifications) may also be linked to publications.

Linking products and assets to a publication at the top level can be a useful way tomake a 'collection' of objects
available for the entire publication. Linking products, assets, and classifications to publication sections is a useful
way to further organize these objects for DTP operators. This organization helps to eliminate guesswork for DTP
operators as they choose objects fromSTEP tomount ('drag and drop') onto pages in InDesign.

Linking these objects directly to publications and sections also eliminates the need to organize them in an alternate
classification hierarchy.

Linked products, assets, and classifications can be viewed directly beneath the applicable publication nodes in the
Tree (left screenshot below) aswell as from theSTEP Structure View palette in InDesign (right screenshot
below).
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Note: Reference types are not used to link products, assets, or classifications to publications. Due to this, any
product, asset, or classification object typemay be linked to any publication or section object type. In addition,
metadata cannot be placed on links between publications / sections and linked objects.

This topic outlines themanual steps involved in linking and unlinking products, assets, and classifications to and
from nodes in the publication hierarchy. For information onmore automated linkingmethods, refer to the following
two topics in theAutoPage documentation. (Though these topics are in the AutoPage documentation, the
methods are valid for any publication type.)

l STEPXML: Exporting and Importing AutoPage Publications in STEPXML
l Excel: Exporting and Importing AutoPage Publications in Publication Excel

Note: Linking objects to publication sections ismandatory for AutoPage publications, for which the AutoPage
Publication Planner can also be used to link objects. For more information, see theAutoPage Publication
Planner topic in theAutoPage documentation.

Steps to Link a Product to a Publication or Section
1. In the Tree, open the top-level node of the publication hierarchy, then navigate to the publication or section

object to which you would like to link your product(s).

2. Click on the relevant publication or section, then right-click and select Link product.

3. In theSelect Product dialog, browse or search for the product(s) that you would like to link to the publication
or section. Multiple productsmay be selected by holding the CTRL or Shift keywhile clicking.
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4. ClickSelect to link the selected product(s) to the publication or section.

Unlink a Product from a Publication or Section
1. In the publication hierarchy, navigate to the product that you would like to unlink from the publication or section.

2. Click the relevant product, then right-click and selectUnlink product.

Link an Asset to a Publication or Section
1. In the Tree, open the top-level node of the publication hierarchy, then navigate to the publication or section

object in which you would like to link your asset(s).

2. Click the relevant publication or section, then right-click and select Link asset.
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3. In theSelect Asset dialog, browse or search for the asset(s) that you would like to link to the publication or
section. Multiple assetsmay be selected by holding the CTRL or Shift keywhile clicking.

Assets will typically be selected from a location in the Classification hierarchy but they can also be chosen from
the Product hierarchy if they have been linked to the product by an asset reference.
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4. ClickSelect to link the selected asset(s) to the publication or section.

Unlink an Asset from a Publication or Section
1. In the publication hierarchy, navigate to the publication or section that contains the asset you would like to

unlink.

2. Click the relevant asset, then right-click and selectUnlink asset.
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Link a Product to a Publication or Section from the Product
References Tab
Productsmay also be linked to publications and sections from the productReferences tab. (This option is not
available for assets or classifications.)

1. Navigate to the Product object that you would like to link to the publication or section and click on the
References tab.

2. Expand thePublications flipper and clickLink to Publication or Section.

3. In theSelect Publication or Section dialog, browse to or search for the publication or section into which you
would like to link your product.

4. ClickSelect. The product is now linked to the selected publication / section.
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Unlink a Product from a Publication or Section from the Product
References Tab
1. Navigate to theReferences tab of the Product that you would like to unlink from the publication or section.

2. Expand thePublications flipper and click the arrow to the left of the row that contains the publication / section
fromwhich you would like to unlink.

3. SelectUnlink from Publication or Section.

Link a Classification to a Publication Section
To link aClassification folder to a publication section, simply drag and drop the Classification folder from its
location in the Tree into the relevant section folder.

Note: There is no right-click option available on sections for linking Classifications. Also note that Classifications
cannot be linked to publications at the publication level.

Unlink a Classification from a Publication Section
1. In the publication hierarchy, navigate to the section that contains the classification you would like to unlink.

2. Click the relevant classification, then right-click and selectUnlink classification.
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Recycle Bin for Tree
This topic describes the functionality available for objects within the Tree Recycle Bin. For information on the
SystemSetup Recycle Bin, see theRecycle Bin for System Setup topic in theSystem Setup / Super User
Guide. For information on deleting objects from Tree, see the Deleting Objects in Tree topic within thisGetting
Started / User Guide.

When objects are deleted from the Tree, they aremoved to the Recycle Bin located on the Tree tab. From the
Recycle Bin, objects can be revived or permanently deleted.

Note: Objects in the Recycle Bin are not searched when users perform searches in workbench andWebUI. This
limitation also applies to searches done using the workbenchGoto functionality. Additionally, attribute values of
objects in the Recycle Bin cannot be edited. If editing is required, the object needs to be revived.

When right-clicking on any object in the Recycle Bin, several options are available related to removing or reviving
objects in STEP. Each option is described below.

l Purge: Permanently deletes the object, with no subsequent option for revival. It is recommended to approve
deletions prior to purging them, though it is not required. However, purging an object without first approving the
deletion will NOT result in a deletion event being captured. Therefore, if deletion events need to be recorded for
sending to downstream systems, the deletion should always be approved prior to the purge action being
carried out. For more information on events, seeEvents in theSystem Setup / Super User Guide guide.

l Approve Deletion:Deletes the selected object from the Approved workspace, and passes a deletion event
for that object. This option is only enabled on objects that are workspace revisable.

l Approve Deletion Recursively:Deletes the selected object and all of its children from the Approved
workspace, and passes a deletion event for all impacted objects. This option is only enabled on objects that are
workspace revisable.

l Revive:Revives the selected object, returning it to the location in Tree fromwhich it was deleted. Note that
object revival has some dependencies and objectsmay not always be revived exactly as theywere prior to
deletion. For example, if an object had references to other objects which have subsequently been deleted,
those referenceswill not be present upon revival.
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l Revive Recursively:Revives the selected object and all child objects to their previous location in Tree. Note
that object revival has some dependencies and objectsmay not always be revived exactly as theywere prior to
deletion. For example, if an object had references to other objects which have subsequently been deleted,
those referenceswill not be present upon revival.
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Navigation and Searches 
This section describes themany different ways you can access specific data in the workbench. The STEP
Workbench offers rich functionality for finding both SystemSetup and Tree objects based on various criteria.
Whether it be by standard navigation, Bookmarks, searches using basic, advanced, or drill-down functionality,
STEP providesmanyways to locate the required data.

This section will allow users to:

l Navigate hierarchies

l Find data quickly using theGoto function
l Find data using basic and advanced searches

l Perform drill-down searches using theSearch Result Profiling page
l Use standard andSearch Bookmarks

Note: Objects within the Recycle Bin are not searched and will not display in search results.

For information on search functionality in theWebUI, see theHomepage Widgets topic and theAdvanced
Search topic in theWebUser Interfaces documentation.
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Basic Navigation
You can navigate the STEP tree structures in the samemanner as you navigateWindows folder structures.

Expanding a Folder
l Click the plus sign (+) to the left of a folder

l or double-click on collapsed folder

Collapsing a Folder
l Click theminus sign (-) to the left of a folder

l or double-click on expanded folder

Collapse Tree
When the folders in the tree hierarchy are expanded, it can be collapsed by using the 'Collapse Tree' option from
the 'View' menu.
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Note: Folders with an (x) sign cannot be expanded in the hierarchy, because they contain toomany subnodes. To
reach objects beneath such folders, the search orGoto functionalitymust be used.

To know more about the Goto fuctionality, see theUsing Goto topic in theGetting Starting documentation.

The remaining navigationmethods are standard techniques similar to those just described. These basic desktop
computer skills are prerequisites for all users of the STEP system.

Navigation and expanding folders and sub folders can be done in any tab. However, when in theWorkflow tab,
you will find flippers which need to be clicked on to find the processes.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 286



Using Goto
TheGoto functionality allows the user to locate an object in STEP in a quick and efficient manner. There are two
'Goto' features that a user could use:

l Goto: A quick way to jump to a particular object in the database based on the name and/or ID. If there are
multiple hits, it will jump to the first one it finds. Pressing 'Ctrl+G' will take the user to the Goto field.

l Goto Next: When there aremultiple hits from the 'Goto' function, the user can opt to select Goto Next to
continue on to the next hit. Pressing 'Ctrl+E' will take the user tot he Goto Next field.

You simply type in theName or ID of an object in theGoto field, press Enter or click theGoto next object button
to the right of the field, and the systemwill take you to the object without displaying a list of search results.

Once you start typing in theGoto field, the systemwill suggest objectsmatching the typed-in text (case insensitive)
and display them on a dropdownmenu as shown below.

When typing in the 'GoTo' field all objects are searched not just products. This includes but is not limited to
classifications, assets, attributes, user names, etc.

It is important to keep inmind that:

l Object IDs and Names are both searched.

l Object IDs are searched case-sensitive.

l Object Names are searched case-insensitive.

l Wild Cards are not allowed

Items can be selected from themenu using either themouse or the keyboard ARROWUP / DOWN keys. A
maximumof 20 itemswill be displayed.

Another way to find the Goto andGoto Next options are fromNavigateMenu.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 287



Keys in the Goto function dropdown
The ID/Name dropdown list in Goto function will have any created keys as part of the dropdown list.

Note: Only activiated keys can be seen in the Goto function’s dropdown list. See the Creating and Deleting Keys
topic in the Data Quality documentation.

Selecting a key from this dropdown list can be are used to identify and delete objects, parents, referenced objects,
and assets. The systemwill take the user to the product that has the unique key value stored on that product.

Setting the Primary Hierarchy for 'Goto' searches
A user can set the Primary Hierarchy to be either a Primary Product Hierarchy, Classification folder, Asset Folder,
etc, through the View -> Primary HierarchyMenu. Once the primary hierarchy is selected and a Product is
searched, then the first priority will be given to the folder that is selected and then the search will happen in the next
folders.
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For example, if the View > Primary Hierarchy is set to Assets, the product will first be searched under Assets.
Then when clicked on Search again, the user will be shown in the actual hierarchywhere the product was initially
created. In normal circumstances, the product will by default be searched in the actual hierarchywhere it was
initially created.

Important: Objects within the Recycle Bin are not searched as part of the Goto functionality.
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Bookmarks
Bookmarks in STEP are placeholders created by the user that serves as a shortcut for previously viewedObjects.

In the STEP system, there are two different types ofBookmarks:

1. Standard NavigationBookmarks
2. Search Bookmarks.

Note: Bookmarks are stored on the local STEP system and are not accessible when logging into STEP from a
different computer.

Standard Navigation Bookmarks
Standard navigationBookmarks are used for quickly accessing specific nodes in the Tree andSystem Setup
hierarchies.

You can add a standard navigationBookmark by selecting a node in the hierarchy and clickingAdd Bookmark
in theNavigate: Bookmarksmenu or alternately by using the Ctrl+D keyboard shortcut. TheBookmarkwill
afterwards be accessible in the left sideBookmarks tab.

Search Bookmarks
Search Bookmarks are used for storing specific searches that can then easily be re-run.

Steps to add a Search Bookmark:

1. Create a search criteria in the Search tab.

2. Go to Navigate > Bookmarks

3. Select 'Add Search Bookmark'
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4. A dialog will be displayed to type in the BookmarkName.

5. Click onOK button.

Accessing the Saved Search Bookmark
When you click on a stored Search Bookmark, the search parameters will be populated. Select Search to rerun
the search.

Note:
Search Bookmarks are saved under the Bookmarks tab with a search icon labelled with the bookmark name
provided by the user.
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Saved Bookmarks can also be found in the under the Navigate > Bookmarks.

Editing a Bookmark
Both standard navigation andSearch Bookmarks can be edited in theBookmarks tab by right-clicking the
Bookmark and selectingEdit Bookmark in the context menu. It is possible to edit theName of theBookmark
and also the object / search URL if theEdit URL checkbox is activated.

Removing a Bookmark
Both standard navigation andSearch Bookmarks can be removed from theBookmarks tab by right-clicking the
Bookmark in the tab and selectingRemove Bookmark on the context menu.
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Search Overview
TheSearch tab in combination with theSearch Result Profiling page offers extensivemethods for locating
objects in STEP quickly and efficiently.

Generally there are two approaches to performing searches:

1. If you know specific details about the object you wish to find, using theSearch tab you can find, for example, all
Productswhere the value for the attributeWeight is less than '5 kg', the object is located below the Product
Folder 'Office Chairs' and is not of theObject Type 'Item'.

2. If you do not know the details, you can start with a broad search and then narrow it down using theSearch
Result Profiling.

Note: Objects within the Recycle Bin are not searched and will not display in search results.
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Search Elements

1. Search Criteria Type Selector - Click the text / triangle icon to display a list of available search criteria options.
SeeBasic Search Criteria and Functionalitywithin theSearch Overview documentation for more
information.

2. Add Criteria / Operator Button - Click the button to add a new Standard Search Criteria. The type can be
changed for each search criteria. If you hold down themouse button, you can choose anOR operator or an
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Exclude operator. SeeBasic Search Criteria and Functionalitywithin theSearch Overview
documentation for more information.

3. Remove Search Criteria Button - Clears the criteria from the search. Click the Search button to refresh the
Results Area.

4. Reset Button - Clears all results and search criteria from theSearch tab andSearch Result Profiling page.
5. Search Button - Runs the defined search.

6. Search Result Counts - The number of items currently displayed and total number of items found by the
search. If the search finds objects not visible in the current Context or objects that you are not privileged to see,
amessage is displayed and the objects are not displayed in the search result.

7. Show Details / Hide Details Toggle - Hyperlink shows or hides search result details. The details view displays
asset thumbnails. If the search is under a classification folder and if there are assets, only then will the asset
thumbnail be displayed and similarly, if the search is for the products and if the product is linked with an asset
then the thumbnail will be displayed. If not then the thumbnail will be displayed as 'No Primary Image.'

8. Search Results List - When a search has been executed, the result is shown in a list below the search box.
Clicking one of the results will open the object editor for that particular object in the Search Results Profiling
pane while continuing to display the Search Results list. It is also possible tomakemulti-selections from this
list.. A maximumof 100 results are displayed in this area. The complete result set can be viewed, exported or
updated using theOperations on Entire Result options.

9. Save asCollection Button - Click to open theSave as Collection dialog which allows you save the entire
result set as aCollection. Collections are available on the Tree tab. SeeSearch Operationswithin the
Search Overview documentation for more information.

Note: Themaximum results displayed can be adjusted via the configuration property
'DrillDownSearch.Maxresults.' However, it is not advisable to adjust the number more than 100+ as this will hit the
system performance as the number increases.

There are only 3 operations that are abailable on the Entire Result: Export Button, Bulk Update Button, and Searcj
Result Profiling Page.

10. Export Button - Click to open theExport Manager wizard which allows you to export the entire result set to a
specified file type. SeeSearch Operationswithin theSearch Overview documentation for more information.

11. Bulk Update Button - Click to open theBulk Updatewizard which allows you tomodify a variety of elements
on each item in the entire result set. SeeSearch Operationswithin theSearch Overview documentation for
more information.

12. Search Result Profiling Page - Page displays profiling information about the search including categories and
provides a convenient way to further refine the search. See theSearch Result Profiling Page section within
theSearch Overview documentation for more information.

Search Dropdown Options
When performing a search on the Search tab, there are a number of options that a user can select from the
dropdownmenu to start their search. These search options are described in greater detail in the topics that follow.
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l Object Type

l Search Below

l Referenced Assets

l RevisedObjects Changed Since

l Data Containers

l Search from List

l JavaScript Search

l MissingMandatory Values

l Unapproved

l Product Override Search

l Search in Publication Hierarchy

l Referenced

l Referenced By

l STEPWorkflows

l Sample Results
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l Translation Status. See theSearching for Translation Status topic in the Translation documentation.
l Unpushed or Failed Assets

© Stibo Systems - Confidential - STEP Trailblazer 8.3 297



Search Result Profiling Page
TheSearch Result Profiling page appears when you have run your search. The page displays statistics about
the search grouped under the headersResults by Object Type,Results by Position in Tree Hierarchy and
Results by Value.Apart from giving you information about the results of your search, you can use the page to
further refine your search. Thus, if you start by running a broad search, you can refine it by clicking the links
'Exclude' in the profile - thereby adding additional criteria to your search. See the example below:

When exclude option is clicked, an additional search criteria called 'Add Exclude' is added as shown below:
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For all types of searches, theSearch Result Profiling page will display the results sorted byObject Type. The
screenshot above shows theResults by Object Type. The search result includes 78Products of theObject
Type "Product", 8Assets (where 7 are of theObject Type "TIFF Image" and 1 is of theObject Type "JPG
Image") and finally 1Attribute.

If you click TIFF Image, an Object Type Search Criteria is added to the search. The search runs again, finding
only objects with theObject Type "TIFF Image".

If you click exclude next to TIFF Image, anObject Type Search Criteria is added to the search, but this time as
anExclude Criteria. Hence, all objects of theObject Type "TIFF Image" will be excluded from the search result.
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Basic Search Criteria and Functionality
This section describes the different types of search criteria available in the STEP system aswell as some basic
search functions.

The Standard Search Criteria
The standard search criteria named 'Search' allows you to find objects in STEP based onName, ID,Attributes
and their values.

A text string entered in the search field will make STEP search for object Names, IDs, or Attribute valueswhere
the text occurs.

If you simply enter a text string and click theSearch button, the search will find objects with an ID, and / or aName
and / orAttribute and / or their valuesmatching the entered string. Below you can see how you can further refine
your standard searches.

Note: By default, standard searches are case insensitive forName andAttribute value searches and case
sensitive for ID searches. You canmakeName andAttribute value searches case sensitive using the
Advanced option "Match Case on Names and Values". For more information on the options available under
advanced, see theAdvanced Options topic in theSearch Overview documentation.

Search Field Typeahead
Once you start typing in the standard search criteria text field, the systemwill suggest possible entriesmatching
the typed in text (case insensitive) and display them on a drop-downmenu as shown below.
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In the typeaheadmenu, objects are displayed with their relevant icon, thenName and ID in brackets, whereas
Attribute values are shown as text.

Items can be selected from themenu using either themouse or the keyboard ARROWUP/DOWN keys. A
maximumof 100 itemswill be displayed.

Note: Using system properties it is possible for a system administrator to control the behavior of the typeahead.
E.g. after how many entered characters should suggestions be shown etc.

Limiting Result to Matches on ID's
You can limit standard searches tomatch on ID only by entering "ID = " at the beginning of the text field as shown
below.

Note: "id" and "Id" will work aswell and spaces on each side of the equals sign are optional.

Limiting Results to Matches on Name
You can limit standard searches tomatch only onName by entering "Name = " at the beginning of the text field as
shown below.

Note: E.g. "name" and "NAME" will work aswell and spaces on each side of the equals sign are optional.

Attribute Value Searches
Using a standard search, you can limit the result to onlymatch on values for specificAttributes.
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There are at least three ways to construct anAttribute search query:

1. Start entering an AttributeName or ID, then select the relevant Attribute from the typeaheadmenu, after which
"Attribute Name (Attribute ID)" is inserted in the text field, then enter a search operator or enter a SPACE and
select an operator from the typeaheadmenu and enter the value to search for.

2. Enter the Attribute ID (case sensitive), enter a search operator or enter a SPACE and select an operator from
the typeaheadmenu, then enter the value to search for.

3. Enter the AttributeName (case insensitive), enter a search operator or enter a SPACE and select an operator
from the typeaheadmenu, then enter the value to search for.

Note: As shown on the screenshot above, if you have the required privileges you will get typeahead suggestions
on existing values after having specified a search operator.
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Attribute Value Search Operators
There are 7 operators that can be used when performingAttribute value andReference Metadata Attribute
value searches.

< - Less than operator. Only works for number validatedAttributes (Validation Base Type = number, integer or
fraction)

<= - Less than or equal to operator. Only works for number validatedAttributes (Validation Base Type = number,
integer or fraction)

= - Equal to operator.

> - Greater than operator. Only works for number validatedAttributes (Validation Base Type = number, integer
or fraction)

>= - Greater than or equal to operator. Only works for number validatedAttributes (Validation Base Type =
number, integer or fraction)

! - Operator used for finding objects where the specifiedAttribute does not have values in currentContext. Note
that the search does not checkwhether theAttribute is valid for a given object. Also, if the specified attribute has
an inherited value (not a local value), then the object will be listed in the results set even though the value field is
not empty.

!! - Operator used for finding objects where the specifiedAttribute does not have local values in anyContext.
Note that the search does not checkwhether theAttribute is valid for a given object. Also, if the specified attribute
has an inherited value (not a local value), then the object will be listed in the results set even though the value field
is not empty.

Using Wildcards in Searches
In searches you can use two different wildcards for performing searches on partial text strings. The wildcards are
asterisk (*) and questionmark (?).

The difference between the two is that while the asterisk (*) represents any number of characters in a string, the
questionmark represents exactly one character.

The wildcards '?' (single character) and '*' (multiple characters) can be used anywhere in the text string.

Note: Searches starting with a wildcard as shown above will be significantly slower than other searches and
generally should be avoided.

ISODATE Searches
If a user has an attribute with the validation type of ISODATE, where the date populated in the field is in the YYYY-
MM-DD format, a user can search the populated attribute on objects using the following keywords in the Search
tab: now, today, tomorrow, yesterday.
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While it does not matter if the ISODATE is set to 'Strict Validation' or not, it doesmatter that the date is written in
the YYYY-MM-DD format. Any other format, including using slashes ' / ' instead of dashes '-' will not work since
searcheswork bymatching only values conforming to the ISO standard (with dashes). For this reason, it is
recommended that 'Strict Validation' be set to Yes. Otherwise, the stored values are not guaranteed to be
searchable.

In the example below, a user used this in a search to look for an object that has a particular date. In the case below,
the user typed in the name of the date attribute 'ISODate', and then used an 'attribute value search operation'
followed by the keywork of "tomorrow". They then narrowed their search even further to just under one particular
node, giving them the desired results.

Combining Search Criteria
You can combine different search criteria to create advanced searches. Except for caseswhere one or moreOR
operators are used, the sequence of the criteria does not matter.

Thus, the search shown below:
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...will generate the same results as:

When not usingOR Operators or Exclude Search Criteria in the search, all criteria will be combined with an
implicit AND operator.

By clicking the button with the green plus icon, a query can be constructed that combines several criteria. The
criteria will by default be "AND’ed"meaning that all criteria will bemet for the found results.

As an example, the search shown below will find objects that have the value 'Black' for the 'Color' Attribute AND
are present below an 'Audio Visual Equipment' hierarchy node. The order of criteria does not have significance.
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As for how to construct your search usingExclude Search Criteria andOR Operators, please see below.

Using Exclude Search Criteria
It is possible to negate all the different types of search criteria using theExclude Search Criteria functionality.

You can addExclude Search Criteria to your search either by clicking theAdd Criteria/Operator button,
holding themouse button down and selectingAdd Exclude from themenu, or by clicking an "exclude" link on the
Search Result Profiling page.

Exclude Search Criteria appear with a redminus icon on the left side of the criteria panel as shown below.

As long as noOR Operators are used, it does not matter where in the sequence of criteriaExclude Search
Criteria are placed.

Taking the example depicted above, the search will find objects where all the "positive" criteria aremet minus
objects where theAttribute "Color" is "Gray".

Note: You can use asmanyExclude Search Criteria in your search as you wish to.

Note: As theExclude Criteria are subtracted from the "positive" search result, a search containing only an
Exclude Search Criteriawithout an Include criteria as point of departure will not generate any results.
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Using the OR Operator
You can add anOR Operator to your search by clicking theAdd Criteria/Operator button, holding the left-
mouse button down and selectingAdd Or from themenu.

OR separators can be inserted between criteria via the add criterion button as shown below.

When usingOR Operators your search will be divided in to completely separate parts containing one or more
criteria. Each part is in effect executed separately and the results then added before presenting the final result.

As it is not possible to work with parenthesis, when working with ORs it is often necessary to configure the same
criterion on both sides of anOR separator like shown below.

As an example, the search shown below will return all objects where theName starts with the text 'Hat123' and
theColor is 'Black' plus all objects where theName starts with the text 'Hat123' and theColor is 'Gray.'
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Advanced Options
Additional options for narrowing a search can be accessed under theAdvanced flipper in Simple Search.

There are 4 Advanced SearchOptions as shown below:

1. Match Case on Names and Values

2. Include Inherited Values

3. Exclude Values

4. Regular Expression

Advanced Search Options
1. Match Case on Names and Values - When selected,Name andAttribute value searches are not case

sensitive.

For example, this is a basic search with search criteria of 'Search = T-Shirt.'
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The search results are displayed with all the objects in STEPthat match the search criteria, in this case 'T-shirt.'

STEP objects in the search result includes:

l Classification / Asset / Product / Entity objects

l Special Types objects

l SystemSetup Tab objects

Now, on the search, select the Advanced option 'Match Case on Names and Values.'
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With this option selected, the search result will only include attribute values and all the object names in STEP
that match the search criteria in the correct case. Since the previous search results were all a different case,
this search will return no results.

Note: ID searches are always case sensitive.

2. Include Inherited Values
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When selected, attribute value search results will show objects where thematch includes inherited values as
well as objects where thematch includes locally defined values.

Note:
Attribute valueswith hierarchical inheritance (valueswith green triangle) will only be included in the search result
when Include Inherited Values option is selected.

Dimension dependent Attributes – Specification or Description attribute values inheriting from other contexts
(valueswith a red triangle) will also be displayed in the search result even when the user does not select the
option Include Inherited values.

3. Exclude Values

When selected, attribute values are not searched for the entered search term. If unchecked, attribute values
are searched for the entered term and objects with the search term populated as an attribute value are
included in the search results.

The Exclude values in advanced search are useful for neglecting objects which are having search content as a
value in it.

For example, assume there are attributeswhich has value 'Red' in few objects and there are objects which has
Object Name/ID as 'Red.'

If a normal search is performed, the results for 'Red' are shown below.
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If the same search is performed but with 'Exclude Values' selected under Advanced, only attribute IDs and
Namesmatching the search are turned.
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4. Regular Expression

When selected, attribute values are searched using the regular expression entered in the Search text box.
Although establishing an attribute with Validation Base Type of Regular Expression allowsmore than 2000
characters (for example, [A-Z]{1,3000}), searching via a Regular Expression only returns results for matches
within the first 2000 characters. For more information, see theRegular Expression topic inSystem Setup /
Super User Guide documentation.

5. Include Data Containers

Include in search results any search terms contained inside data containers.
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Object Type
With theObject Type search criteria you can limit your search result to items of a specificObject Type. These
objects aremaintained through the STEP Workbench, on the SystemSetup tab, and under the Object Types
& Structures folder. Simply start typing in the field or drill down through the hierarchy tomake a node selection.

1. Click on theSearch tab. Where the default option for the dropdown operation is searchSearch, click on this
dropdown bar and selectObject Type.

2. A new dropdown bar will appear with a number of options to select from (optionswill vary depending on client
search needs).
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3. For the purpose of this example,Productswill be used for the search. Hover over the small right triangle next
to the object type to choose the particular objects of selected object type.

4. When selecting 'Other,' the Object Type selection dialog will appear.
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5. Browse / Select the object type from the object type list. Click on 'Select' to confirm.

6. With the search field established, click on the green + symbol to define what product object type to be
searched.

7. You will notice that a new search field appears and the wordsObject Type = Product remain at the top as
part of the search criteria. Type in the criteria that you wish to be searched, and click theSearch button on the
lower right hand side. (For this case, it is all products that aremade by ACME).

8. Results are listed on the left side, and on the right side a Search Result Profile will populate.
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9. If this is still not as refined as needed, keep adding search boxes by pressing the green + symbol and
typing in further information.

System Setup Objects Types
Attribute / List of Values / Unit are under system setup object types category and there are NOsub selections to
search for (as seen for other object typeswith small right triangle).
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l Selecting these object typeswill directly list all the Attributes / List of Values / Units from the STEPWorkbench.

l User can always refine these searches again by keep adding search boxes by pressing the green + symbol

and typing in further information.

Publication
Similar to product object types, you can also search the specific Publication Group, Publication, and the
Publication Section using their object types.

Entity
Similar to product and publication object typeswe can also search the specific Entities using their object types.
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Special Types
There is an option Special Types – which includes Table Type, BusinessRule, Business Library, Business
Condition, and Business Action which can be searched.
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Search Below
TheSearch BelowSearch Criteria allows you to limit your search result to objects below a specified node in the
System Setup or Tree tab hierarchy.

Note: The search below option can be applied to the following object types only: attribute, classification,
collection, entity, product, and publication.

1. Select theSearch tab and click on it. From the Search dropdown you will see a small dropdown bar that
defaults toSearch.

2. In theSearch Criteria Type Selector selectSearch Below.
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3. Click the ... button (ellipsis) to display theObject Selector Dialog. By default the Primary Product Hierarchy
will be selected as search criteria.

4. Select a node in the hierarchy and click theSelect button.
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5. Click theSearch button

6. The Results displayed includes only items at or below the selected node. Additionally, the selected node for the
search below criteria will also be included in the search results. In the example shown below, Hats and Caps
Items is also included in the search result
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Referenced Assets
TheReferenced Assets search criteria is used for finding product objects which has referenced assets to the
specified product.

By default all local referenced assets for the specified product are displayed.

Steps to setup Referenced Assets search criteria are below:

1. Click on the side Search tab. You will see a small dropdown bar that defaults to Search. Click on the dropdown
bar and selectReferenced Assets.

2. Specify a Product Name in the input field by either tying in the actual product name or the product ID. By
running a basic search, it will return results of all referenced assets of the product specified.
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Note: I the product ID and name are the same,or if the product name has numbers as part of its name, the search
result will still display all the local referenced assets of the Product specified.

Checkbox Options for Referenced Assets Search
When performing a search there are two search search checkbox options that a user can select:

l Include Inherited Values- This option is used when the inheriting referenced assets on the specified product
are to be included in the search result.

l Match Case on Names- This ensures that the specified product name is searchedmatching the case (case
sensitive) and all local referenced assets are displayed as search result.
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Revised Objects Changed Since
With theRevised Objects Changed Since search criteria you can find recently edited objects in the
STEP workbench. To narrow your search, enter an exact date/time to determine how old the changes can be, or
you can simply use intervals of days, hours, or minutes.

1. Click on theSearch tab. In the this tab, on the dropdown bar, selectRevised Objects Changed Since.

2. A new dropdown bar will appear with the following four search criteria options:

l Date

l Interval of Days

l Interval of Hours

l Intervals of Minutes

For the purpose of this example, 'Date' will be used for the 'RevisedObjects Changed Since' search field. The
Date option will provide a data picker, allowing for the selection of the data and time.

3. Click on the [...] and determine the date / time of the oldest objects you wish to search. ClickOK.
4. Click the green plus sign to add additional search criteria. (Optional)

5. Click onSearch to run the search and view results.
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l Interval in days – Specify the number value in the field.

The search result will be displayed as shown below with objects which are revised since last 3 days.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 328



l Interval in hours –Specify the number value in the field.

The search result will be displayed as shown below with objects which are revised since last 60 hours.
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l Interval in minutes – Specify the number value in the field.

The search result will be displayed as shown below with objects which are revised since last 30minutes.
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Note:
l Only number value will be accepted as input for the options - Interval in days, Interval in hours,
Interval in minutes even though if Days/day or hour/Hours/H or minutes/Min/M is suffixed along with
number, the number value is considered.

l RevisedObjects Changed Since criteria can be combined with any other search criteria.

l If this is still not as refined as needed, keep adding search boxes by pressing the green + symbol

and typing in further information.
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Searching Data Containers
TheData Containers Search Criterion allows users to limit search results to only those entities for which data
containers exist for specific data container types, or those entities for which specific attributes are linked via data
containers.

To initiate a search of entities with information contained within data containers, users should follow these steps.

1. Click theSearch tab, and then open the Search dropdown.

2. In theSearch Criteria Type Selector, select the 'Data Containers' search criterion.

3. When the 'Data Containers' criterion is selected, two fields display below it. Data Container Type and an
additional text input field. If a user clicks 'Search' without either of these fields populated, the search will return
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a list of all entities for which any data container of any data container type has been added.

4. Clicking the button beside the Data Container Type field will open a window in which the user may either
Search or Browse for any data container types that have been created on the system. Selecting a data
container type will limit search results to only those entities for which a data container has been added for that
specific data container type. Select the relevant data container type and clickSelect.

5. To initiate a search for all entities for which the selected data container is added to, clickSearch. The search
will return a list of entities for which that data container has been added, even if there is no content (no attribute
values entered) in the data container.
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In the example below, a user has elected to search for a data container type called 'Shipping Address' without
refining the search any further. If the user selects 'Shipping Address' as the Data Container Type and clicks
Search, a list of entities for which a data container has been added to an entity under the data container type
'Shipping Address' will display. In this instance, four entities are listed.

6. To further narrow the search, usersmay enter additional search terms in the text input field. When a user starts
typing the attribute used in the selected ‘Data Container’, a type ahead result will be displayed and the attribute
will be selected. Once selected the available operators =, <, >, <=, >=, !, !! will be displayed. If the selected
attribute has a value in the ‘Data Container’ tab of an entity or on the entity itself then those valueswill show up
as a dropdown. However, the search result will be displayed only for the attribute value which is present for the
attribute in the Data Container tab.

For example, the entity with the ID 'CUS_107835' has an attribute 'Country Code' with the value of
'ARGENTIAN' in the Contact tab, but with the value of 'BAHAMAS' on the Data Containers tab.
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When a search is performed on the ‘Data Containers’ and the attribute 'Country Code' is selected, it will display
all the values. And the search result will only display the entity ‘Custpmer B’ only if the value is ‘BAHAMAS.’
The search result will return ‘0’ if the value selected is ‘ARGENTINA’
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7. Additional search terms in the text input fields can be entered. To continue the example, if the user wanted to
refine the search for entities with a 'Country Code' data container type to only include those data containers
containing the value 'BAHAMAS', the user would enter 'BAHAMAS' in the input field. In this example, results
returned from the search show two of the original four entities. Thismeans that a 'Shipping Address' data
container has been added to these two entities, and an attribute within those data containers also contains the
value 'BAHAMAS'.

8. Under the Advanced flipper, additional options are available for refining the search:

l The 'Instance count' parameter allows you to specify a number of data container instances an entitymust
have.

l Checking the 'Match Case on names and Values' parameter makes the search case sensitive.
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l The 'Regular Expression' parameter allows you to search using regular expressions. For more information
on regular expression, see theRegular Expression topic inSystem Setup / Super User Guide
documentation.

Searches involving data containersmay also be initiated in a different way.

The standard search criterion (named 'Search') features additional options to further refine a search under an
'Advanced' flipper. One of these is called 'Data Containers'. When checked, this refinement enables data
containers to be searched for values and include the applicable entities in the search results.

Let us say a user wanted to search for all instances of the value 'BAHAMAS' occurring in the system. By checking
'Data Containers' under the advanced flipper and adding 'BAHAMAS' into the text input field, the search results
will list not only the Customer A and Customer B entities where 'BAHAMAS' occurs inside a data container, but
also instances of 'BAHAMAS' that appear outside of data containers.
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For more information on data containers and the terminology used in this topic, reference the SystemSetup guide
and see theSetting Up Data Containers in Workbench documentation. For more information on adding and
maintaining data containers, also reference the SystemSetup guide and see theAdding and Maintaining Data
Containers documentation.
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Document Content
With theDocument Content search criteria you can search for a specified word / text string in text documents
stored as Assets in STEP.

1. Navigate to the sideSearch tab and click on it. A small dropdown bar will appear. Click on the dropdown bar
and selectDocument Content.

Important: A prerequisite to searching in documents is that they are indexed. Document Content displays as a
search option only in systems that have full text indexable functionality enabled and are not running In-Memory.

2. Enter the word / text string into the text field that appears.

3. Click the green plus sign to add additional search criteria. (Optional)

4. Click on 'Search' to run the search and view results.
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Search from List
With theSearch from List search criteria you can search using a list of data. This data can bemanually entered
into the user field or pasted in from another source, such as an Excel spreadsheet or Smartsheet. Usersmay
specify whether the entered data should be used to search for object IDs, Names, Key values, Attributes values
(with specification of the particular attribute), or other criteria determined by client's needs. ThismakesSearch
from List an efficient and easyway to find large numbers of objects in STEP and, in combination with other
available search plugins, suitable for highly complex and extensive searches.

1. Select theSearch tab on the left. On this tab, a small dropdown bar will appear with theSearch operation as
the default. Click on the dropdown bar and selectSearch from List.

2. A text field and dropdown bar with a number of options to select from (optionswill vary depending on client
search needs) appear.
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In this example, we chooseSearch from List: ID, which allows specifying the data list in the text field and
searching by 'ID' (selected from the dropdown).

3. Enter the data list you wish to search.

l Copied data can come fromExcel or any other application as long as line breaks or tabs are included to
separate the values. See theUsing a Data List from an External Application section below.

l Data can be enteredmanually, usingEnter to create a line break between each value.

Note: The separators used for data are tabs and line breaks. To copy data in, each valuemust be listed on its
own line or separated by a tab delimiter, without any characters around it, including bullet indicators and
spaces.

4. Click the green plus button ( ) to add additional search criteria. (Optional)

5. Click onSearch to run the search and view results.
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If this is still not as refined as needed, keep adding search boxes by pressing the green plus button ( ) and
typing in further information.

Each of the 'Search from List' options available from the dropdown are described and illustrated below.

Search from List: ID
Search by specifying the ID in the list text field and selecting 'ID' from the dropdown, as shown in the example
above.

Search from List: Name
Search by specifying the object name in the list text field and by selecting 'Name' from the dropdown.
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Enter the values to search into the text field. ClickSearch to run the search and view results.

The search results display with the name of the objects specified in the data list.

Search from List: Key
Search by specifying the key values in the list text field, and by selecting the key from the dropdown.

In this example, the search results display with the Supplier Part Number that holds values specified in the data
list.
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It is important to keep inmind that:

l Only active keyswill be available as an option in the dropdown list.

l Active Keys that have values in products can be searched.

l Searching for active keyswith empty values in a data list field will NOT return search results.

For more on keys and how to activate them, see theUnique Keys documentation.

Search from List: Attributes
Search by specifying the attribute values in the list text field, and by selecting the option 'Attribute' from the
dropdown.
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Note: Description attributes are displayed under the product hierarchy node in the folders for which they are valid.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 345



The search results display with the attributes specified, in this case it is the attribute 'Color' which holds values of
'Orange.'
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It is important to keep inmind that:

l Only one attribute can be selected from the Attribute Group browse / search window to be used as search
criteria.

l Inherited attribute values (hierarchical inheritance) can be specified in the data list. The result set includes the
object that contains the searched value as a local value.While this object may not match an object type
restriction, it points to the origination of the searched text.

l Attribute values inheriting from other contexts can be specified in the data list.

l Calculated Attribute value (description or specification attributes) when specified in data list, will NOT be
displayed with any search result

Using a Data List from an External Application
Copied data can come fromExcel or any other application as long as line breaks or tabs are included to separate
the values.

To copy data in, each valuemust be listed on its own line or separated by a tab delimiter, (tab key from keyboard)
without any characters around it, including bullet indicators and spaces.

In the example below, ID's have been copied over from an external file. Data can be horizontal or vertical as long
as the appropriate line breaks or tabs are in between the values.
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JavaScript
The JavaScript search criteria searches through all JavaScript in STEP. It canmatch items according to
BusinessRules, Match Algorithms, Decision Tables or any other structure programmed through JavaScript.

Follow the steps below to set up a JavaScript Search:

1. To start a JavaScript search criteria, click on the side search tab, and select JavaScript.

2. By running a basic search, it will return results in all categories for the desired JavaScript part.
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JavaScript Checkbox Optinos
There are 2 checkbox optionswith JavaScript search criteria:

l Match Case: If you select this, the search will only return results that match the upper or lower case letters that
are in the search criteria.

l Match whole word only: will return only results that are the exact criteria that were put in that stand alone. An
example would be if the letter 'a' were typed into a search, and only results that had 'a' in it that stand alone
somewhere in the JavaScript were returned.
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Missing Mandatory Values
TheMissingMandatory Values search criteria is used for finding Product objects that have validMandatory
Specification attributeswithout values.

To set a criteria as aMissing Mandatory Values search:

1. Click on theSearch tab. You will see a small dropdown bar that defaults to Search.

2. Click on the dropdown bar and selectMissing Mandatory Values.
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Use Cases
1. Product object which has specification and description attribute asmandatory with empty values.

The 'Product Name' attribute is set asmandatory for ItemObject Types. For Object 22200, the attribute value
is left empty. In the Search tab, MissingMandatory Values search criteria is used with Object Type
‘ProductsRoot’ search criteria. 22200 is included in the search results.

2. Description attribute ismandatory and is left blank on entity object.

In this example, the 'Available Sizes' description attribute is set to mandatory. On the address entity ADD_
107837, the 'Available Sizes' attribute is empty. A search is performed that has a 'MissingMandatory Values'
search criteria with Object Type ‘Entity root’ search criteria. The ADD_107837 object is returned as a result.
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The search criteria requires no data input or selections to bemade. However, it is encouraged to use in
conjunction with another search criteria (by pressing the green + sign) to help further refine the search.

Note: As theMissing Mandatory Values search criteria only works on Product objects, using it in combination
with other search criteria will limit the search result to such objects.

TheMissingMandatory Values search criteria can also be set to exclude Product objects with missingMandatory
values. This functionality is described in Using Exclude Search Criteriawithin theBasic Search Criteria and
Functionality documentation.
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Unapproved
This criteria is used to identify objects that are not currently approved. These include classifications, products,
images and documents, and entities setup to beWorkspace revisable.

To set a criteria as anUnapproved search, first click on the side Search tab. You will see a small dropdown bar
that defaults to Search. Click on the dropdown bar and selectUnapproved.

Once you select this, there are three options to use: 'Never approved or modified in main,' 'Never approved,' or
'Modified in Main.'
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Never Approved or Modified in Main: This is the consolidation result of 'Never been approved' objects and
'Modified in main' objects.

Never Approved: This search result displays objects (products, classifications, assets & documents, or entities
that are setup to be workspace revisable) that have never been approved (certified).

Modified in Maintenance: When the 'Modified in Maintenance' option is selected, search result will be displayed
for objects which aremodified after the approval or added to in themaintenance setting.
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Status in Current Context: When this box is checked, it will only search in STEP under what is selected in the
current context. If it is unchecked, it will search all objects in all of the contexts.
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Product Override
With theProduct Override search criteria you can locate and identify any product overrides present in your
system. You can simply search for all overrides in STEP or you can narrow your search to overrides of a specific
product. If more concise results are required, you can even specify sub-products.

1. Navigate to the sideSearch tab and click on it. A small dropdown bar will appear. Click on the dropdown bar
and selectProduct Override.

2. Two optionswill appear: 'Find All' and 'Find byOverridden Product'. 'Find All' will search for all product
overrides in your system. For the purposes of this example, 'Find byOverriden Product' will be used for the
search.

3. Select the 'Find byOverridden Product' option and either type in the product's name you wish to search or click
the [...] to browse for a product to search.
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4. Clicking 'Add Child Product' and selecting sub products will narrow the search further, requiring search results
to have those specific sub-products linked to them. Checking the 'Exact Match on Child Products' boxwill
require search results to have every sub-product you have specified—nothingmore, nothing less.

5. Click the green plus sign to add additional search criteria. (Optional)

6. Click onSearch to run the search and view results.

If this is still not as refined as needed, keep adding search boxes by pressing the green + symbol and typing in
further information.

Clicking on the arrow symbol in the sub product row(s) will display the followingmenu:

l Hide: This option allows the user to Hide an added Child Product from list.

l Show All Rows: This option will show all the hidden child products.
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l Add Child Product: This option will do the same operation as the ‘Add Child Product” link as stated above.
l Remove sub product: This option will remove the selected Child product.

Note: Multiple child products can be selected and above operations can be performed on the same.

© Stibo Systems - Confidential - STEP Trailblazer 8.3 360



Search in Publication Hierarchy
The user can search the objects below a specific Publication hierarchy and can know the status or a specific result
by using the ‘Search in Publication Hierarchy.’

Keep inmind that this search isNot used to search for different templates (such as products, publications, or page
templates) or to search number of objects / links placed in product template. It is only used to search the objects
below a specific Publication hierarchy.

Note: It is important to note that any user who uses 'search in publication hierarchy' in the Search tab, must have
prior knowledge of how to use STEP'n'Design. For more information on STEP'n'Design, see theSTEP'n'design
documentation. For more information on the publication hierarchy, see thePublication topics in theGetting
Started documentation.

Steps to Setup Search in Publication Hierarchy
1. On the side Search tab, click on the dropdownmenu and select Search in Publication hierarchy.
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The search criteria requires no data input. However, it is helpful to further refine the search by pressing the plus
sign below, and entering in information to limit the search results.

2. After selecting Search in Publication hierarchy, there are two options to set in the search criteria:
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l Search below: used for choosing a node. Select either the Publication Group or Publication. The
search result will display all matched product objects which are under the selected Publication Group or
Publication.

l Search for: speifies what object is being searched.

Search for
There are 5 options in the dropdown list that a user can choose to search for:

1. Objects linked to Publication / Section: When this option is selected, products and assets linked to a
publication will be displayed in the result.
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2. Objects in Assortment Lists: This is a legacy component.

3. Objects in Baskets: The products saved in a Basket will be displayed in the results.

4. Object on actual pages: the product and asset are used on actual pages (DTP documents) and will display
the results field.
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5. Object on planned pages: The products and assets used on planned pageswill be displayed in the result.
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References and Referenced By
The References andReferenced By criteria work similarly.

To navigate to either of these searches, go to the sideSearch tab and click on it. You will see a small dropdown
bar that defaults toSearch. Click on the dropdown bar and selectReferences orReferenced By.

Both options require a reference type selection to begin. Reference types are setup in the STEP Workbench
SystemSetup tab in the Reference Types folder, and theWebUI Advanced Search allows you to pick from image
and document reference types, classification reference types, and product reference types.

Once a reference type is entered, no additional options need to be filled in to start a search. Use the information at
a high level or fill in the other values to drill down further (e.g., multi-supplier item references). Select a reference
source underReferenced By and a target under theReferences. Plus enter specific attributes and values to
search referencemetadata.
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References
For References, there are two boxes that can be checked: Include Inherited References and Finding Missing
References.

Include Inherited References: When this is selected, it will show items that have the particular search criteria
passed down to them from a parent folder or level.

Finding Missing References: When the reference type is selected, and this box is checked, the populated
results will show all items that have that particular missing reference.
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Reference Target
The user has to type the ID/Name of the target in the ‘Reference Target’ field and click on the ‘Search’ button. This
will display all the Source / Products which uses the Target reference specified in the ‘Reference Target’ search
field.

In this example, the ‘Reference Type’ field is empty. Hence the result is irrespective of the reference type.
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The search result will differ when we specify the ‘Reference Type’.

In this example, the ‘Reference Type’ is selected and shows all the results for that ‘Reference Target.'
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If a narrowed search is needed, use the advanced option. To use this option click the ‘Advanced’ flipper and select
the appropriate option. For more details on the advanced options, see theAdvanced Options topic in the
Getting Started documentation.
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Referenced By
Reference Source
The user has to type the ID / Name of the source wish to search. It will list the itemswhich have been used as a
source.

Usersmay click the ellipsis [...] to browse for a reference type for search either type in the reference type ID /
Name for more restricted search.
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If the user needs a narrowed search, then the user can also use the advanced option. To use this option, open the
Advanced flipper and select the appropriate. For more details on the advanced options, see theAdvanced
Options topic in theGetting Started documentation.
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Reference and Referenced By Metadata Attribute Value Searches
Values for metadata attributesmay be searched by using theReferences orReferenced By search options.
Usersmay indicate any value to search allmetadata attributes for amatching value. The following pictureswill
demonstrate withReferences, but know that the same holds true forReferenced By.

Alternatively, usersmay enter an attribute ID or name, operator, and value for amore restricted search.

Note: It is not possible to perform searches onmissingmetadata values.
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Workflow
With theWorkflow search criteria you can search for andmonitor STEP workflows. Selecting a specific workflow
from the dropdown list will show all items associated with the workflow. You can also specify the workflow state to
narrow your search.

1. Navigate to the sideSearch tab and click on it. A small dropdown bar will appear. Click on the dropdown bar
and selectWorkflow.

2. A new dropdown bar will appear with a number of options to select from (optionswill vary depending on client
search needs). For the purpose of this example, 'Sales ItemCreation' will be used for the STEP Workflow
search field.

3. Specify the State you wish to search within from the State dropdown list.
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4. Selecting the '[any State]' state option allows you to search the entire workflow, if you prefer not to choose a
specific state. For the purposes of this example, '[any State]' will be used for the search.

5. Click the green plus sign to add additional search criteria. (Optional)

6. Click onSearch to run the search and view results.

If this is still not as refined as needed, keep adding search boxes by pressing the green + symbol and typing in
further information.

Note: It is possible to search products which are not present in the selected workflow. Select the specific
workflow, select ‘State’ as “[not in STEP workflow]” and click on search as illustrated in the below image.
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Sample Results
The Sample Result Search Criterion allows users to refine the search results to only those specified numbers.
When the ‘Sample Result’ criterion is selected, one input field ‘Sample Result Size’ is displayed below it. If a user
enters a random number and clicks on Search, the search result will be zero. Hence, this search should always be
appended to an existing search and entering a numeric value for 'Sample Results Size' will further refine the
search result based on the entry

For example, a user searches for a set of products below a hierarchy that displays a set of results which has 16
products. To do so they go to the Search tab > Search Below option in the Search dropdown > and choose what
node to search below. For more on how to search below, see theSearch Below topic in this documentation.

Now, the user wants to append the results with the ‘Sample Result’ search criteria. To do this theywill keep their
original search, but select the plus sign > Sample Results > and enter a number. In this example ‘10’ is used to
define the Sample Results Size. The search result will give random results.
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Notice that the results will display and not go above the specified sample results size number. If this Search button
is clickedmultiple times, the sample search results will change each time, though always staying below the
specified sample number.
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Unpushed or Failed Assets
TheUnpushed for Failed Assets search criteria allow you to identify Assets that have not been successfully
pushed. These assets have an Asset Push Status of 'Never been handled', 'Asset not in workspace,' or 'Error.'

1. On theSearch tab click theSearch dropdown.
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2. Select theUnpushed or Failed Assets option.

3. Click the… (ellipsis) button to display theSelect Asset Push Configuration dialog.
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4. Select a configuration and click theSelect button.

5. Click theSearch button.

6. The Search Results List and Profiling information are displayed.
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Note: Click an item in the list link to view it or click a Profiling hyperlink to update the Search Results List.
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Search Operations
There are three operations that can be found at the bottom of theSearch Tab.

Exporting a Search Result
After conducting a search it is possible to export the search result by clicking theExport Search Result button at
the bottom of theSearch tab.

When clicking theExport Search Result button, STEP will attempt to use all the objects in the result as root
objects for theExport Manager (equaling selecting the objects on theProduct Selection step of theExport
Manager). Which objects are exported is thus determined by the selectedExport format and the selectionsmade
in theExport Manger. For more information using the Export Manager, see theExport Manager topic in the
Data Exchange documentation.

Saving a Search Result as a Collection
After conducting a search it is possible to save the entire search result as aCollection.
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When clicking theSave as Collection button, a dialog is opened where it is possible to specify the ID,Name, and
location of the new Collection. For more information on collections, see theCollection topic in theGetting
Started documentation.

Bulk Updating a Search Result
When having conducted a search it is possible toBulk Update the entire search result.

When theBulk Update Search Result button is clicked, theBulk Updatewizard appears with the search result
selected as the dataset. For more information on bulk updates, see theBulk Updates documetentation.

Note: If you only wish toBulk Update some of the objects in the result, you can select or multi select in the
search result and then select theRun Bulk Update option on the File menu
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STEP Workbench Keyboard Shortcuts
Within the STEPWorkbench there aremany shortcut key combinations that allow users to quickly navigate and
make changes through the system. The following tables list and describe the options available for Shortcut Key
options.

Basic Shortcuts
Shortcut Description Shortcut

Key

Copy Creates a duplicate of the information selected that can be pasted somewhere else. Ctrl + C

Cut Takes away information that can be pasted into a different location if desired. Ctrl + X

Duplicate This duplicates the item selected, with the option to duplicate references aswell. Ctrl + J

Goto This brings the user to the Goto field in the upper right hand corner of the workbench
screen where items are looked up.

Ctrl + G

Goto
Next

Finds the next item that most closelymatcheswhat the user is looking for. The results
may differ depending on what tab the user is in and working with, or what area is
selected as active.

Ctrl + E

Help WhenWorkbench is open, it will populate another window that provides all of the
Online Help Documentation.

F1

Next Shifts the focus to the next cell. Tab

Paste When information that was either cut or copied from before is placed into an alternate
area.

Ctrl + V

Previous Shifts the focus to the previous cell. Shift +
Tab

Redo Goes to the changed sate, if the change was reversed. Ctrl +
Shift + Z
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Shortcut Description Shortcut
Key

Reload Reloads the workbench and updates to any changesmade. F5

Select All When the desired area is clicked in or is already the active area, pressing this key
combination will choose everything in this particular area.

Ctrl + A

Undo Goes back to the original state before the change wasmade. Ctrl + Z

Navigate to Main Side Bar Tabs in Workbench
Shortcut Description Shortcut

Key

Background
Process
Tab

Unless a product is being viewed, this will bring the user to the Background
Processes tab. If a user is on a product, this key combination will not transpire.

Alt + P

Bookmarks Brings the user to the Bookmarks side tab. Alt + M

System
Setup Tab

Brings the user to the SystemSetup tab. Alt + Y

Search Tab Leaves the user looking at what theywere on in themain frame, but brings up the
Search Tab along the left hand side.

Ctrl + F

Tree Tab This will bring a user to the Tree Tab only if not viewing an item in Tree in themain
screen, or having an item still show up in themain screen even though navigation
has been away from it.

Alt + T

Workflow
Tab

Navigates to the STEPWorkflows tab. Alt + W

Navigate to Horizontal Tabs within Main Sidebar Tabs
To navigate to the horizontal tabswithin themain tabs in workbench, press Alt + (the letter underlined on the tab).

For example, if a workflow is selected within SystemSetup, pressingAlt + S displays theStatus tab for the
workflow being viewed because 'S' is the underlined letter for the Status tab.
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Note that options for shortcut keys to horizontal tabs vary depending on what item is selected and in what main tab
a user is located (Tree, Search, Background Processes, SystemSetup, Bookmarks, and STEPWorkflow). Not all
tabs have underlined letters for shortcut key options.

General Shortcuts Useful in Workbench
Shortcut Description Shortcut

Key

Add Bookmark When on an object and this is pressed, it will add the item to the
bookmark list on the Bookmark tab.

Ctrl + D

Add Element When adding various elements, pressing this key combination will often
(not in all cases), bring up a dialog allowing the user to add to the desired
list.

Ctrl +
Plus

ApproveObject When inMain, approves an object that was previously unapproved. Ctrl +
Shift + J

Mark Different (On
multi-product display)

In Tree, when viewingmultiple products at once, or when viewing the
horizontal Sub Products tab for an item, selecting this key combination
will mark all areas that are different green.

Shift +
F12

NewWindow With STEPWorkbench open, this will open an additional STEP
Workbench window.

Ctrl + N

Remove Element When deleting various elements from lists or rows, pressing this key
combination will often remove the desired connection or item.

Ctrl +
Minus

Rotate Table (On
Multi-Product display)

In Tree, when viewingmultiple products at once, or when viewing the
horizontal Sub Products tab for an item, this rotates the table view if the
table is the active area.

F11

© Stibo Systems - Confidential - STEP Trailblazer 8.3 388



Shortcut Description Shortcut
Key

Toggle attribute
values selection
between blinking
cursor and blue filter

When on a field that is editable, selecting F2 allows the user to write in the
field. When pressed again, the entire field turns blue, rendering it entered
and non-editable, unless F2 is pressed again or the field is clicked into
again.

F2

Insert Options
Shortcut Description Shortcut

Key

Insert Action Set In SystemSetup, when in the Action Sets, pressing this key
combination will create a child Action in an Action set.

Ctrl + Shift
+ S

Insert Asset The Create Asset dialog appears when in Tree. Ctrl + Shift
+ A

Insert Attribute Displays the Create Attribute dialog in SystemSetup. Ctrl + Shift
+ T

Insert Attribute Group In SystemSetup, this creates a new Attribute Group if sitting
on the proper level.

Ctrl + Shift
+ I

Insert Background
Process toMonitor
Deadlines / STEP
Workflow Deadline
Monitoring

This allows a user to set up a background process tomonitor
states with exceeded deadlines in the desired time frame.

Ctrl + Shift
+ D

Insert Character Tag When typing in a field and this is selected, a dialog appears
allowing the user to select from character tags.

Ctrl + R

Insert Classification In Tree, this inserts a new yellow folder, or classification. Ctrl + Shift
+ C

Insert Classification Root In Tree, a new Classification Root or top node yellow folder
is created.

Ctrl + Shift
+ R
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Shortcut Description Shortcut
Key

Insert Dimension In SystemSetup, when sitting on the top node for contexts,
clicking these keyswill bring up the dialog to create a new
dimension.

Ctrl + Shift
+ D

Insert Dimension Point In SystemSetup, when on a dimension, selecting this will
create the dimension point.

Ctrl + Shift
+ M

Insert Group In SystemSetup, when on the node that housesUsers and
Groups, selecting this key combination will create a new
group.

Ctrl + Shift
+ G

Insert List of Values In SystemSetup, when sitting on the top node for List of
Values, pressing this will bring up the dialog to create a new
List of Values.

Ctrl + Shift
+ L

Insert non-breaking space Enters a non-breaking space when editing attribute values. Ctrl + Enter

Insert Orphan Attribute When on a product, this will insert an orphan Attribute,
which will appear in italics.

Ctrl + Shift
+ O

Insert Product When in Tree, this will create a new object under the one
selected.

Ctrl + Shift
+ P

Insert Special Character When in a field that allows typing, selecting this brings up a
list of characters that can be selected and inserted into the
field.

Ctrl + Shift
+ E

Insert STEPWorkflow In SystemSetup, when on the top node for workflows, or
when inside the node for workflows, selecting this will bring
up a new STEPWorkflow Designer window to create a new
workflow.

Ctrl + Shift
+ R

Insert Workspace In SystemSetup, when on a workspace, selecting this key
combination will create a different workspace.

Ctrl + Shift
+ W
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Linking Options
Shortcut Description Shortcut

Key

Link Asset When on References or References By tab, this allows asset links or references to
be selected and put into the appropriate folders. Note that the Reference Type can
be changed from the drop-downmenu in the dialog that appears.

Ctrl +
Shift + F

Link Attribute
to
Classification

To link an Attribute to an item, select the item that needs the attribute and select
this key combination. Linked attributeswill appear in the References tab under the
'Attributes' flipper.

Ctrl +
Shift + Y

Link Attribute
to Product

When on a product, selecting this key combination links an attribute to a product. Ctrl +
Shift + K

Link
Classification
to a Product

This links a classification to a product. It can be seen under the Reference tab
under the 'Linked Attributes to ClassificationsHierarchy' flipper.

Ctrl +
Shift +H

Paste Link Creates a new reference (pointer or link) to an existing / copied object. An
example would be if the user copied a SKU from a blue folder and pasted it into the
yellow folders. Note that object types need to be compatible.

Ctrl + L

Link Product
/ Create Link

When on References or References By tab, this allows product links or references
to be selected and put into the appropriate folders.

Ctrl +
Shift + Q

Style Options
Shortcut Description Shortcut

Key

Bold When typing in a filed, this activates bold text. Ctrl + B

Character Tag Opens the Insert Character Tag dialog for adding character tags to
attribute values.

Ctrl + R

Italic When typing in a field, this activates italic text. Ctrl + I

Non-breaking Enters a non-breaking space when editing attribute values. Ctrl +
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Shortcut Description Shortcut
Key

Space Enter

Special
Character

Opens a dialog showing themost recently used special characters,
as well as an option to select to see all special characters. Allows user
to select a special character to insert when editing attribute values.

Ctrl +
Shift + E

Style This key combination can be pressed to bring up the Style box, where
there are a number of styles to choose from.

Ctrl + Y

Rich Text
Editor

Opens the Rich Text Editor in the STEPWorkbench when editing an
attribute value.

Alt + F2

Paste and
Match Style

When in a field, if 'text A' is copied from one area and is going to be
pasted into 'text B' that is a different style, pressing this key
combination will make it so the copied 'text A' will past into 'text B' with
the style of 'text B'.

Ctrl +
Shift + V

Flatplanner Shortcuts
Shortcut Description Shortcut Key

Save (In Flatplanner) This save what is being worked on. Ctrl + Alt + S

Zoom In (In Flatplanner) This zooms in on what is being worked on. Ctrl + Plus

ZoomOut (In Flatplanner) This zooms out of what is being worked on. Ctrl + Minus
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